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1 What’s New in This Release

Oracle Business Intelligence Enterprise Edition consists of components that were formerly available 
from Siebel Systems as Siebel Business Analytics Platform, with a number of significant 
enhancements.

The Oracle Business Intelligence Presentation Services Administration Guide is part of the 
documentation set for Oracle Business Intelligence Enterprise Edition. This guide contains 
information about administering Oracle BI Presentation Services, including tasks that are performed 
using the Oracle Business Intelligence Presentation Services Administration screen and Oracle 
Business Intelligence Catalog Manager. This guide contains new material and material that was 
previously published under the title Siebel Analytics Web Administration Guide. 

Oracle recommends reading the Oracle Business Intelligence Enterprise Edition Release Notes before 
installing, using, or upgrading the Oracle BI Infrastructure. The Oracle Business Intelligence 
Enterprise Edition Release Notes are available: 

■ On the Oracle Business Intelligence Enterprise Edition CD-ROM.

■ On the Oracle Technology Network at http://www.oracle.com/technology/documentation/
bi_ee.html (to register for a free account on the Oracle Technology Network, go to http://
www.oracle.com/technology/about/index.html).

What’s New in Oracle Business Intelligence Presentation Services 
Administration Guide, Version 10.1.3.2
Table 1 lists changes described in this version of the documentation to support Release 10.1.3.2 of 
the software.

Table 1. New Product Features in Oracle Business Intelligence Presentation Services 
Administration Guide, Version 10.1.3.2

Topic/Topics Description

“Setting the Preferred Time Zone for 
Users” on page 24

Added new topic for setting the preferred time zone for users.

“Specifying Whether to Allow HTML 
Input in Oracle BI Presentation 
Services Fields” on page 37

Added new topic on specifying whether to allow HTML input 
in fields.

“Using the Javahost Service in 
Oracle BI Presentation Services” on 
page 37

Revised the topics for Javahost service.

“Configuring the Maximum Number 
of Rows in an Answers Table View” 
on page 53

Revised information on ResultRowLimit entry.
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“Managing Device Types for 
Delivers” on page 72

Added new topic on managing device types for Oracle 
Business Intelligence Delivers.

“Setting the Case of Logon Names 
for the SA System Subject Areal” on 
page 74

Added new topic describing the UpperCaseRecipientNames 
element.

“Controlling Delivery Options for 
iBots” on page 74

Added new topic on controlling delivery options for iBots.

“Configuring Report Write Back” on 
page 90

Revised to provide more complete information on performing 
write back.

Presentation Catalog topics Revised the topics in Chapter 6, “Administering the Oracle BI 
Presentation Catalog” to describe the enhanced Presentation 
Catalog.

“Replicating Presentation Catalogs” 
on page 99

Revised the topics for replication in this section.

“Archiving a Presentation Catalog” 
on page 109

Added new topic on archiving a Presentation Catalog using 
Oracle BI Presentation Services Administration.

Oracle Business Intelligence 
Catalog Manager topics

Note that Oracle Business 
Intelligence Catalog Manager was 
formerly known as Siebel Analytics 
Catalog Manager. 

Revised Catalog Manager topics and moved them into their 
own chapter and added new topics to describe the enhanced 
Catalog Manager functionality. The new chapter is titled 
Chapter 7, “Managing Presentation Catalogs Using Oracle BI 
Catalog Manager.” 

“Archiving and Unarchiving a 
Presentation Catalog Using Catalog 
Manager” on page 132

Added new topic on archiving and unarchiving the Oracle 
Business Intelligence Presentation Catalog using Oracle 
Business Intelligence Catalog Manager

“Types of Presentation Services 
Groups” on page 138

Removed the Authenticated Users group from this topic.

“Administering Presentation 
Services Groups” on page 139

Updated the procedures for administering Presentation 
Services groups.

“Overview of the Oracle BI 
Presentation Services 
Administration Screen” on page 148

Updated the table describing the links in the Activities Section 
in Oracle BI Presentation Services Administration, including 
adding the Manage Device Types, Manage BI Publisher, and 
Toggle Maintenance Mode links. Added Available Paging 
Memory and Available Virtual Address Space to the Product 
Information section.

“Setting Permissions in Oracle BI 
Presentation Services 
Administration” on page 150

Updated the procedures for setting permissions.

Table 1. New Product Features in Oracle Business Intelligence Presentation Services 
Administration Guide, Version 10.1.3.2

Topic/Topics Description
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“Setting Privileges in Oracle BI 
Presentation Services 
Administration” on page 152

Updated the procedures for setting privileges.

“Default Oracle BI Presentation 
Services Privilege Assignments” on 
page 154

Updated the table listing the privileges and default settings 
for the Oracle Business Intelligence Infrastructure.

“Creating and Using Shared Items” 
on page 166

Added new topic to describe creating and using shared items.

Topics for the proxy functionality Added new topics on the ability to authorize users to act as 
other in Chapter 8, “Managing Oracle BI Presentation Services 
Security.”

“Oracle BI Presentation Services 
Configuration File Structure” on 
page 176

Added information on the fmtName attribute for the Writer 
element.

“Adding a Language Selection to 
Oracle BI Presentation Services 
Screens” on page 197

Added new topic to describe how to add a language selection 
to Oracle BI Presentation Services screens.

“Configuring the Oracle Business 
Intelligence ReportUI Portlet” on 
page 199

Revised the topics for configuring the Oracle BI ReportUI 
Portlet.

Table 1. New Product Features in Oracle Business Intelligence Presentation Services 
Administration Guide, Version 10.1.3.2

Topic/Topics Description
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2 Administering Oracle BI 
Presentation Services

This chapter provides general post-installation configuration and administration procedures that are 
not specific to Oracle Business Intelligence Answers, Oracle Business Intelligence Delivers, Oracle 
Business Intelligence Interactive Dashboard, or Oracle Business Intelligence Presentation Catalog. 
Directions for configuring these components of Oracle BI Presentation Services are in subsequent 
chapters.

This chapter contains the following sections:

■ Making Oracle BI Presentation Services Configuration Changes on page 15

■ Changing the Oracle BI Presentation Services ODBC DSN on page 17

■ Setting the Oracle BI Presentation Services Configuration File Path on page 17

■ Disabling the Oracle BI Presentation Services Feature to Remember Users’ Names and Passwords on 
page 18

■ Setting the Time to Expire for Idle Oracle BI Presentation Services Client Connections on page 18

■ Administering Sessions in Oracle BI Presentation Services on page 19

■ Setting the Time to Expire for Oracle BI Presentation Services Client Sessions on page 22

■ Setting the Time to Keep an Unsaved Oracle Business Intelligence Request on page 22

■ Setting the Time to Cancel an Unattended Oracle Business Intelligence Request on page 23

■ Setting the Time to Log Users Off Oracle BI Presentation Services Automatically on page 23

■ Setting the Preferred Time Zone for Users on page 24

■ Managing the Oracle BI Presentation Services Cache Settings on page 29

■ Configuring the Oracle BI Presentation Services Cookie Domain on page 31

■ Managing Oracle BI Presentation Services URL Generation and Resource File Location on page 32

■ Specifying the Default Language for the Oracle BI Presentation Services Login Screen on page 35

■ Specifying Whether to Allow HTML Input in Oracle BI Presentation Services Fields on page 37

■ Using the Javahost Service in Oracle BI Presentation Services on page 37

■ Configuration Keys on page 46

Making Oracle BI Presentation Services 
Configuration Changes
This section provides procedures for making configuration changes. You need to make changes only 
if you want to change default elements, such as the name of the Presentation Catalog, or override 
internal default settings, such as the time for client connections to expire.
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You make configuration changes by modifying the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), which holds configuration settings for Oracle BI Presentation Services.

For organizations that use Oracle Application Server, Oracle recommends that you use Oracle 
Application Server Control to modify configuration files. For organizations that use other application 
servers, Oracle recommends that you use JConsole. For more information, see the Oracle Business 
Intelligence Infrastructure Installation and Configuration Guide.

NOTE: If you have previously made configuration changes by modifying the Windows registry, you 
should migrate those changes to the Oracle BI Presentation Services configuration file 
(instanceconfig.xml). In the Windows registry, entries under the Common key remain valid.

For general background information about customizing the Oracle BI Presentation Services XML files, 
read “Customizing the Oracle BI Presentation Services User Interface Using XML Message Files” on 
page 192.

To make changes to the configuration file instanceconfig.xml

1 Navigate to:

SADATADIR\web\config

where SADATADIR is the data directory.

CAUTION: Always make a backup copy of the instanceconfig.xml file before you make any 
changes.

2 Locate the instanceconfig.xml file and make a backup copy.

3 Use a text editor to open the instanceconfig.xml file.

4 Place your entries between the elements <ServerInstance> and </ServerInstance>, using the 
values described throughout this chapter.

5 Save the file when you are done.

Your changes take effect when the service for Oracle BI Presentation Services is restarted.

Example instanceconfig.xml File
The following XML file is an example of the Oracle BI Presentation Services configuration file 
(instanceconfig.xml):

<?xml version="1.0" ?>
<!-- Oracle BI Presentation Services Configuration File -->
<!-- The following example shows initialization settings for a server instance. -->

<WebConfig>
<ServerInstance>

<CatalogPath>/OracleBIData/web/catalog/default</CatalogPath>
<DSN>AnalyticsWeb</DSN>

</ServerInstance>
</WebConfig>
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Several entries are present in the file instanceconfig.xml by default, including the path to the 
Presentation Catalog, and the name of the Oracle Business Intelligence Server data source name 
used by Oracle BI Presentation Services to access Oracle BI Server.

For example, the path to the Presentation Catalog is shown between the <CatalogPath> and </
CatalogPath> elements:

■ In Windows, an example path might be the following:

<CatalogPath>c:\OracleBIData\web\catalog\default</CatalogPath>

■ In UNIX, an example path might be the following:

<CatalogPath>/usr/local/OracleBIData/web/catalog/default</CatalogPath>

Changing the Oracle BI Presentation 
Services ODBC DSN
Oracle BI Presentation Services accesses an Oracle BI Server repository with a single Oracle BI 
Server data source name (DSN). The installation process configures a DSN named Analytics Web for 
this purpose. For information on configuring a new or existing DSN, read Oracle Business Intelligence 
Server Administration Guide.

Answers must use a single DSN.

If you change the name of the DSN, you need to update the Oracle BI Presentation Services 
configuration file (instanceconfig.xml) to use the new name.

The following entry is an example:

<DSN>Oracle BI Presentation Services Production</DSN>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Setting the Oracle BI Presentation 
Services Configuration File Path
You can override the path that Oracle BI Presentation Services searches for configuration files upon 
startup. The internal default location is $(SADATADIR)\web\config.

Oracle BI Presentation Services must have read permission to this path. The default data directory 
is OracleBIData.

You can override the internal default by adding the following entry to the Oracle BI Presentation 
Services configuration file (instanceconfig.xml), using a fully qualified path for the value:

<ConfigDir>value</ConfigDir>
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For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Disabling the Oracle BI Presentation 
Services Feature to Remember Users’ 
Names and Passwords
By default, users are asked if they want to have their user names and passwords remembered when 
logging on to Oracle BI Presentation Services. You can disable this behavior by modifying the Oracle 
BI Presentation Services configuration file (instanceconfig.xml) to add the following entry. When the 
value is set to No, users always have to type their user names and passwords.

The following entry is an example:

<AllowRememberPassword>No</AllowRememberPassword>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Setting the Time to Expire for Idle Oracle 
BI Presentation Services Client 
Connections
The entry ConnectionExpireMinutes defines the length of idle time that the connection between 
Oracle BI Presentation Services and the Oracle BI Server is maintained before the connection is 
closed. You can override the number of minutes to elapse by modifying the Oracle BI Presentation 
Services configuration file (instanceconfig.xml) to add the following entry. The internal default is 3 
minutes.

The following entry is an example:

<ConnectionExpireMinutes>3</ConnectionExpireMinutes>
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When a user logs into the Analytics application, a connection is created from the browser client to 
Oracle BI Presentation Services, and another connection is created from Oracle BI Presentation 
Services to the Oracle BI Server. If the user’s session remains idle for three minutes or more (the 
user does not perform any operation), the connection from Oracle BI Presentation Services to the 
Oracle BI Server is closed or dropped. The connection from the browser to Oracle BI Presentation 
Services still remains intact. The next time the user performs an operation such as running a report 
or navigating to a dashboard, a new connection is created from Oracle BI Presentation Services to 
the Oracle BI Server.

NOTE: This setting affects idle time only. For example, if the user were to run a request that 
executes for more than three minutes, the original connection from Oracle BI Presentation Services 
to the Oracle BI Server remains intact throughout, until the three-minute idle time is encountered 
again. This setting therefore keeps down the number of open connections to the server.

You can also set the amount of time to elapse before a user is logged off automatically. For more 
information, read “Setting the Time to Log Users Off Oracle BI Presentation Services Automatically” on 
page 23.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Administering Sessions in Oracle BI 
Presentation Services
Using the Session Management screen in Oracle BI Presentation Services Administration, you can 
view information about logged on users and running requests, cancel requests, and clear the cache. 

To access the Session Management screen

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Sessions link.

The Session Management screen appears, displaying the following tables:

■ The Sessions table, which gives information about users who are logged on to Oracle BI 
Presentation Services:

Field Description

User ID The name of the user connected to Oracle BI Presentation Services. 

Host Address The name or IP address of the machine that initiated the HTTP connection 
to the Web server. This could be a user’s PC, a handheld device, a firewall, 
and so on.

Session ID A unique identifier assigned by Oracle BI Presentation Services for each 
client session.
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■ The Cursor Cache table, which shows the status of requests made by users:

Browser Info Information about the browser being used to access Oracle BI Presentation 
Services.

Logged On The time stamp when the user ID logged on to Oracle BI Presentation 
Services.

Last Access The time stamp of the user ID’s last activity on Oracle BI Presentation 
Services. This can be any kind of activity on the system, such as switching 
from one dashboard page to another.

Field Description

ID The unique internal cache identifier for this entry.

User The name of the user who ran the request and last placed it into the cache. 
If two IDs are shown, the second ID is impersonating the first. For example, 
the entry lhurley/administrator means that the Administrator account 
logged on and impersonated lhurley. This can happen when the Oracle 
Business Intelligence Scheduler starts an iBot on someone's behalf. Oracle 
BI Scheduler logs on and impersonates that user so security and content 
filters still apply.

Refs The number of references to this entry since it was placed into the cache.

Status The status of the request using this cache entry:

■ Running. The request is currently running.

■ Finished. The request has finished.

■ Queued. The system is waiting for a thread to become available so the 
request can be processed.

■ Canceling. The application is in the process of canceling the request.

■ Error. An error was encountered during the processing or running of 
the request. Look in the Statement column for information about the 
error.

Time The time taken to process and run the request, displayed in one second 
increments. A value of 0s (zero seconds) indicates that the request took 
under 1 second to complete.

Field Description



Administering Oracle BI Presentation Services ■ Administering Sessions in Oracle BI
Presentation Services

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

21

To cancel all running requests

1 Click the Cancel Running Requests button.

2 Click Finished.

To cancel one running request
■ In the Cursor Cache table, identify the request and click the Cancel link in the Action column.

The user receives a message indicating that the request was canceled by an administrator.

To clear the Web cache

1 In the Cursor Cache table, identify the request and click the Close All Cursors button.

2 Click Finished.

Action ■ Cancel. Kills the request. Appears for in-progress requests. The user 
running the request will receive an informational message indicating 
that the request was canceled by an administrator.

■ Close. Clears the cache entry associated with this request. Appears for 
completed requests.

■ View Log. Displays the entry in the nQQuery.log file for this request (if 
logging is turned on for this user). This file logs query activity on the 
system at the individual user level. 

Query logging is, by default, turned off. It can be enabled for individual 
users at different logging levels. The Oracle BI Server Administrator 
uses Security manager to enable logging for a user.

You can also view the nQQuery.log file (located by default in the Log 
directory in the Oracle Business Intelligence installation directory) 
using a text editor such as Windows Notepad. The Oracle BI Server 
Administrator determines the maximum size of the nQQuery.log file by 
setting the USER_LOG_FILE_SIZE parameter in the NQSConfig.ini file.

Last 
Accessed

The time stamp of the last time the cache entry for this request was used 
to satisfy a request.

Statement The SQL issued for the request, or if the request resulted in an error, 
information about the nature of the error.

Information Usage tracking information (for example, what report contained the 
query).

Records The number of records in the result set that have been seen (for example, 
50+ to indicate that 50 records have been seen but there are additional 
records to be fetched or 75 to indicate that 75 records have been seen and 
there are no more records to be fetched)

Field Description
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To clear the cache entry associated with a request
■ In the Cursor Cache table, identify the request and click the Close link in the Action column.

To view the query file for information about a request
■ In the Cursor Cache table, identify the request and click the View Log link.

NOTE: Query logging must be turned on for data to be saved in this log file. For more information 
about query logging, read Oracle Business Intelligence Server Administration Guide.

Setting the Time to Expire for Oracle BI 
Presentation Services Client Sessions
The entry ClientSessionExpireMinutes defines the length of idle time that can elapse before Oracle 
BI Presentation Services removes the user's client (browser) session information from its memory. 
This session includes user-specific state information such as request cache, dashboard page state, 
subject area information, connection information, and so on.

The internal default is 1440 (24 hours).

For example, if the user does not access Oracle BI Presentation Services in 24 hours or more, the 
server’s information about that session is removed completely, in which case the user will be logged 
out of the application and will need to log back in. All state information is lost.

You can override the number of minutes to elapse before browser client sessions are removed by 
modifying the Oracle BI Presentation Services configuration file (instanceconfig.xml) to add the 
following entry. The value must be greater than or equal to the value specified for the setting 
SearchIDExpireMinutes, described in “Setting the Time to Keep an Unsaved Oracle Business 
Intelligence Request” on page 22.

The following entry is an example:

<ClientSessionExpireMinutes>1440</ClientSessionExpireMinutes>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Setting the Time to Keep an Unsaved 
Oracle Business Intelligence Request
You can override the time, in minutes, that an unsaved request remains valid by modifying the Oracle 
BI Presentation Services configuration file (instanceconfig.xml) to add the following entry. This entry 
applies to unsaved requests only. The internal default is 180 (three hours).

NOTE: The value must be less than or equal to the value specified for the setting 
ClientSessionExpireMinutes, described in “Setting the Time to Expire for Oracle BI Presentation 
Services Client Sessions” on page 22.
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The following entry is an example:

<SearchIDExpireMinutes>1440</SearchIDExpireMinutes>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Setting the Time to Cancel an 
Unattended Oracle Business Intelligence 
Request
You can override the time to elapse, in minutes, before an unattended request is cancelled by 
modifying the Oracle BI Presentation Services configuration file (instanceconfig.xml) to add the 
following entry. An unattended request is one that has not been accessed in the number of minutes 
specified by this setting. The internal default is 5. The minimum value is 2.

This entry handles the case where a user is at the Request screen in Answers and browses elsewhere, 
abandoning the request, at least temporarily. Do not set the value too small, however, as the user 
may return to the request.

The following entry is an example:

<UnaccessedRunningTimeoutMinutes>5</UnaccessedRunningTimeoutMinutes>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Setting the Time to Log Users Off Oracle 
BI Presentation Services Automatically
You can override the time to elapse, in minutes, before a user is automatically logged off. This setting 
applies only to users who do not have the following option selected at the Log In screen:

Remember my ID and password

If this value expires before the value set in the entry ConnectionExpireMinutes, the user can log back 
in to the existing session. For information about the ConnectionExpireMinutes entry, read “Setting 
the Time to Expire for Idle Oracle BI Presentation Services Client Connections” on page 18.

The default is 180 (three hours). You can change the number of minutes by modifying the Oracle BI 
Presentation Services configuration file (instanceconfig.xml).

The following entry is an example:
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<LogonExpireMinutes>180</LogonExpireMinutes>

NOTE: You can disable this setting by setting it to a value greater than the value for the setting 
ClientSessionExpireMinutes, described in “Setting the Time to Expire for Oracle BI Presentation 
Services Client Sessions” on page 22.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Setting the Preferred Time Zone for 
Users
If you have users in time zones that are different from the zone for Oracle BI Presentation Services, 
then you can specify the time stamps that those users see in Oracle Business Intelligence. For 
example, suppose the server is located in the Pacific time zone in the United States. You can specify 
that users on the east coast of the United States see time stamps displayed in Eastern Standard 
Time. 

If you make no time zone settings and if a user does not specify a preferred time zone using the My 
Account screen in Answers, then that user sees time displayed according to the local time zone for 
Oracle BI Presentation Services.

For information on how users specify their preferred time zones, see the Oracle Business Intelligence 
Answers, Delivers, and Interactive Dashboards User Guide.

This section contains the following topics on preferred time zones:

■ Where Time Zones Are Used on page 25

■ Setting Time Zones on page 25

■ Precedence Order for Time Zones

■ Where Time Zone Specifications Are Stored on page 27

■ Description of Time Zone Settings on page 28

■ Example: Configuration File Settings for Specifying the Time Zone on page 29
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Where Time Zones Are Used
Before you begin to set preferred time zones, see Table 2 for information on where time zones are 
used.

Setting Time Zones
Use the following procedure to set time zones for users.

To set preferred time zones for users

1 Determine the time zone that is set for Oracle BI Presentation Services. 

2 Use elements in the Oracle BI Presentation Services configuration file (instanceconfig.xml) or 
session variables. Consult the following for more information: 

■ See Table 3 for information on the precedence order for time zones. 

Table 2. Time Zone Usage

Type Description

Oracle BI Presentation Services As the Presentation Services Administrator, you can specify 
the time zone that Oracle BI Presentation Services uses.

Data from the database The Oracle BI Server Administrator specifies the time zone for 
the data that is retrieved from the database. 

If you make no time zone settings, then users see the time 
stamp data in the time zone of the original data as set by the 
Oracle BI Server Administrator.

Content that is displayed in Oracle 
Business Intelligence

Users who create reports can specify the time zone that is 
displayed in their reports and dashboard prompts. This 
specification overrides those made by you as the 
administrator and by end users if they have previously used 
the column in their queries and have set the time zone.

If the specified display time zone supports daylight saving 
time, then the timestamp values that are displayed are 
automatically adjusted for daylight saving time.

General time stamps that indicate 
when events happen

End users can specify the time zone for many general stamps 
including the following ones:

■ The scheduled time of iBots.

■ The generated time of alerts or reports.

■ The time on which items in the Presentation Catalog are 
created, modified, and accessed.

Log files Log files contain time stamps for various activities.
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■ See Table 4 for descriptions of the session variables and elements.

■ See “Example: Configuration File Settings for Specifying the Time Zone” on page 29.

■ See the Oracle Business Intelligence Server Administration Guide for complete information 
on session variables.

3 Encourage end users to specify their preferred time zones using the My Account screen in 
Answers.

4 Encourage users who create reports to do the following to set the time stamps for their reports:

a Use the Data Format tab of the Column Properties dialog to specify the time zone that is 
displayed in the columns of their reports.

b Use the Time Zone dialog to set the time zone that is displayed in dashboard prompts.

Precedence Order for Time Zones
The actual time zone in which various types of content are displayed follows a precedence order that 
is described in Table 3. In the table, the items with lower numbers override those with higher 
numbers. For example, Item 1 takes precedence over Item 2. 

Table 3. Precedence Order for Time Zones

Time Zone For Determined By

Data 1 The setting of the DATA_TZ session variable.

2 The setting of the <DefaultDataOffset> element in the 
instanceconfig.xml file.

3 The time zone of the original data as set by the Oracle 
BI Server Administrator (because the time zone is 
unknown for Oracle BI Presentation Services).

Data display 1 The setting that a report creator makes.

2 The setting of the DATA_DISPLAY_TZ session variable.

3 The setting of the <DefaultDataDisplay> element in the 
instanceconfig.xml file.

4 “User-Preferred Time Zone”

General time stamps (not including 
column data and log files)

1 “User-Preferred Time Zone”

2 The time zone for Oracle BI Presentation Services.

Log file information 1 The setting of the <Logging> element in the 
instanceconfig.xml file. 

2 The time zone for Oracle BI Presentation Services.
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User-Preferred Time Zone
The user-preferred time zone is determined by the following:

1 The specification that a user makes on the My Account screen in Answers.

2 The setting of the TIMEZONE session variable.

3 The setting of the <DefaultUserPreferred> element in the instanceconfig.xml file. 

Where Time Zone Specifications Are Stored
Whenever a time zone specification appears in a drop-down list or as the value of a session variable 
or element in the Oracle BI Presentation Services configuration file (instanceconfig.xml), that 
specification originates from the TimeZones.xml file. This file is stored in the 
SADATADIR\common\timezone directory, where SADATADIR is the data directory.

The TimeZones.xml file contains nearly all time zones from around the world. You should not need 
to add zones to this file, but you are free to edit this file if you care to. You can choose to delete 
those zones that users in your organization will never use.

Specifying Time Zone Values
Various editors show the ampersand that appears in time zone values in one of two ways: either the 
ampersand character itself or its escape sequence. Use care when entering a time zone value, as 
follows:

■ When you use the ampersand in the value of a session variable, include the ampersand character 
(&) in the value, such as ”Pacific Time (US & Canada); Tijuana”.

■ When you use the ampersand in the value of an element in the Oracle BI Presentation Services 
configuration file (instanceconfig.xml), include the escape sequence for the ampersand in the 
value, such as ”Pacific Time (US &amp; Canada); Tijuana” 
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Description of Time Zone Settings
Table 4 describes the session variables and the elements in the Oracle BI Presentation Services 
configuration file (instanceconfig.xml) with which you set time zones. When you include elements in 
the instanceconfig.xml file, then you specify the time zone that all users see. When you use session 
variables, you can specify a different time zone for each user. If you use session variables and you 
specify values for the appropriate elements in the instanceconfig.xml file, then the values of the 
session variables override the settings in the instanceconfig.xml file.

Table 4. Time Zone Settings

Element
 Session 
Variable Description  Value

<DefaultDataOffset> DATA_TZ The time zone offset of the 
original data. To allow the time 
zone to be converted so that 
users see the appropriate zone, 
you must set the value of this 
element or variable.

If you do not set this, then no 
time zone conversion occurs 
because the value is “unknown”.

For example, suppose you want 
to convert to Eastern Standard 
Time (EST), which is Greenwich 
Mean Time (GMT) - 5. You must 
specify this value to enable the 
conversion to EST.

An offset that 
indicates a number 
of hours away from 
GMT time. For 
example:

“GMT-05:00” or “-
300”, which means 
minus 5 hours. 

<DefaultDataDisplay> DATA_
DISPLAY_TZ

Specifies the time zone to use 
for displaying data.

If you do not set this, the value 
is the “User-Preferred Time 
Zone”.

One of the time 
zones that are 
specified in the 
TimeZones.xml file.

See “Specifying 
Time Zone Values.”

<DefaultUserPreferred> TIMEZONE Specifies the users’ default 
preferred time zone before they 
select their own on the My 
Account screen in Answers. 

If you do not set this, the value 
is the local time zone from 
Oracle BI Presentation Services.

One of the time 
zones that are 
specified in the 
TimeZones.xml file.

See “Specifying 
Time Zone Values.”
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Example: Configuration File Settings for Specifying the 
Time Zone
The following shows a sample section of the Oracle BI Presentation Services configuration file 
(instanceconfig.xml) in which the <TimeZone> element has been added. 

<TimeZone>

<DefaultDataOffset>0</DefaultDataOffset>

<Logging>(GMT-08:00) Pacific Time (US &amp; Canada); Tijuana</Logging>

<DefaultUserPreferred>(GMT-08:00) Pacific Time (US &amp; Canada); Tijuana</
DefaultUserPreferred>

<DefaultDataDisplay>(GMT-06:00) Central Time (US &amp; Canada)</DefaultDataDisplay>

</TimeZone>

Managing the Oracle BI Presentation 
Services Cache Settings
The entries described in this section are available for managing the Oracle BI Presentation Services 
cache:

■ “Specifying the Maximum Amount of Time an Entry Can Exist in the Oracle BI Presentation Services 
Cache” on page 30

■ “Specifying the Least Amount of Time an Entry Can Exist in the Oracle BI Presentation Services 
Cache” on page 30

<Logging> na The time zone of the time 
stamps that appear in log files 
that are generated by Oracle BI 
Presentation Services. 

If you do not set this, the value 
is the local time zone from 
Oracle BI Presentation Services

One of the time 
zones that are 
specified in the 
TimeZones.xml file.

See “Specifying 
Time Zone Values.”

<TimeZone> na The parent element for the 
elements that affect the 
preferred time zone. A child of 
the <ServerInstance> element.

na

Table 4. Time Zone Settings

Element
 Session 
Variable Description  Value
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■ “Specifying the Least Amount of Time an Entry Can Exist in the Oracle BI Presentation Services 
Cache After Use” on page 30

■ “Specifying the Maximum Number of Oracle BI Presentation Services Open Record Sets” on page 31

The cache is accessed when users make requests in Answers. This is not the same cache that is 
accessed by the Oracle BI Server. You can change the internal defaults by modifying the Oracle BI 
Presentation Services configuration file (instanceconfig.xml) to add the cache entries.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Specifying the Maximum Amount of Time an Entry Can Exist in the 
Oracle BI Presentation Services Cache
You can override the maximum amount of time, in minutes, that an entry in the cache can exist 
before it is removed. The internal default is 60 (one hour).

Depending on (the number of requests being run, an entry may be removed before the time limit 
expires.

NOTE: The setting for CacheMinUserExpireMinutes, described in “Specifying the Maximum Amount of 
Time an Entry Can Exist in the Oracle BI Presentation Services Cache,” can force an entry for a 
particular user to exist for a longer time than that specified by CacheMaxExpireMinutes.

The following entry is an example:

<CacheMaxExpireMinutes>60</CacheMaxExpireMinutes>

Specifying the Least Amount of Time an Entry Can Exist in the Oracle 
BI Presentation Services Cache
You can override the minimum amount of time, in minutes, that an entry in the cache can exist before 
it is removed. The internal default is 10.

The following entry is an example:

<CacheMinExpireMinutes>10</CacheMinExpireMinutes>

Specifying the Least Amount of Time an Entry Can Exist in the Oracle 
BI Presentation Services Cache After Use
You can override the minimum amount of time, in minutes, that an entry in the cache can exist after 
it has been viewed by a user. The internal default is 10.

For example, if CacheMaxExpireMinutes is set to 60 minutes and a user views the entry during the 
59th minute, the entry exists for that user for an additional 10 minutes. The user can continue paging 
through the data without requiring a new request to be run.

The following entry is an example:

<CacheMinUserExpireMinutes>10</CacheMinUserExpireMinutes>



Administering Oracle BI Presentation Services ■ Configuring the Oracle BI Presentation
Services Cookie Domain

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

31

Specifying the Maximum Number of Oracle BI Presentation Services 
Open Record Sets
You can override the maximum number of open record sets that Oracle BI Presentation Services 
keeps open at any one time. The internal default is 10. The minimum value is 3. For systems under 
significant loads, you can increase this value to 500 or 1000.

The following entry is an example:

<CacheMaxEntries>100</CacheMaxEntries>

Configuring the Oracle BI Presentation 
Services Cookie Domain
You can configure the cookie domain by modifying the Oracle BI Presentation Services configuration 
file (instanceconfig.xml) to add the following entries:

■ “Specifying Oracle BI Presentation Services Cookie Domain Information” on page 31

■ “Overriding the Oracle BI Presentation Services Cookie Domain Path” on page 31

■ “Specifying the Expiration Date for Persisted Oracle BI Presentation Services Cookies” on page 31

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Specifying Oracle BI Presentation Services Cookie Domain 
Information
You can specify domain information for a cookie sent to the browser. There is no default value.

The following entry is an example:

<CookieDomain>value</CookieDomain>

Overriding the Oracle BI Presentation Services Cookie Domain Path
You can override the domain path that cookies apply to. The internal default is “/”.

The following entry is an example:

<CookiePath>/usr/local/test/cookies</CookiePath>

Specifying the Expiration Date for Persisted Oracle BI Presentation 
Services Cookies
You can override the date on which persisted cookies expire by modifying the Oracle BI Presentation 
Services configuration file (instanceconfig.xml) to add the following entry. For example, remembered 
passwords expire on this date (read “Disabling the Oracle BI Presentation Services Feature to 
Remember Users’ Names and Passwords” on page 18). The default value is “Tue, 31 Dec 2030 
23:59:59 GMT”.
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The format for the date is “day, dd mon year hh:mm:ss GMT”, where:

You should not change this entry.

The following entry is an example:

<CookieExpire>Tue, 31 Dec 2040 23:59:59 GMT<\CookieExpire>

Managing Oracle BI Presentation 
Services URL Generation and Resource 
File Location
You can override how Oracle BI Presentation Services generates URLs and where resource files are 
located by modifying the Oracle BI Presentation Services configuration file (instanceconfig.xml) to 
add the following entries:

■ “Specifying How Oracle BI Presentation Services Command URLs Are Generated” on page 32

■ “Specifying How Oracle BI Presentation Services Static URLs Are Generated” on page 33

■ “Specifying the Location of Oracle BI Presentation Services Primary Resource Files” on page 33

■ “Specifying the Path to Oracle BI Presentation Services Primary Resource Files” on page 34

■ “Specifying the Location of Oracle BI Presentation Services Nonprimary Resource Files” on page 34

■ “Specifying the Path to Oracle BI Presentation Services Nonprimary Resource Files” on page 35

■ “Specifying Whether Oracle BI Presentation Services Generates Fully Qualified URLs” on page 35

You need to create the elements <URL> and </URL> after the <ServerInstance> element, and place 
your entries between the <URL> and </URL> elements.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

NOTE: Most of the URL entries are interrelated.

Specifying How Oracle BI Presentation Services Command URLs Are 
Generated
You can specify how Oracle BI Presentation Services generates command URLs.

If you explicitly specify an entry, it must be of the following form:

day The standard three-letter abbreviation for the day of the week.

dd The 2-digit day of the month.

mon The standard three-character abbreviation for the month.

year The 4-digit year.

hh:mm:ss The hour, minutes and seconds.

GMT The time zone, Greenwich Mean Time.
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protocol://server/virtualpath

where virtualpath is the complete virtual path to Oracle BI Presentation Services. The default is 
determined separately for each client, based on the URL sent by the client to Oracle BI Presentation 
Services.

The following entry is an example:

<URL>
<AbsoluteCommandURLPrefix>value</AbsoluteCommandURLPrefix>

</URL>

Specifying How Oracle BI Presentation Services Static URLs Are 
Generated
You can specify how Oracle BI Presentation Services generates URLs for static resources such as 
images, script files, style sheets, and other user-specified files. The default is protocol://server from 
the URL\AbsoluteCommandURLPrefix setting, described in “Specifying How Oracle BI Presentation 
Services Command URLs Are Generated” on page 32.

If you explicitly specify an entry, it must be of this form:

protocol://server

If you specify a virtual path, it is removed.

This entry designates a separate Web server for delivering static resources, thereby reducing the 
load on the main Web server. This prefix will be used for the resources that have a fully qualified 
virtual path of the form ‘/Path/file’. If a resource file has a relative virtual path of the form ‘Path/file’, 
the prefix used is the same used for commands to the Oracle BI Presentation Services extension.

The following entry is an example:

<URL>
<ResourceServerPrefix>value</ResourceServerPrefix>

</URL>

Specifying the Location of Oracle BI Presentation Services Primary 
Resource Files
You can override the physical location of Oracle BI Presentation Services’ primary resource files 
(these are the resource files distributed with Oracle BI Presentation Services, not user-customized 
files such as custom styles or skins). The internal default is $(SAROOTDIR)\web\app\res.

You must provide a full path. Oracle BI Presentation Services must have read permission to this path. 
For example, if this is a shared network resource, you need to make sure that the user under which 
Oracle BI Presentation Services is running has read access to the share, as well as read access to 
the file system the share is exported from.

NOTE: If the value for this entry is different from the physical location of the Oracle BI Presentation 
Services DLLs, you must specify a setting for URL\ResourceVirtualPath, described in “Specifying the 
Path to Oracle BI Presentation Services Primary Resource Files” on page 34.

The following entry is an example:
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<URL>
<ResourcePhysicalPath>value</ResourcePhysicalPath>

</URL>

Specifying the Path to Oracle BI Presentation Services Primary 
Resource Files
You can override the virtual path used for Oracle BI Presentation Services’ primary resource files as 
specified by the setting URL\ResourcePhysicalPath, described in “Specifying the Location of Oracle BI 
Presentation Services Nonprimary Resource Files” on page 34. These resource files and customer-
defined resource files must be served from the same Web server.

For generating relative URLs, the virtual path defaults to Res, assuming that the resource folder is 
present under the same virtual directory as the Oracle BI Presentation Services DLL files.

For generating absolute URLs, the entry of the value URL\AbsoluteCommandURLPrefix is used as the 
default.

The value must be a fully qualified virtual path of this form:

‘/VirtualPath’

If you omit the leading slash, one will be added.

The following entry is an example:

<URL>
<ResourceVirtualPath>value</ResourceVirtualPath>

</URL>

Specifying the Location of Oracle BI Presentation Services 
Nonprimary Resource Files
You can override the physical location of resource files that are not part of a default installation. Such 
resource files include customized styles and skins. The internal default is 
$(SADATADIR)\web\app\res.

You must provide a full path. Oracle BI Presentation Services must have read permission to this path. 
For example, if this is a shared network resource, you need to make sure that the user under which 
Oracle BI Presentation Services is running has read access to the share, as well as read access to 
the file system the share is exported from.

The following entry is an example:

<URL>
<CustomerResourcePhysicalPath>value</CustomerResourcePhysicalPath>

</URL>
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Specifying the Path to Oracle BI Presentation Services Nonprimary 
Resource Files
You can override the virtual path used for resource files that are not part of a default installation as 
specified in the setting URL\CustomerResourcePhysicalPath, described in “Specifying the Location of 
Oracle BI Presentation Services Nonprimary Resource Files” on page 34. The internal default is Res.

The following entry is an example:

<URL>
<CustomerResourceVirtualPath>value</CustomerResourceVirtualPath>

</URL>

Specifying Whether Oracle BI Presentation Services Generates Fully 
Qualified URLs
You can override whether Oracle BI Presentation Services always generates fully qualified URLs for 
resource files that have fully qualified virtual paths. The internal default is No.

When set to No, resources and the Oracle BI Presentation Services extension are served from one 
server. When set to Yes, default resources are served from the same server as the Oracle BI 
Presentation Services extension, and customer resources are served from another server. Depending 
on the value of the other settings described in this section, you could also set it up to have default 
and customer resources served from one server, and the Oracle BI Presentation Services extension 
served from another server.

The following entry is an example:

<URL>
<ForceAbsoluteResourceURL>value</ForceAbsoluteResourceURL>

</URL>

Specifying the Default Language for the 
Oracle BI Presentation Services Login 
Screen
The default language in which the Oracle BI Presentation Services login screen appears is obtained 
from the user’s client browser settings. The following procedure explains how to change the 
language.

NOTE: The following procedure uses Internet Explorer 6.0 as an example. If you are using a different 
browser, make the necessary substitutions.

To change the default language on a user’s login screen

1 In Internet Explorer, choose Tools > Internet Options.

The Internet Options dialog box appears.
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2 Click Languages.

The Language Preference dialog box appears.

Installed languages appear in the Languages list. The language at the top of the list is used as 
the default language.

3 If the desired language is not installed on the browser, add it.

4 Use the Move Up and Move Down buttons to position the desired language at the top of the list.

5 Restart the browser and log into Oracle BI Presentation Services.

The default language should match the language in the browser’s Language list.

NOTE: If a user does not select a different language from the drop-down list on the login screen, 
the setting for the User Interface Language at the user’s My Account screen determines the 
language in which the user interface is displayed.
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Specifying Whether to Allow HTML Input 
in Oracle BI Presentation Services Fields
The HardenXSS element secures Oracle BI Presentation Services against cross-site scripting (XSS). 
Securing against XSS prohibits HTML input in fields in Oracle BI Presentation Services that would 
otherwise accept HTML. 

By default, Oracle BI Presentation Services is secured against XSS, which means that users cannot 
enter HTML; instead they can enter only plain text. If you want to allow users to enter HTML, add 
the HardenXSS element to the Oracle BI Presentation Services configuration file (instanceconfig.xml) 
and set it to false.

NOTE: In a secure environment (that is, by default or when HardenXSS is set to true), only 
resources (images) that are located in Oracle BI Presentation Services may be used. These images 
are referenced using a relative path prefixed with “fmap:” (for example, fmap:images/
someimage.gif) and cannot be retrieved using a full URL (for example, http://www.somewhere.com/
images/someimage.gif).

HardenXSS does not handle views that may contain HTML (Narrative, Ticker, Static Text, and No 
Results) or the Advanced Tab. Instead, you must deny access to the following privileges for untrusted 
users:

■ View Narrative

■ View Ticker

■ View Static Text

■ View No Results 

■ Answers: Access Advanced Tab

For more information on permissions, see “About Setting Oracle BI Presentation Services Privileges” on 
page 152.

The following entry is an example:

<ServerInstance>
<HardenXSS>false</HardenXSS>

</ServerInstance>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Using the Javahost Service in Oracle BI 
Presentation Services
The Javahost service gives Oracle BI Presentation Services the ability to use functionality provided 
by Java libraries. It supports the following components:

■ Chart generation (Corda)
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■ SVG renderer (Apache Batik)

■ Java tasks support for Oracle BI Scheduler

■ Oracle BI Publisher

Starting and Stopping the Javahost Service
The Javahost service starts and stops automatically, so typically there is no need to start and stop it 
independently. However, if you need to make configuration changes, you should edit the Javahost 
configuration file config.xml and the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), shut down the Javahost service, and then restart it.

The Javahost service has two execution modes:

■ Service mode. Javahost is running in the background, its console is not visible and the user is 
not required to be logged on to the computer. This mode is the normally production environment 
mode.

■ Console mode. Javahost is running in the user console. This mode is useful for troubleshooting 
purposes, because it displays messages.

To start or stop the Javahost service in UNIX
■ Source the (SAROOTDIR)/setup/common.sh file and then use the (SAROOTDIR)/web/javahost/

bin/run.sh command:

■ To start it in Service mode, use a "-service" command line switch.

■ To stop the Javahost service, use the (SAROOTDIR)/web/javahost/bin/shutdown.sh 
command.

This utility opens a TCP/IP connection to Javahost and sends a shutdown signal to it.

To start or stop the Javahost service in Windows
■ To start or stop the Javahost service in Service mode, use the Services control panel and start 

or stop the Oracle Business Intelligence Javahost Service.

■ To start and stop the Javahost service in Console mode requires using the command line:

■ To start it, run <SAROOTDIR>/web/bin/sawjavahostsvc.exe.

■ To stop it, press Ctrl+C.

Javahost Service Command Line Options
When using the command line in UNIX and Windows, you can specify some command line options.

In UNIX, the command line for starting the Javahost service is:

run.sh [-h] [-service] [-Config Javahostconfig]
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In UNIX, the command line for stopping the Javahost service is:

shutdown.sh [-h] [-Config Javahostconfig] [-Port port] [-Host host]

In Windows, the command line for starting the Javahost service in Console mode is:

sawjavahostsvc.exe [-regserver instancename | -regserverauto instancename | 
-unregserver instancename | -h | -service -V ] [-user username] [-pwd password] 
[-SAWConfig instanceconfig] [-Config Javahostconfig]

NOTE: You can specify multiple Javahost configuration files (config.xml) and multiple Oracle BI 
Presentation Services configuration files (instanceconfig.xml). You might want to have multiple 
Javahost configuration files, for example, if you want to define all components supported by Javahost 
services and other necessary settings in one file and then modify the listening port and selectively 
enable and disable components supported by Javahost services in another file. 
If you specify multiple files, the configuration elements are merged and the precedence of values in 
the files is based on the order in which the files are specified.

For example: 

sawjavahostsvc.exe /SAWConfig ../OracleBIData/web/config/instanceconfig.xml /Config 
../javahost/config/config.xml /Config ../javahostconfigs/config.xml 

Table 5 lists and describes the command line options.

Table 5. Javahost Service Command Line Options

Options
Operating 
Systems Description

-regserver instancename Windows Registers the Oracle Business Intelligence 
Javahost service in manual startup mode.

(optional) The instancename parameter is 
used to register more than one Javahost 
service on the same machine. If specified, the 
Javahost service name is set to OracleBI Java 
Host <instancename>.

-regserverauto instancename Windows Registers the Oracle Business Intelligence 
Javahost service in automatic startup mode.

(optional) The instancename parameter is 
used to register more than one Javahost 
service on the same machine. If specified, the 
Javahost service name is set to OracleBI Java 
Host <instancename>.

-unregserver instancename Windows Unregisters the Oracle Business Intelligence 
Javahost service.

(optional) The instancename parameter is 
used when more than one Javahost service is 
registered on the same machine. 
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In UNIX, the shutdown.sh parameters serves one purpose, which is to pass connection information 
(host and port) so that a shutdown signal can be sent to the Javahost service. The following rules 
explain how these parameters interact:

■ If either the -Host or the -Port parameter is specified, then shutdown.sh ignores the -Config 
parameter.

■ If -Host is specified and -Port is not, then shutdown.sh uses 9810 as the port number.

-service UNIX, 
Windows

Executes Javahost in Service mode. On 
Windows, this parameter should never be used 
explicitly. Instead, use the control panel 
Services applet to start and stop the Oracle 
Business Intelligence Javahost service.

-V Windows Displays the version.

-user username Windows Specifies the username for the user account 
which will be used by Windows to launch 
Javahost service. Used in conjunction with the 
-regserver and -regserverauto options.

-pwd password Windows Specifies the password for the user account 
which will be used by Windows to launch 
Javahost service. Used in conjunction with the 
-regserver and -regserverauto options.

-SAWConfig instanceconfig UNIX, 
Windows

Specifies the path to Oracle BI Presentation 
Services configuration file 
(instanceconfig.xml). The default path is:

SADATADIR/web/config/instanceconfig.xml
(where SADATADIR is the data directory)

-Config Javahostconfig UNIX, 
Windows

Specifies the path to config.xml. The default 
path is:

SAROOTDIR\web\javahost\config
(where SAROOTDIR is the installation 
directory)

NOTE: You should use -Config when stopping a 
Javahost service that uses an SSL connection 
so that required SSL configuration parameters 
can be read.

-Port port UNIX Identifies the Javahost listening port.

-Host hostname UNIX Identifies the computer running the Javahost 
service.

Table 5. Javahost Service Command Line Options

Options
Operating 
Systems Description
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■ If the -Config parameter is set, then shutdown.sh uses the instanceconfig.xml file to find the 
Javahost listening port. It expects that the Javahost service is running on the local computer 
(Host=localhost).

■ If no parameters are specified, then shutdown.sh uses Host=localhost and port=9810.

Javahost Service Command Line Properties
The locations of special directories, such as the root directory, in the Oracle Business Intelligence 
environment are passed to Javahost services through Java properties. 

These properties are set automatically by the Java command line as follows:

■ In Windows, by the sawjavahostsvc command 

■ In UNIX, the saw.sh script, located in the SAROOTDIR/setup directory (where SAROOTDIR is the 
installation directory)

You can modify these properties by explicitly setting these property values while configuring the Java 
command line.

Table 6 lists and describes the Javahost Service command line properties.

Configuring the Javahost Service
To configure the Javahost service, you edit Javahost Service configuration elements in the following 
files:

Table 6. Javahost Service Command Line Properties

Property Description

oracle.bi.presentation.coreconfigdir SAROOTDIR\web\config directory 
(where SAROOTDIR is the installation directory)

oracle.bi.presentation.dataconfigdir SADATADIR\web\config directory 
(where SADATADIR is the data directory)

oracle.bi.rootdir SAROOTDIR directory 
(where SAROOTDIR is the installation directory)

oracle.bi.presentation.rootdir SAROOTDIR\web directory 
(where SAROOTDIR is the installation directory)

oracle.bi.tempdir Temporary directory

oracle.bi.javahostdir Javahost root directory

oracle.bi.presentation.cordaroot Corda root directory
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■ Javahost configuration file (config.xml), located in the SAROOTDIR\web\javahost\config 
directory (where SAROOTDIR is the installation directory)

For more information on the elements that you can edit, see “Javahost Service Configuration 
Elements in the config.xml file” on page 42.

■ Oracle BI Presentation Services configuration file (instanceconfig.xml), located in the 
SADATADIR\web\config directory (where SADATADIR is the data directory)

For more information on the elements that you can edit, see “Javahost Service Configuration 
Elements in the instanceconfig.xml File” on page 45.

Javahost Service Configuration Elements in the config.xml file
Table 7 lists and describes the Javahost service elements in the Javahost configuration file 
(config.xml). The elements are identified by their relative path starting from the /JavaHost element.

Table 7. Javahost Service Configuration Elements in config.xml

Element Description

Loaders Contains the following elements:

■ ListOfEnabledLoaders

■ Loader (there can be multiple Loader elements)

Loaders/ListOfEnabledLoaders List of components (such as PDF, Charts, Oracle BI Publisher, 
and so on) to be enabled.

If this element is missing from the file, then all Loaders are 
enabled. If the element has an empty value, then all loaders 
are disabled.

Each component has a corresponding Loader element. The 
name of the component listed here must match the name 
specified in the corresponding Loader/Name element.

Loaders/Loader Contains the following elements, which specify configuration 
information for a specific component:

■ Name

■ Class

■ ConfigNodePath

■ ClassPath

Loaders/Loader/Name Specifies the unique name of the component. Use this name 
in the ListOfEnabledLoaders.

Loaders/Loader/Class Specifies the Loader main class for the component.

Loaders/Loader/ConfigNodePath Specifies the XPath (starting from the /Javahost element) to 
the configuration information for the Loader 
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Loaders//Loader/ClassPath Specifies the class path. 

MessageProcessor Contains the SocketTimeout element.

MessageProcessor/SocketTimeout Specifies the idle timeout (in milliseconds) for socket after 
which socket is returned to the idle sockets pool. Javahost 
uses a socket polling mechanism to wait for new data on the 
whole set of idle sockets in a single thread. 

Default: 5000 (5 seconds)

Listener Contains the following elements:

■ PermittedClientList

■ Port

■ Address

■ Secure

Listener/PermittedClientList Specifies a list of IP addresses and host names from which 
Javahost accepts incoming connections. Separate each client 
by a comma. To accept all client connections, set this 
element to an asterisk (*).

Default: *

Listener/Port Identifies the Javahost TCP/IP listening port.

Default: 9810

For information on using the Hosts/Host element to identify 
specific instances of Javahost processes, see Oracle Business 
Intelligence Enterprise Edition Deployment Guide.

Listener/Address Specifies the network interface that Javahost is to bind to. If 
this element has no value, Javahost will bind to all available 
network interfaces.

Listener/Secure Specifies whether to enable SSL encryption:

■ Yes: Enables SSL encryption

■ No: Disables SSL encryption

Default: No

For more information on SSL, see Oracle Business 
Intelligence Enterprise Edition Deployment Guide.

Table 7. Javahost Service Configuration Elements in config.xml

Element Description
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Charts Contains the following elements:

■ InputStreamLimitInKB

■ ChartRoot

■ CordaRoot

■ EnableConsoleOutput

Charts/InputStreamLimitInKB Specifies the maximum input size for charts requests. A 
value of zero deactivates this limit. If you cannot generate a 
chart using the default value, slowly increase this setting 
until you find the optimum value.

Default: 1024

Charts/ChartRoot Specifies the path to the Corda chart_root directory.
Default:{CordaRoot}/chart_root.

Charts/CordaRoot Specifies the path to the Corda installation.
Default: SAROOTDIR/Corda50
(where SAROOTDIR is the installation directory)

Charts/EnableConsoleOutput Specifies whether to enable the Corda console diagnostic 
messages:

■ Yes: Enables the Corda console diagnostic messages

■ No: Disables the Corda console diagnostic messages

Default: No

Scheduler Contains these elements:

■ Enabled

■ DefaultPurgingPeriod

Scheduler/Enabled Specifies whether to enable Scheduler:

■ True: Enables Scheduler

■ False: Disables Scheduler

Default: False

Scheduler/DefaultUserJarFilePath Specifies the default directory for users to put their Java 
extension utility jar files in.

When Scheduler is enabled, this element is required and 
accepts a single path. 

Table 7. Javahost Service Configuration Elements in config.xml

Element Description
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Javahost Service Configuration Elements in the instanceconfig.xml 
File
Table 8 lists and describes the Javahost service elements in the Oracle BI Presentation Services 
configuration file (instanceconfig.xml). The elements are identified by their relative path starting 
from the /WebConfig/ServerInstance element.

Scheduler/DefaultTempFilePath Specifies the default temporary file directory for Scheduler 
requests.

Default: {systemtempdir}
(where {systemtempdir} is the system temp directory)

Scheduler/DefaultPurgingPeriod Specifies the default purging period (in seconds) for 
Scheduler requests to clean up failed jobs.

Default: 300

XMLP Contains the InputStreamLimitInKB element.

XMLP/InputStreamLimitInKB Specifies the maximum input size for Oracle BI Publisher 
requests. A value of zero deactivates this limit.

Default: 8192

Table 8. Javahost Service Configuration Elements in instanceconfig.xml

Element Description

JavaHome Specifies the path to the root directory of JDK or JRE 
installation.

Default: Value of JAVA_HOME environment variable

JavaHost/InitLoggerDir Specifies the absolute path to the directory where 
sawjavahostsvc.exe writes log information before it loads 
java. If the value of this element is empty, logging is 
disabled.

Default: SADATADIR/web/log/javahost (where SADATADIR 
is the data directory).

JavaHost/JniLibrary Specifies the absolute path to jvm.dll.

Default: {JavaHome}/jre/bin/server/jvm.dll
If that file does not exist, then:
{JavaHome}/bin/server/jvm.dll, where {JavaHome} is the 
path to JDK or JRE installation.

Table 7. Javahost Service Configuration Elements in config.xml

Element Description
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Javahost Service Logging
The Javahost service uses a standard Java logging engine. By default, Javahost uses a logging 
configuration file located at SADATADIR/web/config/logconfig.txt (where SADATADIR is the data 
directory). For the logging file format description, see publicly available Java documentation.

On Windows, several initialization messages could be written before Java is initialized. Use the 
JavaHost/InitLoggerDir configuration key to control the location where those messages are written.

Configuration Keys
Use the Oracle BI Presentation Services configuration file (instanceconfig.xml) to configure many 
elements for Oracle BI Presentation Services behavior. Do not use any keys unless you are overriding 
the stated default values. You should keep the instanceconfig.xml file as short as possible and 
override only those settings that are necessary for configuring your implementation.

For organizations that use Oracle Application Server, Oracle recommends that you use Oracle 
Application Server Control to modify configuration files. For organizations that use other application 
servers, Oracle recommends that you use JConsole. For more information, see the Oracle Business 
Intelligence Infrastructure Installation and Configuration Guide.

All configuration keys follow this format:

<key_name>value</key_name>

Example: add configuration keys for DefaultTimeoutMinutes (Level is “/”) and MaxVisiblePages (level 
is “/PivotView”) to instanceconfig.xml

JavaHost/JVMOptions Specifies the Java command line parameters.
Default: -Xms128m -Xmx256m -Xrs 
"-Djava.class.path={CLASSPATH}"
"-Djava.awt.headless=true"
"-Djava.util.logging.config.file=
{JAVAHOSTROOTDIR}/config/logconfig.txt" where 
{CLASSPATH} is the list of javahost jar files separated by 
semicolons and {JAVAHOSTROOTDIR} is the Javahost root 
directory SADATADIR/web/javahost

JavaHost/UseDefaultJVMOptions Specifies whether to use the default JVMOptions:

■ Yes: Merges the value of the JavaHost/JVMOptions 
element with its default value.

■ No: Uses the value of the JavaHost/JVMOptions 
element, which specifies the exact command line for 
Java.

Default: Yes

Table 8. Javahost Service Configuration Elements in instanceconfig.xml

Element Description
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<WebConfig>
<ServerInstance>

<CatalogPath>/OracleBIData/web/catalog/default</CatalogPath>
<DSN>AnalyticsWeb</DSN>
<DefaultTimeoutMinutes>3000</DefaultTimeoutMinutes>
<PivotView>

<MaxVisiblePages>2000</MaxVisiblePages>
</PivotView>

</ServerInstance>
</WebConfig>
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3 Administering Oracle BI 
Answers

This chapter describes procedures that are used to administer Oracle BI Answers. For an introduction 
to Answers, read Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User 
Guide.

This chapter contains the following topics:

■ Managing Settings for the Oracle BI Presentation Services Chart Image Server on page 49

■ Managing the Oracle BI Presentation Services Charting Settings on page 51

■ Configuring Answers Pivot Table Settings on page 52

■ Configuring the Maximum Number of Rows in an Answers Table View on page 53

■ Adding Support for Navigation and Drill Down in Answers on page 54

■ Changing the Default Currency in Answers on page 54

■ Nesting Folders in the Selection Pane in Answers on page 55

■ Blocking Requests in Answers on page 56

■ Specifying View Defaults for Answers and Dashboards Users on page 60

■ Changing Alternating Bar Color on page 65

Managing Settings for the Oracle BI 
Presentation Services Chart Image 
Server
Oracle BI Presentation Services uses a third-party charting engine to render charts (PopChart Image 
Server from CORDA Technologies, Inc.). You can override the default image type by modifying the 
Oracle BI Presentation Services configuration file (instanceconfig.xml) to add the following entries:

■ “Specifying the Oracle Business Intelligence Chart Image Type” on page 50

■ “About Downloading and Using Flash as the Default Image Type in Oracle Business Intelligence” on 
page 50

You need to create the elements <Charts> and </Charts> after the <ServerInstance> element, and 
place your entries between the <Charts> and </Charts> elements.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.
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Specifying the Oracle Business Intelligence Chart Image Type
You can override the image type generated by the PopChart Image Server. The internal default is 
Flash.

The other choices are SVG (W3C Scalable Vector Graphics), PNG (W3C Portable Network Graphics), 
and JPEG. Flash and SVG images provide the greatest degree of interaction because they support 
mouseover behaviors (such as pop-up data labels), navigation, and drilling.

The following entry is an example:

<Charts>
<DefaultImageType>PNG</DefaultImageType>

</Charts>

About Downloading and Using Flash as the Default Image Type in 
Oracle Business Intelligence
In some organizations, users are instructed to download the latest Flash software from a corporate 
location instead of the vendor’s Web site. The default download source for Oracle BI Presentation 
Services is the vendor’s Web site. You can modify the default download source to point to another 
location. Then, when users view a chart in Oracle Business Intelligence and a newer version of the 
Flash software is available on the corporate server, they can be prompted to download the newer 
version. This section contains the following topics:

■ “Modifying the Default Flash Download Source” on page 50

■ “Enabling a Download Prompt for New Flash Versions” on page 50

Modifying the Default Flash Download Source
The default download source for the Flash plug-in is the vendor’s Web site. You can change this to 
another location by modifying the Oracle BI Presentation Services configuration file 
(instanceconfig.xml) to point to the location that holds the Flash code base.

NOTE: You need to create the elements <FlashCodeBase> and </FlashCodeBase> after the 
<Charts> element, and place your entries between the <FlashCodeBase> and </FlashCodeBase> 
elements.

The following entry is an example:

<Charts>
<FlashCodeBase>\\CORPORATE\Download\Flash</FlashCodeBase>

</Charts>

Enabling a Download Prompt for New Flash Versions
After modifying the default Flash download source, you can enable a download prompt by creating 
a new classID for the Flash ActiveX control to add a custom global identifier (clsid) property. You can 
obtain the current global identifier property from any machine where Oracle BI Presentation Services 
charting is being used. (The global identifier property used by Oracle Business Intelligence is 
D27CDB6E-AE6D-11CF-96B8-444553540000.) The custom global identifier property must contain 
the same number of characters and dashes as the global identifier used in the default Flash ActiveX 
control.



Administering Oracle BI Answers ■ Managing the Oracle BI Presentation Services
Charting Settings

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

51

The following entry is an example:

<Charts>
<FlashCLSID>E38CDB6E-BA6D-21CF-96B8-432553540000</FlashCLSID>

</Charts>

You should test flash charts independent of Oracle Business Intelligence to make sure that they 
function with the custom global identifier property.

Managing the Oracle BI Presentation 
Services Charting Settings
You can change certain Oracle BI Presentation Services charting settings from their internal default 
settings by adding entries to the Oracle BI Presentation Services configuration file 
(instanceconfig.xml):

■ “Specifying the Location of Temporary Storage for Chart Cache in Oracle BI Presentation Services” 
on page 51

■ “Specifying the Interactive Behavior of Charts in Oracle BI Presentation Services” on page 52

■ “Specifying the URL for Chart Navigation in Oracle BI Presentation Services” on page 52

You need to create the elements <Chart> and </Chart> after the <ServerInstance> element, and 
place your entries between the <Chart> and </Chart> elements.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Specifying the Location of Temporary Storage for Chart Cache in 
Oracle BI Presentation Services
You can override the internal default entry for the location used by Oracle BI Presentation Services 
as temporary storage for chart cache. The internal default is 
dirletter:\SADATADIR\Temp\nQWCharts, where dirletter is the drive where the Oracle BI 
Presentation Services software is installed and SADATADIR is the data directory.

The location should be a fully-qualified path name, such as d:\OracleBIChartCache. The folder or 
directory structure must exist before you start the service for Oracle BI Presentation Services again.

The following entry is an example:

<Charts>
<CacheDirectory>/usr/local/OracleBI/Data/temp/chartcache</CacheDirectory>

</Charts>
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Specifying the Interactive Behavior of Charts in Oracle BI 
Presentation Services
You can override the default interactive behavior of Oracle BI Presentation Services charts. Valid 
entries are Drill, Navigate and None. The default is Drill. This means that charts are created drillable 
by default.

If you specify Navigate, charts navigate to the URL described in “Specifying the URL for Chart 
Navigation in Oracle BI Presentation Services” on page 52. If you specify None, charts are not 
interactive; for example, clicking on a chart or chart region does nothing.

The following entry is an example:

<Charts>
<DefaultInteraction>Navigate</DefaultInteraction>

</Charts>

Specifying the URL for Chart Navigation in Oracle BI Presentation 
Services
If you specify Navigate as the interactive behavior of charts (described in “Specifying the Interactive 
Behavior of Charts in Oracle BI Presentation Services” on page 52), you can override the default URL 
to which charts navigate. The internal default URL is http://www.oracle.com/.

If the interactive behavior is not Navigate, this entry is ignored.

The following entry is an example:

<Charts>
<DefaultNavigationPath>http://www.intranet.com/</DefaultNavigationPath>

</Charts>

Configuring Answers Pivot Table 
Settings
You can change certain pivot table settings from their internal defaults by adding entries to the 
<PivotView> element in the Oracle BI Presentation Services configuration file (instanceconfig.xml):

■ “Specifying the Maximum Number of Records to Process in an Oracle Business Intelligence Pivot 
Table”

■ “Specifying the Maximum Number of Populated Cells in an Oracle Business Intelligence Pivot Table”

■ “Specifying the Maximum Number of Sections in an Oracle Business Intelligence Pivot Table”

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.
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Specifying the Maximum Number of Records to Process in an Oracle 
Business Intelligence Pivot Table
You can override the maximum number of records that can be processed by a pivot table. The 
internal default is 20000.

The following entry is an example:

<CubeMaxRecords>30000</CubeMaxRecords>

Specifying the Maximum Number of Populated Cells in an Oracle 
Business Intelligence Pivot Table
You can override the maximum number of populated cells that Oracle BI Presentation Services has 
in a pivot table. The internal default is 150000. If the user exceeds this value, the server returns an 
error message when the pivot table is rendered.

The following entry is an example:

<CubeMaxPopulatedCells>160000</CubeMaxPopulatedCells>

Specifying the Maximum Number of Sections in an Oracle Business 
Intelligence Pivot Table
You can override the maximum number of sections that Oracle BI Presentation Services displays in 
a pivot table. The internal default is 1000.

The following entry is an example:

<MaxVisibleSections>500</MaxVisibleSections>

Configuring the Maximum Number of 
Rows in an Answers Table View
You can override the maximum number of rows that can appear in a Table view by modifying the 
Oracle BI Presentation Services configuration file (instanceconfig.xml) to add the following entry. The 
internal default is 65000. If the user exceeds this value, the server returns an error message when 
the table view is rendered.

NOTE: This entry applies to the Table view, not the Pivot Table view.

The following entry is an example:

<ResultRowLimit>95000</ResultRowLimit>

The ResultRowLimit entry controls the maximum value that can be set for the DefaultRowsDisplayed, 
DefaultRowsDisplayedInDelivery, and the DefaultRowsDisplayedInDownload entries. To set 
DefaultRowsDisplayed, DefaultRowsDisplayedInDelivery, or DefaultRowsDisplayedInDownload to a 
value that exceeds the current value of ResultRowLimit, you also must increase the value of 
ResultRowLimit to equal or exceed the value that you want to set.
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Adding Support for Navigation and Drill 
Down in Answers
When you create a request, you can allow users to navigate to related requests and content. If the 
Oracle BI Server Administrator set up dimensions and dimensional hierarchies for the subject area, 
users can drill down on data results presented in charts, tables and pivot tables to obtain more 
detailed information.

There are no specific privilege settings that impact access to Oracle BI Presentation Services 
Navigation and drill down features, which are available to all users.

Dimensional hierarchies are a system of levels in a dimension that are related to each other by one-
to-many relationships. For example, a region hierarchy might be defined as a postal code rolling up 
to a city, rolling up to a region. There is exactly one city and one region corresponding to a single 
postal code, but there might be many postal codes corresponding to a single city, and there might 
be many cities corresponding to a single region.

Users drill down to move through the dimensional hierarchies associated with the subject area to 
obtain more detailed results. For example, if the results contain a total sales column, the user might 
be able to click total sales to drill down on sales by region, and then click a region to display sales 
by city in that region. The information available to Oracle BI Presentation Services users through drill 
down is constrained by the dimensional hierarchies configured by the Oracle BI Server Administrator 
for the specific subject area.

For information about setting up dimensions and hierarchies, read Oracle Business Intelligence 
Server Administration Guide.

Changing the Default Currency in 
Answers
You can change the default currency displayed in the Answers user interface, for example, from 
French Francs to Euros.

If you are using Oracle Business Intelligence applications, with no customizations, you only need to 
set the default data warehouse currency.

If you have created additional subject areas, the currency column data is in the number format, and 
you need to specify the currency for the customized subject area as described in the second 
procedure.

For more information about using formatting functions in Answers, read Oracle Business Intelligence 
Answers, Delivers, and Interactive Dashboards User Guide.

To set the default data warehouse currency

1 Open the currencies.xml file in the directory \\SAROOTDIR\web\config, where SAROOTDIR is the 
installation directory.

2 Search for the currency to make the default, for example, USD, CAD, PEN, or MAD.
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3 Copy the entire currency element.

For example, copy the currency tag for the Euro:

- <Currency tag="int:euro-l" type="international" symbol="_" 
displayMessage="kmsgCurrencyEuroLeft" digits="2" format="$ #"> 

<negative tag="minus" format="-$ #" /> 

</Currency>

4 Search for the text string int:wrhs, located towards the top of the file.

5 Select the entire element and replace it by pasting the copied element over it.

6 Replace the tag attribute so it reads int:wrhs.

For example, replace tag="int:euro-l" with tag="int:wrhs".

7 Restart the service for Oracle BI Presentation Services.

To specify the currency for customized subject areas

1 In Answers, modify the request that uses the subject area.

2 Click the Format Column button for the currency column.

The Column Properties dialog box appears.

3 At the Value Format tab, in the Data Format area, click the following option:

Override Default Data Format

4 In the Treat Numbers As drop-down list, select Currency.

5 In the Currency Symbol drop-down list, select the currency symbol.

6 To save this as the system-wide default for this data type, click Save, and then select the 
appropriate option.

7 Click OK when you are done, and then repeat the preceding steps for any other columns to 
change.

Nesting Folders in the Selection Pane in 
Answers
To make selections easy for users to discern in the selection pane, you can set up the presentation 
layer in the Oracle Business Intelligence Administration Tool to give the appearance of nested folders. 
For example, you can make the Sales Facts folder appear as a subfolder in the Facts folder. You can 
accomplish this during the construction of the presentation layer by prefixing the name of a folder 
to appear as a subfolder with a hyphen ( - ) and a space.

The preconfigured Oracle Business Intelligence repository for Oracle’s Siebel operational applications 
provides examples of this construction. For more information, read Oracle Business Intelligence 
Server Administration Guide.
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Blocking Requests in Answers
You may want to block specific requests, such as requiring users to include certain columns with 
others, or requiring filters when certain columns are requested. Answers includes an API that you 
can use to block queries based on the criteria specified in the user’s request, or based on formulas 
in the request. You can access the API using JavaScript to check conditions and validate requests.

This section contains the following topics:

■ Blocking Requests Based on Criteria on page 56

■ Blocking Requests Based on Formula on page 57

■ Validation Helper Functions on page 59

Blocking Requests Based on Criteria
When a user attempts to execute a request that your code blocks, you can display an error message, 
and the request will not be executed. The answerstemplates.xml file includes a message named 
kuiCriteriaBlockingScript that can be overridden to either define or include JavaScript that defines a 
validateAnalysisCriteria function. By default, this message contains a function that always returns 
True. It should be overridden using the procedures described in “Customizing the Oracle BI 
Presentation Services User Interface Using XML Message Files” on page 192.

Answers calls your validateAnalysisCriteria function when the user tries to execute the request. The 
function can return True if the request is not blocked, or False or a message if the request is blocked. 
If a message or a value other than False is returned, the message is displayed in a popup window. 
In either case, the query is blocked.

The following code example shows the blocking of a query.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="QueryBlocking" table="Messages">

<WebMessage name="kuiCriteriaBlockingScript" translate="no">
<HTML>

<script language="javascript" src="fmap:myblocking.js" />
</HTML>

</WebMessage>

</WebMessageTable>
</WebMessageTables>

Sample blocking script in …/OracleBIData/web/res/myblocking.js

// This is a blocking function. It makes sure users pick what I want them to.
function validateAnalysisCriteria(analysisXml)
{

// Create the helper object
var tValidator = new CriteriaValidator(analysisXml);
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// Validation Logic
if (tValidator.getSubjectArea() != "Paint")

return "Why don't you try Paint?";

if (!tValidator.dependentColumnExists("Markets","Region","Markets","District"))
{

// If validation script notifies user, then return false
alert("Region and District go so well together, don't you think?");
return false;

}

if (!tValidator.dependentColumnExists("Sales Measures","","Periods","Year"))
return "You picked a measure so pick Year!";

if (!tValidator.filterExists("Sales Measures","Dollars"))
return "Why don't you filter on Dollars?";

if (!tValidator.dependentFilterExists("Markets","Market","Markets"))
return "Since you're showing specific Markets, please filter the markets.";

var n = tValidator.filterCount("Markets","Region");
if ((n <= 0) || (n > 3))

return "Please select 3 or fewer specific Regions";

return true;
}

If you do not override the function using the template as described previously, or if the function 
returns anything other than False, the criteria is considered to be valid and the request is issued. 
The criteria is validated using this same mechanism for preview and save operations as well.

Blocking Requests Based on Formula
Answers provides a hook to create and incorporate a JavaScript validation function that is called from 
Answers when a user enters or modifies a column formula. If the call fails and returns a message, 
Answers displays the message and cancels the operation. Additionally, helper functions are available 
so the query blocking function can check for filters, columns, and so on, rather than traversing the 
DOM manually. For more information on the helper functions, read “Validation Helper Functions” on 
page 59.

The criteriatemplates.xml file includes a message named kuiFormulaBlockingScript that can be 
overridden to include JavaScript that defines a validateAnalysisFormula function. By default, this 
message contains a function that always returns True.

Answers calls validateAnalysisFormula before applying changes made by the user. If the function 
returns True, the formula is accepted. If the function returns False, the formula is rejected. 
Otherwise, the return value from the function is displayed in the message area beneath the formula, 
as it does currently when an invalid formula is entered.
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The user has the option to click OK to ignore the error. To display your own alert and allow the user 
to continue, your function should return True. To block the query, return False or a message. Your 
function should investigate the formula passed to it using JavaScript string and regular expression 
techniques for validation.

The following code example shows a sample custom message.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="QueryBlocking" table="Messages">

<WebMessage name="kuiFormulaBlockingScript" translate="no">
<HTML>

<script language="javascript" src="fmap:myblocking.js" />
</HTML>

</WebMessage>

</WebMessageTable>
</WebMessageTables>

The following code example shows blocking based on the formula entered.

// This is a formula blocking function. It makes sure the user does not enter an 
unacceptable formula.
function validateAnalysisFormula(sFormula, sAggRule)
{

// we don't allow the use of concat || in our formulas
var concatRe = /\|\|/gi;
var nConcat = sFormula.search(concatRe);
if (nConcat >= 0)

return "You used concatenation (character position " + nConcat + "). That is 
not allowed.";

// no case statements please
var caseRe = /CASE.+END/gi;
if (sFormula.search(caseRe) >= 0)

return "Please do not use a case statement.";

// Check for a function syntax: aggrule(formula) aggrule should not contain a '.'
var castRe = /^\s*\w+\s*\(.+\)\s*$/gi;
if (sFormula.search(castRe) >= 0)

return "Please don't use a function syntax such as RANK() or SUM().";

   return true;
}
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Validation Helper Functions
These functions are defined within a JavaScript file named answers/queryblocking.js. Table 9 
contains the list of helper functions and their descriptions.

Table 9. Validation Helper Functions

Validation Helper Function Description

CriteriaValidator.getSubjectArea() Returns the name of the subject area referenced by the 
request. It generally is used in a switch statement within the 
function before doing other validation. If the request is a 
set-based criteria, it returns null.

CriteriaValidator.tableExists 
(sTable)

Returns True if the specified table has been added to the 
request by the user, and False if the table was not added.

CriteriaValidator.columnExists 
(sTable, sColumn)

Returns True if the specified column has been added to the 
request by the user, and False if the column was not added.

CriteriaValidator.dependentColumn
Exists(sCheckTable, 
sCheckColumn, sDependentTable, 
sDependentColumn)

Checks to make sure that the dependentColumn exists if the 
checkColumn is present. It returns True if either the 
checkColumn is not present, or the checkColumn and the 
dependent column are present. If checkColumn and 
dependentColumn are null, the tables are validated. If any 
column from checkTable is present, a column from 
dependentTable must be present.

CriteriaValidator.filterExists(sFilter
Table, sFilterColumn)

Returns True if a filter exists on the specified column, and 
False if no filter is present.

CriteriaValidator.dependentFilterEx
ists(sCheckTable, sCheckColumn, 
sFilterTable, sFilterColumn)

Checks to make sure that the dependentFilter exists if the 
checkColumn is present in the projection list. It returns True 
if either the checkColumn is not present, or the 
checkColumn and the dependent filter are present.

CriteriaValidator.filterCount(sFilter
Table, sFilterColumn)

Returns the number of filter values specified for given logical 
column. If the filter value is "equals," "null," "notNull," or 
"in," it returns the number of values chosen. If the column 
is not used in a filter, it returns zero. If the column is 
prompted with no default, it returns -1. For all other filter 
operators (such as "greater than," "begins with," and so on) 
it returns 999, because the number of values cannot be 
determined.
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Specifying View Defaults for Answers 
and Dashboards Users
You can control some aspects of the initial state of new views that are added to a request within 
Answers and new objects that are added to a dashboard page. You do this by customizing the 
appropriate XML message files to override the default values distributed withOracle BI Presentation 
Services.

Some of the default values you can customize are shown in the following list:

■ Allowing the sorting of table columns in a dashboard.

■ Adding a default page footer to new reports.

■ Preventing the auto-previewing of results when working with a view.

■ Specifying which views are contained in the compound layout view.

■ Specifying which links to display with an embedded report in the dashboard.

■ Allowing newly created dashboard sections to be collapsible.

XML Message Files for View Defaults
This section describes the XML message files to customize to override the view defaults distributed 
with Oracle BI Presentation Services.

NOTE: For information about the core tasks required to customize XML message files, read 
“Customizing the Oracle BI Presentation Services User Interface Using XML Message Files” on page 192.

For Answers, the file answerstemplates.xml includes a message named 
kuiCriteriaDefaultViewElementsWrapper from within kuiAnswersReportPageEditorHead. This 
message includes two additional messages, kuiCriteriaDefaultViewElements, in which you can define 
default values, and kuiCriteriaDefaultViewElementsMask, in which masks are defined.

NOTE: The mask XML message is protected and you cannot modify its contents.

The wrapper message adds the combined XML into a JavaScript variable, 
kuiDefaultViewElementsXML, that is used to apply the new default values.

For Dashboards, the file dashboardtemplates.xml includes a message named 
kuiDashboardDefaultElementsWrapper that adds XML into a JavaScript variable named 
kuiDefaultDashboardElementsXML for use within the dashboard editor.

Examples of Customizing Answers and Dashboards 
Default Values
The following sections provide examples of customizing default values:

■ “Adding a Default Header or Footer to New Reports” on page 61

■ “Allowing Sorting in Tables in Dashboards” on page 61
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■ “Preventing Auto-Previewing of Results in Answers” on page 62

■ “Setting Defaults for the Compound Layout View in Answers” on page 62

■ “Changing Dashboards Section Defaults” on page 63

■ “Including Refresh and Modify Links with Reports on Dashboards” on page 63

■ “Specifying Dashboard Page Defaults Including Headers and Footers” on page 64

NOTE: For information about the core tasks required to customize XML message files, read 
“Customizing the Oracle BI Presentation Services User Interface Using XML Message Files” on page 192. 
The examples in this section assume you have read this information.

Adding a Default Header or Footer to New Reports
You can specify to the system that default headers and footers appear on all new reports. Footers, 
for example, can contain messages such as a confidentiality notice, the company’s name, and so on. 
You can specify a default header or footer by creating an XML message that specifies the text and 
formatting that should be applied, and then deploying it to Oracle BI Presentation Services.

The following XML code example creates a footer that contains the text "Acme Confidential" in bold, 
red letters.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">

<WebMessage name="kuiCriteriaDefaultViewElements" translate="no"><HTML>
<view signature="compoundView" >

<pageProps pageSize="a4">
<pageFooter showOnDashboard="true" show="true">

<zone type="top"><caption>[b]Acme Confidential[/b]</caption>
<displayFormat fontColor="#FF0000"/></zone>

</pageFooter>
</pageProps>

</view>
</HTML></WebMessage>

</WebMessageTable>
</WebMessageTables>

Allowing Sorting in Tables in Dashboards
By default, Oracle Business Intelligence table views are not sortable within dashboards and result 
views. To make tables sortable, create an XML message that specifies the text and formatting that 
should be applied, and deploy it to Oracle BI Presentation Services. Then, when a new table view is 
created in Answers, the option to allow sorting in dashboards will be selected by default.

The following XML code example turns on the option to allow sorting.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">
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<WebMessage name="kuiCriteriaDefaultViewElements" translate="no"><HTML>
<view signature="tableView" sortable="true" />

</HTML></WebMessage>

</WebMessageTable>
</WebMessageTables>

Preventing Auto-Previewing of Results in Answers
Oracle Business Intelligence displays the results of the request when editing most views within 
Answers. If you prefer that the user explicitly ask to view the results, you can create an XML message 
that specifies that auto-preview should be disabled when new views are created. The user can still 
click the display results link to view the results when editing a view.

The following XML code example disallows the auto-previewing of results when working with a view 
in Answers.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">

<WebMessage name="kuiCriteriaDefaultViewElements" translate="no"><HTML>
<view signature="tableView" showToolBar="true" showHeading="true />
<view signature="pivotTableView" autoPreview="false" />
<view signature="titleView" autoPreview="false" />
<view signature="viewSelector" autoPreview="false" />
<view signature="htmlviewnarrativeView" autoPreview="false" />
<view signature="tickerview" autoPreview="false" />
<view signature="htmlview" autoPreview="false" />

</HTML></WebMessage>

</WebMessageTable>
</WebMessageTables>

Setting Defaults for the Compound Layout View in Answers
Answers displays the results of a newly formed request as a title view followed by a table view. You 
can create an XML message that specifies that the compound view should default to a different 
collection of views, such as a table view followed by a filters view. The user can still add and 
rearrange views within the compound layout view.

The following XML code example sets the default compound layout view to a table view followed by 
a filters view.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">

<WebMessage name="kuiCriteriaDefaultViewElements" translate="no"><HTML>
<view signature="compoundView" >

<cv signature="tableView" />
<cv signature="filtersView" />

</view>
</HTML></WebMessage>
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</WebMessageTable>
</WebMessageTables>

Changing Dashboards Section Defaults
By default, Oracle Business Intelligence displays the results of drilling in the dashboard on a new 
page, does not show section names in the dashboard, and does allow users to expand and collapse 
sections. You can change these default values by creating an XML message that specifies that new 
default values for the dashboard section.

The following XML code example makes section heads visible, enables drilling, and does not allow 
users to collapse the sections.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">

<WebMessage name="kuiDashboardDefaultElements" translate="no"><HTML>
<element signature="dashboardSection" drillInline="true" showHeading="true" 

collapsible="false" />
</HTML></WebMessage>

</WebMessageTable>
</WebMessageTables>

Including Refresh and Modify Links with Reports on Dashboards
By default, Oracle Business Intelligence displays the results of embedded reports within the 
dashboard without including any links. If you prefer that newly added reports default to having 
Modify and Refresh links, for example, you can create an XML message that specifies that the report 
elements should behave this way. A user editing the dashboard can still modify this behavior using 
the menus within the dashboard editor.

In the XML message file, the links attribute can contain any combination of the letters d, f, g, m, and 
r to add the indicated link, as shown in Table 10.

The following XML code example adds Modify and Refresh links to new reports embedded in 
dashboards.

Table 10. Attribute Values for Adding Links to Embedded Reports

Attribute Link Added to Report on the Dashboard

d Download

f Print

g Add to Briefing Book

m Modify

r Refresh
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<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">

<WebMessage name="kuiDashboardDefaultElements" translate="no"><HTML>
<element signature="reportView" display="embed" links="mr" />

</HTML></WebMessage>

</WebMessageTable>
</WebMessageTables>

Specifying Dashboard Page Defaults Including Headers and Footers
By default, Oracle Business Intelligence prints dashboards without headers or footers, and in a 
portrait orientation. If you prefer that newly added dashboard pages default to having a custom 
header and footer and print in landscape orientation, you can create an XML message that specifies 
these items. A user editing the dashboard can still modify this behavior using the menus within the 
dashboard editor.

The following XML code example adds a custom header and footer to a dashboard page and specifies 
landscape orientation.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web.messageSystem">

<WebMessageTable system="Answers" table="ViewDefaults">

<WebMessage name="kuiDashboardDefaultElements" translate="no"><HTML>

<element signature="dashboardPage" personalSelections="false">
<pageProps orientation="portrait" printRows="all" pageSize="a4">

<pageHeader showOnDashboard="true" show="true">
<zone type="top"><caption>[b]Acme is Cool[/b]</caption>
<displayFormat fontSize="9pt" hAlign="center"

fontColor="#FFFFFF" backgroundColor="#000000"/></zone>
</pageHeader>
<pageFooter showOnDashboard="true" show="true">

<zone type="top"><caption>[b]CONFIDENTIAL
@{timeCreated[mm/dd/yy]}[/b]</caption>

<displayFormat fontSize="7.5pt" hAlign="center"
fontColor="#999999" borderColor="#CC99CC" fontStyle="italic"
borderPosition="all" borderStyle="single"/></zone>

</pageFooter>
</pageProps>

</element>

</HTML></WebMessage>

</WebMessageTable>
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Changing Alternating Bar Color
Both pivot tables and normal tables can have colored bars on alternating lines. The default color for 
these alternating bars is green. For Pivot tables, the Edit Format window has many advanced 
formatting controls, including one for the alternating bar color. If you need to change the default 
color in tables, you can make an edit in a style configuration file.

To change the color, edit the views.css file in the b_mozilla_4 folder. Locate this text:

TABLE.ResultsTable TD.ECell
{
background-color: #DDF2DD;

Change the six-digit hexadecimal color value to a new color value.

The control for turning on the alternating text is in the Edit View window. It has a check box labelled: 
Enable alternating row “Green bar” styling. If you have changed the color of the bars, you may also 
want to change the label to indicate the color you are now using.

To change the label text, open the tableviewmessages.xml file and find this entry:

WebMessageName = "kmsgTableViewEnableGreenbarReporting"

Copy the entry and the text line below it to a custom messages file in the custom messages folder, 
and change the text line appropriately. For example:

WebMessageName = "kmsgTableViewEnableGreenbarReporting"
<TEXT>Enable alternating row "RED bar" styling</TEXT>"

For more information on custom messages, read “Customizing the Oracle BI Presentation Services User 
Interface Using XML Message Files” on page 192.
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4 Administering Oracle BI 
Delivers

This chapter describes procedures used to administer Oracle BI Delivers. For information about using 
Delivers, read Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User 
Guide.

This chapter contains the following topics:

■ About Delivers iBots and Impersonation on page 67

■ About Delivers iBots and AntiVirus Software on page 68

■ Viewing Entries in the Delivers iBot Log Directory on page 68

■ Disabling Delivers on page 69

■ Specifying the Machine Running Oracle BI Scheduler on page 70

■ Changing the Directory in Which Delivers iBot Deliveries Are Stored on page 70

■ Integrating Delivers with Oracle’s Siebel Workflow on page 71

■ Using Delivers to Seed the Oracle BI Server Cache on page 71

■ About Permission Settings for Delivers and iBots on page 71

■ Managing Device Types for Delivers on page 72

■ About the SA System Subject Area and Scheduling iBot Deliveries on page 73

■ Setting the Case of Logon Names for the SA System Subject Areal on page 74

■ Controlling Delivery Options for iBots on page 74

■ Viewing Information About Active Delivers iBot Sessions on page 76

About Delivers iBots and Impersonation
Delivers makes use of intelligence agents or Bots (called iBots). iBots are software-based agents 
driven by schedule or events that access, filter, and perform analytics on data based upon defined 
criteria. Users receive information from iBots in the form of alerts that appear on their designated 
delivery devices or dashboards.

To create an iBot, Oracle Business Intelligence administrators and users use Delivers to define the 
actions the iBot is to perform. Oracle BI Presentation Services gathers information about the priority, 
delivery devices, user, and other characteristics; packages that information into a job; and tells 
Oracle BI Scheduler when it wants the job to execute.
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Because Oracle BI Scheduler runs these jobs on behalf of users without accessing or storing their 
passwords, Oracle BI Server permits the Scheduler and Oracle BI Presentation Services to 
impersonate users. This is done by configuring the Scheduler to use a user ID and password with 
administrator privileges that can act on behalf of other users. An iBot logs on to the system using 
this user ID and password, and then the Scheduler executes the job on behalf of the user.

NOTE: If Oracle BI Server is configured to authenticate users through database logons, then 
impersonation is not permitted. Delivers works with database authentication provided that only the 
initialization block set up for authentication in the Oracle Business Intelligence Administration Tool 
uses a connection pool with pass-through authentication. That connection pool cannot be used for 
any other initialization block or request.

For information about user authentication options, read Oracle Business Intelligence Server 
Administration Guide. For information about Oracle BI Scheduler, read Oracle Business Intelligence 
Scheduler Guide.

About Delivers iBots and AntiVirus 
Software
Some antivirus software programs, such as Norton AntiVirus, enable a script-blocking feature, which 
tries to block all calls made by scripts to system objects (such as the Windows file system object) 
that the antivirus software deems unsafe.

If you launch a script as part of post-iBot processing, this antivirus feature may cause unexpected 
results. If you are running antivirus software with a script-blocking feature on the machine where 
Oracle BI Scheduler is installed, you should disable the script-blocking feature to prevent the 
software from unexpectedly blocking iBot script calls.

Viewing Entries in the Delivers iBot Log 
Directory
If an iBot fails to execute fully or if debugging is turned on in Oracle BI Scheduler, a log file is 
generated for the iBot.

The location for iBot log files is specified on the iBots tab of the Job Manager Configuration dialog 
box in Oracle BI Scheduler. The default location is the Log directory in the Oracle Business 
Intelligence installation directory on the machine where Scheduler is installed.

The log file name has the following format:

NQiBot-JobID-InstanceID.xxx

where:

NQibot The preface for all iBot log files.

JobID The Scheduler job ID for the iBot.

InstanceID The Scheduler instance ID for the iBot.
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The iBot error and debug log files are written as separate files for each iBot instance that fails to 
execute. You can use a text editor to view the files. Entries are generally self-explanatory. Exit codes 
are generic and do not indicate any particular condition.

The presence of an error log does not necessarily mean that an iBot failed completely. For example, 
suppose an iBot delivers content to multiple email addresses. If some of the addresses are invalid or 
the mail server is down, an error log is generated for the iBot.

For more information about the Oracle BI Scheduler, read Oracle Business Intelligence Scheduler 
Guide.

Disabling Delivers
Delivers is an optional component of Oracle BI Presentation Services that is enabled by default for 
organizations that have purchased the appropriate license. To disable Delivers, you can edit the 
Oracle BI Presentation Services configuration file (instanceconfig.xml) to add the following entry. The 
default value is Yes (Delivers is enabled). To disable Delivers, set this to No.

You place your entry between the <Alerts> and </Alerts> elements.

The following entry is an example:

<Alerts>
<Enabled>No</Enabled>

</Alerts>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

xxx The file extension:

■ .err for iBot error log files.

■ .log for debug log files.
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Specifying the Machine Running Oracle 
BI Scheduler
You can identify the machine on which Oracle BI Scheduler is running by editing the Oracle BI 
Presentation Services configuration file (instanceconfig.xml) to edit the ScheduleServer entry. By 
default, if Oracle BI Scheduler is running on the local machine, then this entry is populated with the 
name of the local machine. If the Oracle BI Scheduler is not running on standard port 9705, then 
you need to specify the value for the ScheduleServer entry in the form IP_ADDRESS:PORT_NUMBER.

The following entry is an example:

<Alerts>
<ScheduleServer>Server02</ScheduleServer>

</Alerts>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

For more information about how the ScheduleServer element is set, see the Oracle Business 
Intelligence Infrastructure Installation and Configuration Guide and the Oracle Business Intelligence 
Enterprise Edition Deployment Guide.

NOTE: If you are migrating an Oracle Business Intelligence environment to a new system, then 
ensure that you also migrate the Oracle Business Intelligence repository file and the Scheduler 
tables. The Scheduler tables are required for iBots.

Changing the Directory in Which 
Delivers iBot Deliveries Are Stored
You can specify the directory in which iBot deliveries are stored by editing the Oracle BI Presentation 
Services configuration file (instanceconfig.xml) to add the following entry. The deliveries directory 
is, by default, stored in the same location as the Presentation Catalog. (The value described in 
“Changing the Name and Location of the Presentation Catalog” on page 96 defines where the 
Presentation Catalog is stored.) At startup, Oracle BI Presentation Services attempts to create the 
deliveries directory.

You need to create the elements <Web> and </Web> after the <ServerInstance> element, and 
place your entries between the <Web> and </Web> elements.

The following entry is an example:

<PersistentStorageDirectory>/usr/local/OracleBIData/web/catalog/TestDelivery</
PersistentStorageDirectory>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.
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Integrating Delivers with Oracle’s Siebel 
Workflow
You can use the Advanced tab in Delivers to set up iBots to trigger workflows in Oracle’s Siebel 
Workflow application. The procedures to configure this capability are given in Oracle Business 
Intelligence Scheduler Guide.

By default, only Oracle Business Intelligence administrators have the necessary privileges to set up 
iBots to trigger workflows.

For information about the Advanced tab in Delivers, read Oracle Business Intelligence Answers, 
Delivers, and Interactive Dashboards User Guide.

Using Delivers to Seed the Oracle BI 
Server Cache
You can use the Destinations tab in Delivers to set up iBots to seed the Oracle BI Server cache. 
Seeding the cache can improve response times for users when they run requests in Answers or view 
requests that are embedded on their dashboards. Do this by scheduling iBots to execute requests 
that refresh this data.

For more information about Oracle BI Server cache, read Oracle Business Intelligence Server 
Administration Guide.

For information about the Destinations tab in Delivers, read Oracle Business Intelligence Answers, 
Delivers, and Interactive Dashboards User Guide.

About Permission Settings for Delivers 
and iBots
The permission settings for Delivers and iBots are available in the Delivers section on the Privilege 
Administration screen in Oracle BI Presentation Services Administration.

In addition, if you want to allow users who are granted access to the Publish iBots for subscription 
privilege to change or delete an iBot, you need to grant them the Change/Delete permission to the 
shared iBots object and child objects in the Oracle BI Presentation Catalog.

You can grant the Change/Delete permission by using the Manage Catalog feature. For information 
about using the Manage Catalog feature, read “Administering Items in the Presentation Catalog” on 
page 110.
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Managing Device Types for Delivers
Delivers makes use of different device types from such device categories as mobile phones and 
pagers to deliver the content of iBots to users. You can view, create, edit, and delete device types 
for a device category supported by Delivers. 

NOTE: You can only view system-seeded device types (such as AT&T Wireless); you cannot edit or 
delete them.

The capability to manage device types is available to users who have the Manage Device Types 
privilege. By default, this privilege is granted to Oracle Business Intelligence administrators. For 
more information on setting privileges, see “Setting Privileges in Oracle BI Presentation Services 
Administration” on page 152.

To view a device type

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Device Types link.

4 Click the View icon (or the Edit icon for user-created devices) for the device type that you want 
to view.

To create a device type

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Device Types link.

4 Click the Create New Device Type link.

5 Enter a name in the Device Type Name field.

6 Select the appropriate category for the device type from the Category drop-down list. 

7 Enter the details for the device type in the Domain field.

For example, the email extension of the service provider (e.g. pagenet.net).

8 Do not clear the Buffer Size check box unless you have a specific buffer size that you want to 
specify.

9 Click Create Device Type to return to the Manage Device Types screen.

The device appears in the Device Type Name list. 

On creation, this device type will be available for selection (in the Device / Provider drop-down 
list) when users configure delivery options. For more information, see Oracle Business 
Intelligence Answers, Delivers, and Interactive Dashboards User Guide.
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To edit a device type

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Device Types link.

4 Click the Edit icon for the device type that you want to edit.

5 Update the details as required.

6 Click Update Device Type to return to the Manage Device Types screen.

To delete a device type

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Device Types link.

4 Click the Delete icon for the device type that you want to delete.

The Confirm Device Type Deletion screen appears. 

5 Click Yes to confirm the deletion and to return to the Manage Device Types screen.

About the SA System Subject Area and 
Scheduling iBot Deliveries
This section applies only to organizations using Oracle’s Siebel operational applications.

When the SA System subject area is being used, iBot deliveries cannot be made to user IDs that are 
defined only in the Oracle Business Intelligence repository. Such internally defined user IDs include 
the Administrator user ID.

The SA System subject must return rows for any acceptable user of Oracle Business Intelligence. In 
all Oracle’s Siebel operational applications, the Administrator user ID is not defined in the Siebel 
OLTP, and therefore is not returned from queries to the SA System subject area. You should test 
alerts with a valid Siebel OLTP user.

For more information about the SA System subject area, see Oracle Business Intelligence Server 
Administration Guide.
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Setting the Case of Logon Names for the 
SA System Subject Areal
When the SA System subject area is used, logon names are compared to the Logon column in the 
SA System subject area. By default, this comparison is case sensitive. This means, for example, that 
a login of “Fred” will not match an SA System subject area entry of “fred.” If your authentication 
method is case sensitive, this works fine because the login “fred,” accepted at login, matches “fred” 
in the Logon column in the SA System subject area. However, if your authentication method is case 
insensitive, then you need the SA System subject area comparison also to be case insensitive. 

You can make the SA System subject area comparison case insensitive by:

■ Ensuring that your SA System subject area stores all logon names in uppercase

■ Setting the UpperCaseRecipientNames element to true so that logon names are converted to 
uppercase before being included in SA System subject area queries

To set the UpperCaseRecipientNames element to true, you edit the Oracle BI Presentation Services 
configuration file (instanceconfig.xml) to add the UpperCaseRecipientNames element between the 
<Alerts> and </Alerts> elements (which appear after the <ServerInstance> element) and set it to 
true.

The following entry is an example:

<ServerInstance>

.. .. ..

<Alerts>
.. .. ..

<UpperCaseRecipientNames>true</UpperCaseRecipientNames>
.. .. ..
</Alerts>

.. .. ..

</ServerInstance>

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Controlling Delivery Options for iBots
Delivery options (that is, delivery devices and delivery profiles) determine how the content of iBots 
gets delivered to users. Delivery options can be configured in the SA System subject area or by users. 
(For more information about the SA System subject area, see the Oracle Business Intelligence Server 
Administration Guide.)
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You can control the availability of the delivery options configured in the SA System subject area and 
the user-defined delivery options by adding the following elements to the Oracle BI Presentation 
Services configuration file (instanceconfig.xml):

NOTE: The SystemSubjectArea and IgnoreWebcatDeliveryProfiles elements take effect only if the SA 
System subject area is being used.

The following entry is an example:

<ServerInstance>

<SystemSubjectArea>false</SystemSubjectArea>

<Alerts>

<IgnoreWebcatDeliveryProfiles>false</IgnoreWebcatDeliveryProfiles>

</Alerts>

</ServerInstance>

Element Description

SystemSubjectArea

NOTE: These elements are placed 
after the <ServerInstance> 
element in the instanceconfig.xml 
file.

Specifies whether to recognize the delivery devices and 
deliver profiles configured in the SA System subject area:

■ True. Recognizes the delivery devices and delivery 
profiles configured in the SA System subject area and 
displays them on the My Account screen.

■ False. Ignores the delivery devices and deliver profiles 
configured in the SA System subject area and does not 
display them on the My Account screen.

The default is True.

IgnoreWebcatDeliveryProfiles

NOTE: These elements are placed 
after the <ServerInstance> 
element in the instanceconfig.xml 
file and between the <Alerts> </
Alerts> elements.

Specifies whether to ignore user-defined delivery devices 
and deliver profiles:

■ True. Ignores the user-defined delivery devices and 
deliver profiles and does not display them on the My 
Account screen. (This means that users will not be able 
to create new delivery devices and delivery profiles.)

■ False. Recognizes the user-defined delivery devices and 
delivery profiles and displays them on the My Account 
screen.

The default is False.
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Viewing Information About Active 
Delivers iBot Sessions
Using the iBot Session Management screen in Oracle BI Presentation Services Administration, you 
can view the following information about currently active iBot sessions triggered by Oracle BI 
Scheduler:

■ A list of active iBots per session

■ The recipients for each active iBot

When one or more iBot sessions are active, information about each iBot session appears, such as the 
Job ID and the Instance ID assigned to the iBot session by the Scheduler. Clicking the link in the 
Primary iBot column for an iBot session opens a popup window and navigates to the iBot session’s 
definition in Delivers.

Expanding the iBot session shows the individual iBots (one iBot, or multiple iBots if they are chained). 
The state of the iBot is one of the following:

■ Created

■ Populated

■ Conditional Request Resolved

Expanding a specific iBot in a particular session shows the recipients for the iBot and their type, such 
as the Engineering recipients defined in a group, or individual users. When the recipient is a group, 
the individual members of the group are not listed. Clicking the link in the Path column for an 
individual iBot opens a popup window and navigates to the iBot's definition in Delivers.

NOTE: When iBots are chained, the recipient list is dependent upon the parent iBot. The recipients 
are shown for the parent iBot definition only, and not for the actual execution of chained iBots.

To access the iBot Session Management screen

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage iBot Sessions link.

To view information about active iBot sessions

1 To sort iBot sessions by their values in a particular column, click the sort button for that column.

2 To view more information about an iBot session, click the expand button.

3 To view more information about iBots within a particular session, click the expand button.

4 To view the definition of an iBot session or an individual iBot in Delivers, click the link for the 
session or iBot.
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5 Administering Oracle BI 
Dashboards

End users with appropriate privileges can modify personal and shared Dashboards, including the 
addition of pages and content. End users cannot create dashboards.

You can create and manage dashboards, using the procedures in this chapter. For an introduction to 
dashboards and end-user procedures for modifying them, read Oracle Business Intelligence Answers, 
Delivers, and Interactive Dashboards User Guide and Oracle Business Intelligence Presentation 
Services Online Help.

This chapter contains the following topics:

■ About Managing Dashboards on page 77

■ Managing Dashboards on page 78

■ Creating Dashboards Action Links on page 79

■ Setting the Number of Dashboards Names to Appear on a Screen on page 81

■ Controlling Access to Saved Selection Options in Dashboards on page 82

■ Setting the Number of Oracle Business Intelligence Briefing Book Links to Follow on page 87

■ Downloading Oracle Business Intelligence Results in Non-UNICODE Format on page 87

■ Integrating Answers into Other Portals or Intranets on page 88

■ Configuring Report Write Back on page 90

NOTE: For information about specifying view defaults for dashboards, read “Specifying View Defaults 
for Answers and Dashboards Users” on page 60.

About Managing Dashboards
Before you create shared dashboards, make sure you have planned your Presentation Catalog 
directory or folder structure and security strategy. Guidelines for creating a shared dashboard, within 
the broader context of Presentation Catalog structure and security framework, are given in 
“Guidelines for Configuring Oracle BI Presentation Services Security for the Presentation Catalog and 
Dashboards” on page 161.

For more information about shared folder structures in the Presentation Catalog read Chapter 6, 
“Administering the Oracle BI Presentation Catalog.”

For more information about permissions, read Chapter 8, “Managing Oracle BI Presentation Services 
Security.”

Overall, to create a shared dashboard, you first create the dashboard and then add content using 
the Dashboard Editor. You can also assign Presentation Services group permissions to access the 
dashboard. Users who are members of more than one Presentation Services group can select the 
dashboard they display by default from all of the dashboards to which they have permissions. 



Oracle Business Intelligence Presentation Services Administration Guide 
Version 10.1.3.2

Administering Oracle BI Dashboards ■ Managing Dashboards

78 

You can also authorize users to act for others, which allows them to access the other users’ 
dashboards. For more information, see “About Authorizing Users to Act for Others” on page 167.

This section describes, from an administrator’s perspective, how to create and delete dashboards, 
and add sections. For more information about adding pages, sections, and content from an end-
user’s perspective, read Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards 
User Guide.

Managing Dashboards
Using the Manage Dashboards screen in Oracle BI Presentation Services Administration, you can:

■ Access the Create Dashboard screen to create a new dashboard

■ Access the Dashboard Properties screen to change the properties of a dashboard

■ Access the Change Item Permissions screen to change the permissions for a dashboard

■ Delete a dashboard

To access the Manage Dashboards screen

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Interactive Dashboards link.

To access the Create Dashboard screen and create a new dashboard

1 Click the Create Dashboard button to display the Create Dashboard screen.

2 Specify entries for the following fields:

a From the drop-down list, select the appropriate Group Folder.

The members of this Presentation Services group (and other groups and users with 
appropriate permissions) will have Read access to the shared dashboard.

b In the Dashboard Name field, type a name for the dashboard.

c In the Dashboard Builder field, type the name of the user or Presentation Services group that 
can make changes to the dashboard.

3 Click Finished to return to the Manage Dashboards screen.

4 Click Finished.

5 Click Close Window.

6 In Answers, click the Dashboards tab in the selection pane, and then click the Refresh Display 
link near the bottom of the selection pane.

The newly created dashboard appears in the list of dashboards.
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7 In Dashboards, navigate to the dashboard and click Page Options > Edit Dashboard.

The Dashboard Editor screen opens, where you can add content to the dashboard. For 
information, see the Oracle Business Intelligence Presentation Services Online Help.

To access the Dashboard Properties screen
■ Locate the dashboard whose properties you want to change and click the associated 

Properties icon. For information on how to change dashboard properties, see the Oracle 
Business Intelligence Presentation Services Online Help. 

To access the Change Item Permissions screen
■ Locate the dashboard whose permissions you want to change and click the associated 

Permissions icon. For information on how to change permissions, see the Oracle Business 
Intelligence Presentation Services Online Help.

To delete a dashboard

1 Locate the dashboard that you want to delete and click the associated Delete icon.

The Confirm Deletion screen appears.

2 Click Yes.

3 Click Finished.

Creating Dashboards Action Links
To provide a link for end users to navigate from their dashboards to a record in a Siebel operational 
application, use an action link. Oracle Business Intelligence applications contain prebuilt action links 
in requests and dashboards. For example, a user can drill down directly from an Oracle Sales 
Analytics dashboard to a specific record in an Oracle’s Siebel Sales view. Drilldown is based on the 
row identifier column contained in a request.

NOTE: End users must have the appropriate permissions and responsibilities to access the view, and 
any drilldown links. Also, the host name for the Web server (or Virtual IP) serving content from the 
Siebel application server must match that for Oracle BI Presentation Services, because the JavaScript 
Security model prevents a script on one server from affecting another.

When running the Oracle Business Intelligence infrastructure, there is no connection to a Siebel 
operational application. Therefore, you cannot create a new action link nor access a predefined action 
link. The Action Links command in the Navigate drop-down menu is visible only when the user is 
logged into the integrated application.

If a request is added to a dashboard as a link and set to open in a new window, then action links 
contained in that request will no longer navigate to the Siebel operation application. 
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To create an action link

1 Identify the target Siebel operational application view.

2 Select the Siebel operational application view or applet that to drill down to, and select Help > 
About View.

A pop-up window shows the names of the view and applet. Note the view and list applet names. 
You need these names in Step 7.

3 Using a Subject Area that is appropriate for the target applet, use Answers to create a new Oracle 
Business Intelligence request with the row identifier column in it, for example, Account_Row_ID.

4 Click the Properties button for the column.

The Column Properties dialog appears.

5 Click the Column Format tab.

6 In the Value Interaction field, set the Type drop-down menu to Action Link.

7 Fill in the fields using the following table as a guide.

8 Click OK, and then view the request on the dashboard.

After the request is saved and placed on a dashboard, the row identifier column contains an action 
link to the Siebel operational application.

Field Name Description

View Enter the name of the view as determined in Step 2.

Applet Enter the name of the applet as determined in Step 2.

Show Action Link Icon Select this check box to include Action Link icons in the resulting 
report.

Pass value from Set this drop-down menu to the ROW_ID field in your query.

In Step 4, if you had clicked the Column Properties button on the 
ROW_ID field, then choose This Column from the drop-down menu. 
If you had clicked the Column Properties button on a different field, 
then choose ROW_ID instead.
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Setting the Number of Dashboards 
Names to Appear on a Screen
Oracle Business Intelligence typically displays the names of individual dashboards across the top of 
the screen. To minimize the amount of screen space used for this, when there are more than 15 
dashboard names to display, Oracle Business Intelligence creates a drop-down list from which users 
can choose the dashboard to view. A drop-down list shows individual dashboards as grouped under 
the name of the folder that contains them, and replaces the dashboard names at the top of the screen 
with that folder name. Together with the entry described in this section, you can create and 
manipulate folders containing dashboards within the Presentation Catalog to create the desired 
dashboard presentation.

You can change the number of dashboard names to show before a drop-down list appears by 
modifying the Oracle BI Presentation Services configuration file (instanceconfig.xml) to add the 
following entry. The minimum value is 1.

NOTE: This entry takes effect for all folders that contain dashboards if any folder contains more than 
the value you specify. For example, if dashboard folder A contains 8 dashboards and dashboard folder 
B contains 11 dashboards, and you specify a value of 10, drop-down lists will appear for both folders.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

The following entry is an example:

<DashboardMaxBeforeMenu>10</DashboardMaxBeforeMenu>
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Controlling Access to Saved Selection 
Options in Dashboards
This section provides an overview of saved selections and information about administering saved 
selections. It contains the following topics:

■ “Overview of Saved Selections in Dashboards” on page 82

■ “Administering Saved Selections” on page 82

■ “Table of Permission and Privilege Settings for Creating Saved Selections” on page 85

■ “Example Usage Scenario for Saved Selection Administration” on page 86

Overview of Saved Selections in Dashboards
In Dashboards, saved selections allow users to view dashboard pages with their most frequently used 
or favorite choices for filters and prompts, without the need to make choices manually for all of the 
prompts and filters that appear on the dashboard page.

Users and groups with the appropriate permissions and dashboard access rights can perform the 
following activities:

■ Save various combinations of choices for filters and prompts as saved selections, for their 
personal use or use by others.

■ Specify a saved selection as the default selection for a dashboard page, for their personal use or 
use by others.

■ Switch between their saved selections.

You can restrict this behavior in the following ways:

■ Users can view only the saved selections assigned to them.

■ Users can save selections for personal use only.

■ Users can save selections for personal use and for use by others.

NOTE: For information about end user use of saved selections, read the section about creating and 
assigning personal and shared saved selections for a dashboard page in Oracle Business Intelligence 
Answers, Delivers, and Interactive Dashboards User Guide.

Administering Saved Selections
This section describes the privileges and permissions required to administer saved selections. It also 
describes the relevant portions of the Presentation Catalog related to storing and administering 
saved selections.
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Privileges for Saved Selections
In Oracle BI Presentation Services Administration, the following privileges in the Dashboards area, 
together with permission settings for key dashboard elements, control whether users or groups can 
save or assign selections:

■ Save Selections

■ Assign Default Selections

You can set neither privilege, one privilege, or both privileges for a user or group, depending on the 
level of access desired. For example, a user who has neither privilege can view only the saved 
selection assigned as his or her default selection.

Permissions for Saved Selections
This section describes the permissions required for dashboard pages to administer saved selections, 
and the relevant portions of the Presentation Catalog structure for setting permissions on shared and 
personal saved selections.

Assigning Permissions to Dashboards
Permissions for dashboards, such as Read or Change/Delete, are set at the Manage Dashboards 
screen, available by clicking the link Manage Interactive Dashboards at the Oracle Business 
Intelligence Administration screen. The pages on the dashboard inherit the permissions set for a user 
or group.

Assigning Permissions for Saved Selections on a Dashboard Page
Permissions for assigning saved selections on a particular dashboard page are set at the Dashboard 
Properties screen, available by clicking the Dashboard Properties button in the Dashboard Editor.

When selection security is enabled at the Dashboard Properties screen by clicking the Enabled link, 
two buttons appear in the Selection Security column:

■ The left button controls who can save shared selections for that dashboard page.

■ The right button controls who can assign default selections for that dashboard page.

Clicking each button navigates to the appropriate location in the Presentation Catalog for that object. 
Presentation Catalog objects and permissions scenarios are described in more detail in the sections 
that follow.

Presentation Catalog Folder Structure for Saved Selections
In addition to the privileges set in Oracle Business Intelligence Administration, the level of control 
that users and groups have over saved selections depends on their access rights to key elements. 
For example, users and groups that can create and edit underlying dashboards, save dashboard view 
preferences as selections, and assign selections to other users as default selections require Full 
Control permission to the key elements in shared storage, while users and groups that can view only 
their assigned default saved selections need only Read access to the key elements in shared storage.

Key elements in the Presentation Catalog include the following folders:
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■ Shared Storage Folders.

Shared storage folders for dashboards are located within the _portal folder. Dashboards are 
identified by their assigned names.

Permission settings control access to a specific dashboard for editing. Typically, if permissions 
are inherited down to the _selections and _defaults folders, users who can edit dashboards are 
also able to save selections and set defaults. Access to a specific dashboard folder controls 
whether a user or group can edit the dashboard.

The _selections folder within a dashboard folder contains a page identifier folder for each 
dashboard page. Shared saved selections are located within this folder. Access to the page 
identifier folder controls whether a user or group can display, save or edit selections for that 
page.

The _defaults folder within a _selections folder contains assigned default selections. Each group 
that has an assigned default appears here. Access to this folder controls whether a user or group 
can assign defaults.

■ Personal Storage Folders.

Within a user’s personal folder, the _selections folder contains an individual user’s saved 
selections. Like the shared _selections folder, a personal _selections folder contains a page 
identifier folder for each dashboard page. The page identifier folder contains personal saved 
selections and a _defaultlink file that specifies a user’s preference for the personal defaulted 
selection.

A personal saved selection default overrides an assigned shared selection default.

NOTE: If a dashboard page with saved selections is removed from the system, the saved selections 
are also removed from the Presentation Catalog. If the underlying dashboard structure changes such 
that a saved selection is no longer valid when a user accesses it, the default content appears on the 
dashboard.
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Table of Permission and Privilege Settings for Creating 
Saved Selections
Table 11 describes typical user roles and specific permission settings that can be granted to users for 
creating saved selections. The folder names listed in the Permission and Privilege Settings column 
are described in the preceding section.

Table 11. User Roles and Permission Settings for Saved Selections

User Role Permission and Privilege Settings

Power users such as IT users who need to 
perform the following tasks:

■ Create and edit underlying dashboards.

■ Save dashboard view preferences as 
selections.

■ Assign selections to other users as default 
selections.

In the Shared section of the Presentation 
Catalog, requires Full Control permission to the 
following folders:

■ dashboard_name.

■ _selections.

■ _defaults.

Typically, no additional privileges need to be 
assigned.

Technical users such as managers who need to 
perform the following tasks:

■ Save selections as selections for personal 
use.

■ Save selections for use by others.

Users cannot create or edit underlying 
dashboards, or assign view selections to others 
as default selections.

In the Shared section of the Presentation 
Catalog, requires Read permission to the 
following folders:

■ dashboard_name.

In the Shared section of the Presentation 
Catalog, requires Write permission to the 
following folders:

■ _selections.

■ _defaults.

Typically, no additional privileges need to be 
assigned.
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Example Usage Scenario for Saved Selection 
Administration
Depending on privileges set and permissions granted, you can achieve various combinations of user 
and group rights for creating, assigning, and using saved selections.

For example, suppose a group of power users cannot change dashboards in a production 
environment but are allowed to create saved selections and assign them to other users as default 
selections. The following permission settings for the group are required:

■ Read access to the dashboard, using the Manage Dashboards screen.

■ Change/Delete access to the _selections and _defaults subfolders within the dashboard folder in 
the Presentation Catalog, assigned using the Dashboard Properties screen accessible from the 
Dashboard Editor.

Everyday users who need to save selections for 
personal use only.

In Oracle BI Presentation Services 
Administration, requires the following privilege 
to be set:

■ Save Selections.

In the dashboard page, requires that the 
following option is set:

■ Allow Saved Selections.

In the Presentation Catalog, no additional 
permission settings are typically required.

Casual users who need to view only their 
assigned default selection.

In the Shared section of the Presentation 
Catalog, the user needs Read permission to the 
following folders:

■ dashboard_name.

■ _selections.

■ _defaults.

In the Presentation Catalog, no additional 
permission settings are typically required.

Table 11. User Roles and Permission Settings for Saved Selections

User Role Permission and Privilege Settings
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Setting the Number of Oracle Business 
Intelligence Briefing Book Links to 
Follow
A Briefing Book navigation link is a special type of link that can be added to a dashboard using the 
Dashboard Editor. The default value for the maximum number of links to follow is 5.

You can change the default by modifying the Oracle BI Presentation Services configuration file 
(instanceconfig.xml) to add the following entry. The minimum value is 1. The maximum value is 10.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

The following entry is an example:

<MaxFollowLinks>10</MaxFollowLinks>

Downloading Oracle Business 
Intelligence Results in Non-UNICODE 
Format
Oracle Business Intelligence provides options for downloading results that appear in Answers as 
options for the Download link. The Download link can also appear with a request in a dashboard.

By default, the Download Data option downloads results in a UNICODE, tab-separated text file. For 
organizations that require a non-UNICODE, comma-separated file for use with certain applications, 
you can override behavior of the Download Data option or add another download option by modifying 
the message kmsgEVCDownloadLinks in the XML messages file viewscontrolmessages.xml.

If you change the behavior of the Download Data option or add a new option that retrieves comma-
separated data, the entry in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml) described in this section is used to determine the character set to use. You can 
view supported character sets by examining the message file charactersetdefinitions.xml located in 
the SADATADIR\web\config directory, where SADATADIR is the data directory.

For example, adding the following XML code to the message kmsgEVCDownloadLinks in the file 
viewscontrolmessages.xml file adds the option Download CSV to the Download link:

<a class="NQWMenuItem" name="SectionElements"
href="javascript:void(null);" onclick="NQWClearActiveMenu();
Download('@{command}&amp;Format=csv&amp;Extension=.csv')">Download CSV</a>

The Download CSV option downloads a comma-separated file that uses the following entry to 
determine the character set.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.
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The following entry is an example:

<CSVCharset>us-ascii</CSVCharset>

For information about making changes to the XML messages files, read “Customizing the Oracle BI 
Presentation Services User Interface Using XML Message Files” on page 192.

Integrating Answers into Other Portals 
or Intranets
The following customization settings are available for integrating Answers into other portals and 
intranets without requiring the use of Dashboards. These settings are configured in the XML message 
files.

You can perform the following actions:

■ Change the text of the Dashboards link.

■ Change the URL to which users are directed when they click that link.

NOTE: Make sure that you first review the information in “Customizing the Oracle BI Presentation 
Services User Interface Using XML Message Files” on page 192 before making any integration changes.

To change the text of the dashboards link

1 Navigate to the file uimessages.xml.

This file is located in the folder SAROOTDIR\web\msgdb\l_xx\messages, where SAROOTDIR is 
the installation directory, where xx is the language identifier of the selected locale.

CAUTION: Always make a backup copy of the file uimessages.xml before you make any 
changes.

2 Use a text editor to open the file uimessages.xml.

3 Locate the message “kmsgUIPortal.”

The message has the following form:

<WebMessage name="kmsgUIPortal">

<TEXT>Dashboards</TEXT>

</WebMessage>

The default text is Dashboards.

4 Change the default text to text of your choosing.

For example, to change the text to be your company’s intranet, you might change it to the 
following:

<WebMessage name="kmsgUIPortal"> 

<TEXT>Intranet</TEXT> 
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</WebMessage>

5 Save the file when you are done.

Your changes take effect when the service for Oracle BI Presentation Services is restarted.

To change the destination of the dashboards link

1 Navigate to the file controlmessages.xml.

This file is located in the folder SAROOTDIR\web\msgdb\l_xx\messages, where SAROOTDIR is 
the installation directory and where xx is the language identifier of the selected locale.

CAUTION: Always make a backup copy of the file ControlMessages.xml before you make any 
changes.

2 Use a text editor to open the file ControlMessages.xml.

3 Locate the message “kmsgPortalLink.”

The message has the following form:

<WebMessage name="kmsgPortalLink">

<HTML>

<A insert="1">

<MessageRef name="kmsgUIPortal" /> 

</A>

</HTML>

</WebMessage>

The default location is Dashboards (indicated by the reference to insert=“1”, which is an internal 
reference).

4 Change the default location to a location of your choosing.

NOTE: If no location is specified, no link appears in Answers.

For example, to change this to your company’s intranet, you can include the appropriate 
attributes and change it to point to that location instead:

<WebMessage name="kmsgPortalLink">

<HTML>

<A href="http://intranet" target="_top" title="Click here for your intranet">

<MessageRef name="kmsgUIPortal" /> 

</A>

</HTML>

</WebMessage>
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5 Save the file when you are done.

Your changes take effect when the service for Oracle BI Presentation Services is restarted.

For more information about controlling the default appearance and behavior of the Oracle BI 
Presentation Services user interface, read “Customizing the Oracle BI Presentation Services User 
Interface Using XML Message Files” on page 192.

Configuring Report Write Back
Write Back is the ability to enter values directly into a report and have those values used in 
calculations and charts in the report. For example, a report can have Sales Quota Amount defined 
as a write back field, Sales Amount as a field from the data warehouse, and Percentage of Quota as 
a calculated field (Sales Amount/Sales Quota Amount). When viewing the report you can change the 
Sales Quota Amount and the Percentage of Quota field recalculates appropriately.

The following topics describe the write back feature:

■ Write Back Configuration Tasks on page 90

■ How Write Back Works on page 91

■ Creating a Write Back Template on page 92

■ Example: Write Back Template on page 93

■ Write Back Limitations on page 93

Write Back Configuration Tasks
The process of configuring write back fields consists of the following tasks. You need to customize 
these tasks for your specific implementation:

1 Assess the reporting needs in your organization and make a list of write back fields needed and 
the reports in which they should appear.

2 Create a physical table in your database that has a column for each write back field needed. In 
the table create statement, Oracle recommends that you make the write back fields non-null-
able.

NOTE: For optimum security, store write-back database tables in a unique database instance.

3 Using the Administration Tool, configure the new table:

a Map the physical table into the logical model so that the logical fact columns are exposed and 
aggregate properly in the appropriate dimensions.

b Disable the Make Table Cacheable property for the write back table in the Physical Table window. 
This ensures that data written back to the database is displayed to the user, and not a cached 
value.

c Enable write back for the connection pool.
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d Set up the content filters so users can only access records appropriate to their position. For 
example, sales representatives can view only their own records, but the sales managers can view 
records for their direct reports.

For more information on the specific procedures, read Oracle Business Intelligence Server 
Administration Guide.

4 Create a write back template that specifies the SQL necessary to both insert and update values 
into the table you created. For more information, read “Creating a Write Back Template” on 
page 92.

5 In Oracle BI Presentation Services, grant write back privileges:

a For administrators and report writers, enable the Manage Write Back privilege. This action 
enables the Write Back properties window in Answers and enables the Write Back interaction 
type for columns.

b For administrators, report writers, and selected users, enable the Write Back to Database 
privilege. This action enables the user interface controls for write back (fields being editable 
and the presence of the write back button), and enables the server call that writes data back 
to the database.

For more information on granting privileges, read “Setting Privileges in Oracle BI Presentation 
Services Administration” on page 152.

6 In Answers, configure write back reports:

a Create a report that contains a table view that uses the new columns.

b In the report, for each new column, edit the column format. Set the Column Interactions field to 
Write Back.

c If necessary, set key columns to be Hidden Keys in the column format dialog.

d Edit the Table View properties, enabling the write back feature, and specifying the name of the 
write back template, and the text for the write back button.

e Save the report.

f Embed the report in a dashboard page.

For more information on creating reports, read Oracle Business Intelligence Answers, Delivers, 
and Interactive Dashboards User Guide.

How Write Back Works
If a user has the Write Back to Database privilege, then the write back fields in their reports display 
as editable fields. If the user does not have this privilege, then the write back fields display as normal 
fields. If the user types a value in an editable field and clicks the write back button, then the 
application reads the write back template to get the appropriate insert or update SQL command. It 
then issues the insert or update command. If the command succeeds, it reads the record and updates 
the report. If there is an error in either reading the template or in executing the SQL command, an 
error message appears.

The insert command runs when a record does not yet exist and the user enters new data into the 
table. In this case, a user has typed in a table record whose value was originally null.
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The update command runs when a user modifies existing data. To display a record that does not yet 
exist in the physical table to which a user is writing back, you can create another similar table. Use 
this similar table to display placeholder records that a user can modify in Oracle BI Dashboards.

Creating a Write Back Template
The write back template is an XML-formatted file that contains SQL commands needed to insert and 
update records in the write back table and columns you have created. You can create multiple write 
back templates, customizing each one for the fields used in each specific report. In the report 
properties you specify the name of the write back template to use. 

The write back template must meet the following requirements:

■ To meet security requirements, you must specify the connection pool along with the SQL 
commands to insert and update records. This SQL references the values passed in the write back 
schema to generate the SQL statements to modify the database table. Values can be referenced 
either by position (such as @1, @3) or by column ID (@{c0}, @{c2}). Column positions start 
numbering with 1, whereas column IDs start with c0. The use of Column ID is preferred.

NOTE: The notation @n is not the same as @{cn-1}, because the column with ID cn-1 may not 
be the nth column in the table.

■ You must include both an <insert> and an <update> element in the template. If you do not want 
to include SQL commands within the elements, then you must insert a blank space between the 
opening and closing tags. For example, you must enter the element as

<insert> </insert>

rather than

<insert></insert>

If you omit the blank space, then you will see a write back error message such as “The system 
is unable to read the Write Back Template ‘my_template’”.

■ If a parameter's data type is not an integer or real number, then add single quotes around it. If 
the database does not do Commits automatically, then add the optional postUpdate node after 
the insert and update nodes to force the commit. The postUpdate node typically follows this 
example:

<postUpdate>COMMIT</postUpdate>

■ Store the write back template files in the CustomMessages folder. The system can have multiple 
CustomMessages folders, such as SAROOTDIR\web\msgdb\customMessages, where SAROOTDIR is 
the installation directory. For information, see “Customizing the Oracle BI Presentation Services 
User Interface Using XML Message Files” on page 192.
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■ The write back template files can have any name of your choosing, because the system reads all 
XML files in the CustomMessages folder. To ensure that write back works correctly, include in the 
WebMessage element of the file the name of the SQL template that you specified when you 
created the write back table. You can have multiple WebMessage elements in one file, with each 
element specifying one SQL template.

The following example shows the specification of the SQL template that is called 
“SetQuotaUseID.”

<WebMessage name="SetQuotaUseID">

Example: Write Back Template
A write back template might resemble this example:

<?xml version="1.0" encoding="utf-8" ?>
<WebMessageTables xmlns:sawm="com.siebel.analytics.web/message/v1">
<WebMessageTable lang="en-us" system="WriteBack" table="Messages">

<WebMessage name="SetQuotaUseID">
<XML>

<writeBack connectionPool="Supplier">
<insert>INSERT INTO regiontypequota 

VALUES(@{c0},@{c1},'@{c2}','@{c3}',@{c4})</insert>
<update>UPDATE regiontypequota SET Dollars=@{c4} WHERE YR=@{c0} AND 

Quarter=@{c1} AND Region='@{c2}' AND ItemType='@{c3}'</update>
</writeBack>

</XML>
</WebMessage>

<WebMessage name="SetQuota">
<XML>

<writeBack connectionPool="Supplier">
<insert>INSERT INTO regiontypequota VALUES(@1,@2,'@3','@4',@5)</insert>
<update>UPDATE regiontypequota SET Dollars=@5 WHERE YR=@1 AND Quarter=@2 

AND Region='@3' AND ItemType='@4'</update>
</writeBack>

</XML>
</WebMessage>

</WebMessageTable>
</WebMessageTables>

Write Back Limitations
Observe the following limitations for the write back feature:

■ The write back abilities are for Table View only. Other views including chart, gauge, and pivot can 
be displayed but do not have edit fields for changing values.
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■ All values in write back columns are editable. When displayed in nonprinter friendly context, 
editable fields appear as if the user has Write Back privilege. However, when a logical column is 
mapped to a physical column that can change, the logical column returns values for multiple level 
intersections. This scenario can cause problems.

■ Any field in a report can be flagged as a write back field, even if it is not derived from the write 
back table that you created. The responsibility for correctly tagging fields lies with the creator of 
the report.

■ Write back reports do not support drill-down.

■ The user interface does only minimal validation of data input. If the field is numeric and the user 
enters text data, then the user interface detects that and prevents the invalid data from going 
to the database. However, it does not detect other forms of invalid data input (values out of 
range, mixed text and numeric, and so on). When the user clicks the write back button and an 
insert or update is executed, invalid data results in an error message from the database. The 
user can then correct the faulty input. Report authors can include text in the write back report 
to aid the user, for example, “Entering mixed alphanumeric values into a numeric data field is 
not allowed.”

■ A template can contain SQL statements other than insert and update. The write back function 
passes these statements to the database. However, Oracle does not support or recommend the 
use of any statements other than insert or update.

■ The write back feature is not suitable for entering arbitrary new records. In other words, do not 
use it as a data input tool.

■ Numeric columns must contain numbers only. They should not contain any data formatting 
characters such as dollar signs ($), octothorpes (#), percent signs (%), and so on.

■ Text columns should contain string data only.

CAUTION: This feature takes user input and writes it directly to the database. The security of your 
physical database is your own responsibility. For optimum security, store write-back database tables 
in a unique database instance.
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6 Administering the Oracle BI 
Presentation Catalog 

This chapter describes how to administer the Oracle BI Presentation Catalog and provides 
information about basic maintenance procedures. 

You also can use Oracle Business Intelligence Catalog Manager to manage the Presentation Catalog. 
For more information on Catalog Manager, see Chapter 7, “Managing Presentation Catalogs Using 
Oracle BI Catalog Manager.”

This chapter contains the following topics:

■ About the Presentation Catalog on page 95

■ Changing the Name and Location of the Presentation Catalog on page 96

■ Configuring the Presentation Catalog for More Than 4000 Users on page 97

■ Managing the Presentation Catalog Cache in Environments Running Multiple Instances of Oracle BI 
Presentation Services on page 97

■ Creating a New Presentation Catalog on page 97

■ Moving a Presentation Catalog to Another Installation on page 98

■ Committing an Object to Production on page 98

■ Replicating Presentation Catalogs on page 99

■ Archiving a Presentation Catalog on page 109

■ Administering Items in the Presentation Catalog on page 110

About the Presentation Catalog
The Presentation Catalog stores the content that users create in Answers and Dashboards. This 
content, which includes items such as folders, links, and objects (that is, requests, filters, prompts, 
dashboards, and so on), is stored in a directory structure of individual files. 

NOTE: Oracle Business Intelligence Publisher reports are not saved in the Presentation Catalog. For 
more information about Oracle BI Publisher, see Oracle Business Intelligence Publisher User's Guide.

Each object is stored in its own .xml file. For example, a request created in Answers called Report 1 
would be stored in a file named Report1.xml. 

Each item has a corresponding attributes file. For example, the request called Report 1 would have 
a corresponding attributes file named report1.atr. 
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The attributes file contains the item’s full name, access control list (ACL), description, and so on.

NOTE: To guarantee that only one writer can write to a file at one time, a lock file is created when 
an item is being written to. On rare occasions (for example, after a power outage), temporary lock 
files in the Presentation Catalog may not get cleaned up completely. If Oracle BI Presentation 
Services reports of such a lock file, you will need to delete it manually. 

On installation of the Oracle Business Intelligence infrastructure, you are provided with a 
Presentation Catalog directory named default.

The following locations are the default locations for the Presentation Catalog directory:

■ In Windows

SADATADIR\web\catalog

where SADATADIR is the data directory. The default data directory is C:\OracleBIData. Your data 
directory may be different.

■ In UNIX

SADATADIR/web/catalog

where SADATADIR is the data directory. The default data directory is /usr/local/OracleBIData. 
Your data directory may be different.

NOTE: In previous releases of Oracle BI Presentation Services, the Presentation Catalog (formerly 
known as the Siebel Analytics Web Catalog) was stored in a single file rather than in a directory 
structure of individual files. If you have a previous version of the Presentation Catalog, you will need 
to convert it to the new format. Also, because the Presentation Catalog is stored in a directory 
structure of individual files rather than a single file, automatic backups that were done in previous 
releases are no longer necessary; instead you can use the strategy your site has in place for file 
system backup. For more information on how to convert the Presentation Catalog to the new format, 
see the Oracle Business Intelligence Infrastructure Upgrade Guide.

Changing the Name and Location of the 
Presentation Catalog
If you move the Presentation Catalog or change its name, you need to update the Oracle BI 
Presentation Services configuration file (instanceconfig.xml) to specify the new location or name.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

The following entry is an example:

<CatalogPath>/usr/local/OracleBIData/web/catalog/default</CatalogPath>
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Configuring the Presentation Catalog for 
More Than 4000 Users
If you have more than 4000 Presentation Catalog users or you intend to have more than 4000 
Presentation Catalog users in the future, you need to turn on the hashing of users’ home directories 
to take care of a file system limitation. To do so, you set the HashUserHomeDirectories element in 
the Oracle BI Presentation Services configuration file (instanceconfig.xml) to 2. When this element 
is turned on, for example, the default name for user Steve's home directory would become /users/
st/steve.

The following entry is an example:

<Catalog>

<HashUserHomeDirectories>2</HashUserHomeDirectories>

</Catalog>

CAUTION: This element must be set immediately after installing Oracle BI Presentation Services to 
be effective.

Managing the Presentation Catalog 
Cache in Environments Running Multiple 
Instances of Oracle BI Presentation 
Services
If you are running multiple instances of Oracle BI Presentation Services (either through replication 
or clustering) you need to add the following entries in the Oracle BI Presentation Services 
configuration file (instanceconfig.xml) to manage when the Presentation Catalog cache is to be 
updated from disk:

<Catalog>

<AccountIndexRefreshSecs>120</AccountIndexRefreshSecs>
<AccountCacheTimeoutSecs>180</AccountCacheTimeoutSecs>
<PrivilegeCacheTimeoutSecs>180</PrivilegeCacheTimeoutSecs>
<CacheTimeoutSecs>120</CacheTimeoutSecs>
<CacheCleanupSecs>600</CacheCleanupSecs>

</Catalog>

Creating a New Presentation Catalog
The following procedure explains how to create a new Presentation Catalog.
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To create a new Presentation Catalog

1 Stop the service for Oracle BI Presentation Services.

NOTE: When Oracle BI Presentation Services is installed on a Microsoft IIS Web server, the IIS 
Web server creates temporary files for its Web caching capability in a location specified by the 
Microsoft IIS installation. If the Oracle BI Server is stopped before the Oracle BI Presentation 
Services, these temporary files usually remain, consuming disk space.

2 Specify a new location (one that does not exist already) for the Presentation Catalog by setting 
the CatalogPath element in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml).

For more information, read “Changing the Name and Location of the Presentation Catalog” on 
page 96.

3 Make sure that the new location for the Presentation Catalog is empty.

4 Restart the service for Oracle BI Presentation Services.

Moving a Presentation Catalog to 
Another Installation
You can move an existing Presentation Catalog to another Oracle Business Intelligence installation 
by using WinZip (on Windows) or ZIP (on UNIX) to zip it up and then unzip it on the other installation.

Before moving an existing Presentation Catalog to another installation, it is recommended that you 
stop the service for Oracle BI Presentation Services.

For information about migrating a complete Oracle Business Intelligence installation, see the 
Technical Notes section on Oracle’s Siebel SupportWeb.

Committing an Object to Production
You can commit a simple object (for example, a dashboard with privileges) to your production 
environment using the archive and unarchive functionality. 

Committing a complex object (for example, an object that includes references to external filters) is 
a more advanced process. Oracle Corporation offers advanced training courses to guide you through 
this process. It is recommended that you attend one of these courses before you attempt to commit 
a complex object to production.

Committing a simple object to production

1 Archive the object using one of the following:

■ Oracle BI Presentation Services Administration. 

For more information on how to archive in Oracle BI Presentation Services Administration, 
see “Archiving a Presentation Catalog” on page 109.
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■ Catalog Manager. 

For more information on how to archive in Catalog Manager, see “Archiving and Unarchiving a 
Presentation Catalog Using Catalog Manager” on page 132.

2 Copy the archived file to the production machine.

3 On the production machine, unarchive the object. For more information on how to unarchive an 
object, see “Archiving and Unarchiving a Presentation Catalog Using Catalog Manager” on page 132.

4 Set the permissions on the object as appropriate.

Replicating Presentation Catalogs
Oracle Business Intelligence can copy and merge contents of selected Presentation Catalog folders 
between instances of Oracle BI Presentation Services. The replication configuration can be split into 
individual tasks. The replication task is an instruction to periodically merge catalog contents for 
specified catalog folders from one server to another. Two-way replications are possible.

A typical scenario where replication is useful is when you use one instance of Oracle BI Presentation 
Services to prepare and publish shared reports, and use two or more production instances to support 
the users. In this scenario you share the catalog from Instance 1 to two production instances and 
then share the catalogs on each production instance with the other. To accomplish this, you set up 
the following replication tasks in the Oracle BI Presentation Services Replication Agent’s (sawrepaj) 
configuration file:

■ /shared: Instance1 to Instance2

■ /shared: Instance1 to Instance3

■ /users: Instance2 to Instance3

■ /users: Instance3 to Instance2

When an instance of Oracle BI Presentation Services participates in replication, either as a publisher 
or subscriber, it tracks changes made to catalog items that are marked to be replicated and keeps 
them internally in replication log files. Another instance of Oracle BI Presentation Services can make 
a SOAP call to request to export those changes to a file or to import and replay modifications 
recorded in a file exported earlier from another instance. The Oracle BI Presentation Services 
Replication Agent uses SOAP to manage replication related activities on all instances of Oracle BI 
Presentation Services and performs import and export operations. For information on the SOAP calls 
used, read Oracle Business Intelligence Web Services Guide.

About Replication Log Files
Replication log files record modifications made to catalog items that are subject to replication. There 
are two types of replication log files:

■ Change log files — Contain records of modifications to catalog items that were made locally. 
These files are stored in {presentationcatalogpath}/replication/changelog folder, where 
{presentationcatalogpath} is the full path to the Presentation Catalog folder.
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■ Playback log files — Contain records of modifications to catalog items that were replayed from 
other instances of Oracle BI Presentation Services. These files are stored in 
{presentationcatalogpath}/replication/playback folder, where {presentationcatalogpath} is the 
Presentation Catalog folder.

Replication log files are kept on disk indefinitely, until you periodically clean them out. When 
performing replication operations, Oracle BI Presentation Services reads only replication log files 
from the time interval specified by the ReadLogRecordsSinceHoursAgo element in the Oracle BI 
Presentation Services configuration file (instanceconfig.xml). For more information on the 
ReadLogRecordsSinceHoursAgo element, see“Editing the instanceconfig.xml File for Replication” on 
page 108.

While you might want to review replication log files, for example, for troubleshooting purposes, you 
should never edit log files manually.

Replication Log File Records
A replication log file contains different types of records, with each record consisting of a number of 
fields separated by commas. The most important types of records that you will see in a replication 
log file are:

■ File header record. Written at the beginning of each log file, it contains the following fields:

Size, Type, Timestamp, Version, Flags

■ Oracle BI Presentation Services startup record. Written each time Oracle BI Presentation 
Services starts up, it contains the following fields:

Size, Type, Timestamp

■ Before change record. Written when a Presentation Catalog item is about to be changed, it 
contains the following fields:

Size, Type, Timestamp, Change sequence number, Change type

■ After change record. Written immediately after a Presentation Catalog operation has been 
completed, it contains the following fields:

Size, Type, Timestamp, Change sequence number, Operation outcome

■ File finished record. Written as the last record in a replication log file, it contains the following 
fields:

Size, Type, Timestamp, Name of next log file

where:

■ Size. Record size in bytes encoded as a hexadecimal number.

■ Type. Record type, such as:

■ H. File header record

■ S. Oracle BI Presentation Services startup record

■ B. Before change record

■ A. After change Record
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■ F. File finished record

■ Timestamp. The timestamp of the record, written as a hexadecimal number representing the 
number of seconds from midnight (00:00:00), January 1, 1970 UTC.

■ Change sequence number. A sequence number that should be the same in corresponding 
Before change and After change records.

■ Change type. The type of change, written as a hexadecimal number representing a combination 
of the following flags: 

■ 1. Insert

■ 2. Delete

■ 4. Write

■ 8. Change catalog item information

■ 16. Change owner

■ 32. Change security

■ Operation outcome. The operation result, either:

■ 0. Fail

■ 1. Success

Setup for Presentation Catalog Replication
To enable Presentation Catalog replication, set up the conditions described in this section.

Edit the instanceconfig.xml for Replication
For each instance Oracle BI Presentation Services, you need to edit the Oracle BI Presentation 
Services configuration file (instanceconfig.xml) to: 

■ Enable replication. By default, the replication functionality is disabled for instances of Oracle BI 
Presentation Services. 

■ Configure replication for a clustered environment. In a clustered environment, several instances 
of Oracle BI Presentation Services can share the same Presentation Catalog. For replication to 
work properly, you need to:

■ Ensure that each instance of Oracle BI Presentation Services writes to its own log file to avoid 
concurrency issues

■ Make sure that changes made by all instances are taken into account during import and 
export operations

■ Specify the number of records to be kept in a replication log file

■ Specify the time period (in hours) from which replication log files are to be read for replication 
operations.
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For more information on editing the instanceconfig.xml file for replication, see “Editing the 
instanceconfig.xml File for Replication” on page 108.

Create the Oracle BI Presentation Services Replication Agent 
Configuration File
You need to create the Oracle BI Presentation Services Replication Agent’s configuration file 
(config.xml) to specify which folders on which instances of Oracle BI Presentation Services are to be 
replicated. For more information, read “Creating the config.xml File for Replication” on page 105.

Use Oracle BI Presentation Services Replication Agent
You can run the Oracle BI Presentation Services Replication Agent (sawrepaj) on any computer that 
has network access to both instances of Oracle BI Presentation Services. This agent handles all the 
replication tasks. It has some command line options. For more information, see “Using the Oracle BI 
Presentation Services Replication Agent” on page 103.

Copy Presentation Catalog Files
The Oracle BI Presentation Services Replication Agent copies changes made to a Presentation 
Catalog. Because it only copies changes, and not the entire contents, you must first make a copy of 
the source Presentation Catalog on each of the subscribing instances of Oracle BI Presentation 
Services.

Maintain the List of Presentation Catalog Folders to Be Replicated
Because the Presentation Catalog came from another instance, the list of catalog folders to be 
replicated may be incorrect. Use the sawrepaj mark command to maintain the list of catalog folders 
to be replicated. For more information, see “Using the Oracle BI Presentation Services Replication 
Agent” on page 103.

Resuming Replication If Replication Log Files Are 
Unavailable
If, for some reason, replication log files are unavailable in an instance of Oracle BI Presentation 
Services, you may need to resume replication by copying over the Presentation Catalog folders that 
the instance subscribes to. However, this method loses the catalog contents that were not replicated 
to other instances. The following method preserves all catalog contents.

NOTE: If you need to resume replication after Oracle BI Presentation Services has been offline for a 
time period in excess of that configured with the ReadLogRecordsSinceHoursAgo element in the 
config.xml file, you can adjust the value of ReadLogRecordsSinceHoursAgo so that log files in the 
offline period get replicated. Then, reset ReadLogRecordsSinceHoursAgo back to its original setting.
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To resume replication if replication log files are unavailable

1 Use Oracle BI Catalog Manager to erase all replication logs in the {presentationcatalogpath}/
replication/changelog and {presentationcatalogpath}/replication/playback folders, where 
presentationcatalogpath} is the full path to the Presentation Catalog folder.

For more information about Catalog Manager, see Chapter 7, “Managing Presentation Catalogs 
Using Oracle BI Catalog Manager.”

2 Set the UseReplication element in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml)l to N. For more information, see “Editing the instanceconfig.xml File for 
Replication” on page 108.

3 Start the instance of Oracle BI Presentation Services.

4 Delete or rename folders that are replicated from other instances and copy them over from other 
instances using the sawrepaj remotecopy command.

5 Set the UseReplication element in instanceconfig.xml to Y. For more information, see “Editing the 
instanceconfig.xml File for Replication” on page 108.

6 Restart the instance of Oracle BI Presentation Services.

7 Restore the list of folders to be replicated using the sawrepaj mark command on the instance of 
Oracle BI Presentation Services. For more information, see “Using the Oracle BI Presentation 
Services Replication Agent” on page 103.

8 Reenable replication tasks by editing the configuration file to delete the lastPerformed attribute 
from all ReplicationTask elements that have the instance of Oracle BI Presentation Services as 
an import or export target.

Using the Oracle BI Presentation Services Replication 
Agent
The Oracle BI Presentation Services Replication Agent (sawrepaj) is a utility that carries out the 
common replication tasks such as copy, export, import, and mark for replication.

The Oracle BI Presentation Services Replication Agent needs information about the instances of 
Oracle BI Presentation Services and the replication tasks. This information is stored in the config.xml 
file. For more information about the config.xml file, see “Creating the config.xml File for Replication” 
on page 105.

The command line for the Oracle BI Presentation Services Replication Agent uses the following 
format:

■ In UNIX:

sawrepaj.sh [/C path] command [command parameters]

The sawrepaj.sh file is located in SAROOTDIR\web\bin\sawrepaj (where SAROOTDIR is the 
installation directory).

■ In Windows
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sawrepaj.bat [/C path] command [command parameters]

The sawrepaj.bat file is located in SAROOTDIR\web\bin\sawrepaj (where SAROOTDIR is the 
installation directory).

The path following the /C specifies the path to the config.xml file. The command can be one of the 
following:

■ mark

■ remotecopy

■ run

mark
Adds or removes the specified catalog folders from the list of catalog folders that are to be replicated 
on all or specified Oracle BI Presentation Servers. The list of catalog folders to be replicated is stored 
in a config item located in {presentationcatalogpath}/root/system/replication, where 
{presentationcatalogpath} is the full path to the Presentation Catalog folder.

Adding a catalog folder to the list does not mean that the corresponding catalog item is immediately 
replicated. Only future modifications are noted in the replication log file and subsequently get 
replicated. 

The syntax for the mark command is:

sawrepaj [/C path] mark {all|servername} [/n] [catalogfolders]

■ all | servername. The name of the Oracle BI Presentation Server (or all) on which to run the 
mark command. If you use a specific server, the name you specify must match the name attribute 
of the corresponding server element in the config.xml file.

■ /n. If present indicates that the catalog folder should be removed from the list of catalog folders 
to be replicated, otherwise it is added.

■ catalogfolders. A list of catalog folders to add or remove from the list of catalog folders to be 
replicated. Separate each folder in the list with a space. To add or remove the entire Presentation 
Catalog (including all folders and such information as system privileges, Catalog Group 
membership, and so on), use /. If you do not specify any folders, then sawrepaj executes the 
mark command on every folder for the specified servers listed in the config.xml file.

For example: 

sawrepaj /C OracleBI\web\bin\sawrepaj mark all /

remotecopy
Exports the contents of the specified catalog folders from the source server and imports them in the 
destination server. 

The syntax for the remotecopy command is:

sawrepaj [/C path] remotecopy sourceServer destinationServer catalogfolders

■ sourceServer. The name of the source server as specified in the config.xml file.
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■ destinationServer. The name of the destination server as specified in the config.xml file.

■ catalogfolders. A list of catalog folders to copy remotely. Separate each folder in the list with 
a space. If you do not specify any folders, then sawrepaj executes the remotecopy command on 
every folder for the specified servers listed in the config.xml file.

For example: 

sawrepaj /C OracleBI\web\bin\sawrepaj remotecopy Server1 Server2 users shared

run
Executes all replication tasks that are set up in config.xml file and that have not expired. This 
command does not have any runtime parameters. 

The syntax for the run command is:

sawrepaj [/C path] run 

For example: 

sawrepaj /C OracleBI\web\bin\sawrepaj run

Creating the config.xml File for Replication
The structure of the Oracle BI Presentation Services Replication Agent’s configuration file 
(config.xml), located in SAROOTDIR\web\bin\sawrepaj (where SAROOTDIR is the installation 
directory), is as follows:

<Config>
<General>

< ExportDirectory />
< LogExpiresHours/>
< RetryAttempts/>

</General>
<Server/>
<Folderset>

<Folder/>
</Folderset>
<ReplicationTask/>

</Config>

Table 12 describes the elements that you can set in the config.xml file.

Table 12. Elements in the config.xml File

Element Parent Occurrences Description

Config N/A 1 XML root element.

General Config 1 Contains general settings applicable to all 
instances and replication tasks.
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Export Directory General 1 Contains the UNC path to the shared directory 
where export files should be placed. It should 
be accessible by the same name from all 
instances of Oracle BI Presentation Services. 

In addition, the user account under which an 
instance of Oracle BI Presentation Services is 
running must have read/write permissions to 
this directory.

LogExpiresHours General 1 Specifies the time in hours (as a double value) 
that replication logs expire on all instances of 
Oracle BI Presentation Services.

Set this element to the value of the 
ReadLogRecordsSinceHoursAgo element that is 
the lowest among all instances of Oracle BI 
Presentation Services participating in 
replication. For more information on the 
ReadLogRecordsSinceHoursAgo element, see 
“Editing the instanceconfig.xml File for 
Replication” on page 108.

RetryAttempts General 1 Specifies the number of times an attempt to 
change an item is to be retried.

(An attempt to change an item may need to be 
retried, for example, if an item was locked.)

Server Config 1…n Defines connection information for each Oracle 
BI Presentation Server. Its attributes are:

■ name. The logical id of the server, which is 
used to identify it in replication tasks and in 
the sawrepaj command line.

■ url. The URL of the instance of Oracle BI 
Presentation Services, such as:
http://localhost/analytics/saw.dll

■ user. The user name.

■ pwd. The password.

Folderset Config 0…n Defines a list of catalog folders. Its only 
attribute is:

■ name

Table 12. Elements in the config.xml File

Element Parent Occurrences Description
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Example config.xml File
The following XML file is an example of the config.xml file:

<?xml version="1.0" encoding=”UTF-8”?>
<!-- Oracle BI Presentation Services Replication Agent Configuration File -->
<!-- The following example specifies that the entire Presentation Catalog (that is 

all folders) on Server 1 is to be replicated on server 2 and that the entire Presentation 
Catalog on Server 2 is to be replicated on server 1. -->

Folder Folderset 0…n Adds a folder to the folderset. It specifies the 
full path to the catalog folder.

ReplicationTask Config 0…n Defines the replication tasks. Its attributes are:

■ source. The source server name. This 
must match an instance defined in the 
Server element.

■ destination. The destination server name. 
This must match an instance defined in the 
Server element.

■ folders. The name of the folders set. This 
must match a folder set defined in the 
Folderset element.

■ lastPerformed. The timestamp of the last 
successful run of this task. The sawrepaj 
utility updates this value.

■ localChanges. Specifies whether changes 
made directly on the source server are to 
be exported:

■ true. Changes are to be exported.

■ false. Changes are not to be exported.

Default: true

■ remoteChanges. Specifies whether 
changes that were made on another server 
and that were replicated on the source 
server are to be reexported:

■ true. Changes are to be reexported.

■ false. Changes are not to be 
reexported.

Default: false

Table 12. Elements in the config.xml File

Element Parent Occurrences Description



Oracle Business Intelligence Presentation Services Administration Guide 
Version 10.1.3.2

Administering the Oracle BI Presentation Catalog ■ Replicating Presentation Catalogs

108 

<Config>
<General>

<ExportDirectory>\\host1\shared</ExportDirectory>
</General>

</Server name="1" pwd="" url="http://host1/analytics/saw.dll" 
user="administrator" pwd=""/>

</Server name="2" pwd="" url="http://host2/analytics/saw.dll" 
user="administrator" pwd=""/>

<Folderset name="all">
<Folder>/</Folder>

</Folderset>

<ReplicationTask destination="2" source="1" folders="all" />
<ReplicationTask destination="1" source="2" folders="all" />

</Config>

Editing the instanceconfig.xml File for Replication
Table 13 describes the elements that you can set for replication in the Oracle BI Presentation Services 
configuration file (instanceconfig.xml).

Table 13. Elements for Replication in the instanceconfig.xml File

Element Description

UseReplication Specifies whether the instance of Oracle BI 
Presentation Services is to participate in 
replication, as either a publisher or subscriber.

■ Y. Enables replication.

■ N. Disables replication.

Default: N

Replication/Cluster/MyInstanceID Identifies the suffix (%INSTANCEID%) to be 
used for the log files generated by this instance 
of Oracle BI Presentation Services. Log files are 
named as follows:

■ For change log files: 
sawchange_%INSTANCEID%_%SEQNUM
%.log

■ For playback log files:
sawplayback_%INSTANCEID%_%SEQNUM
%.log

This element is required in a clustered 
environment.
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For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes.”

Archiving a Presentation Catalog
You can archive an entire Presentation Catalog or an individual catalog folder in the Presentation 
Catalog. When you archive a Presentation Catalog (that is, the catalog root folder) or an individual 
catalog folder, all objects in the folder and the folder’s subfolders are saved in single compressed file.

NOTE: The archive function is also available to Answers and Delivers users who have been assigned 
the Catalog: Archive Catalog privilege. For more information about the archive function in Answers 
and Delivers, see the Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards 
User Guide. For more information on privileges, see “About Setting Oracle BI Presentation Services 
Privileges” on page 152.

You also can use Catalog Manager to archive a Presentation Catalog or individual catalog folder as 
well as unarchive a Presentation Catalog or individual catalog folder. (The unarchive functionality is 
available only in Catalog Manager.) For more information about using Catalog Manager, read 
Chapter 7, “Managing Presentation Catalogs Using Oracle BI Catalog Manager.”

To archive an entire Presentation Catalog or an individual catalog folder in the 
Presentation Catalog

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the link Manage Presentation Catalog.

The Manage Catalog screen appears.

Replication/Cluster/IDsInCluster Identifies, by ID, all instances of Oracle BI 
Presentation Services that are in the cluster. 
Separate each ID by a comma.

This element is required in a clustered 
environment.

Replication/RecordsInFileLimit Specifies the number of records to be kept in a 
replication log file.

Default: 5000

Replication/ReadLogRecordsSinceHoursAgo Specifies the time period (in hours) from which 
replication log files are to be read for 
replication operations.

Default: 168

Table 13. Elements for Replication in the instanceconfig.xml File

Element Description
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4 If you want to archive a catalog folder (and all its subfolders) rather than the entire catalog, 
navigate to the folder.

5 If you want to archive the:

■ Permissions that are assigned to each item or folder, select the Keep Permissions checkbox.

If you do not select this option, the archiving process will not include any permissions. Upon 
unarchiving, the system will assign the parent folder’s permissions to all of the items and 
folders.

■ Timestamps that are assigned to the item and folder that you are archiving, select the Keep 
Timestamp checkbox. 

If you do not select this option, the archiving process will not include timestamp information. 
Upon unarchiving, the system will apply a timestamp indicating the time at which the item 
or folder is unarchived.

6 Click the Archive Catalog button.

The File Download dialog box appears.

7 Click Save.

The Save As dialog box appears

8 Complete the Save As dialog box and click Save.

Administering Items in the Presentation 
Catalog
You administer shared Presentation Catalog folders through the Manage Catalog screen in Oracle BI 
Presentation Services Administration. You can view folders and contents including hidden items, and 
create, rename, copy, move, and delete folders and contents. You can also take ownership of an item. 
(Taking ownership of an item allows only you to make changes to it. This is useful if a user needs 
assistance with, for example, a request.)

You also can use Catalog Manager to administer items in the Presentation Catalog. For more 
information about using Catalog Manager, read Chapter 7, “Managing Presentation Catalogs Using 
Oracle BI Catalog Manager.”

NOTE: Changes made in the Presentation layer of Oracle BI Administration Tool can affect reports 
and dashboards based on those tables and columns. You can use Catalog Manager to keep the 
Presentation Catalog in sync with these changes in the Presentation layer.

For information about changing permissions to an item in the Presentation Catalog, read “About 
Setting Oracle BI Presentation Services Permissions” on page 147.

To display the shared Presentation Catalog folders

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.
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3 Click the link Manage Presentation Catalog.

The Manage Catalog screen appears.

4 Click the Shared Folder link.

To show hidden items
■ Select the Show Hidden Items check box.

This action reveals, for example, the following hidden items in the user’s home directory:

■ _alerts

■ _briefingbook

■ _delivers

■ _filters

■ _ibots

■ _portal

■ _prefs

■ _selections

■ _subscriptions

NOTE: The availability of the Show Hidden Items check box is controlled by the See Hidden Items 
privilege. For more information, read “Default Oracle BI Presentation Services Privilege 
Assignments” on page 154.

To create a new folder
■ Click the link Create New Folder and follow the instructions on the screen.

To view the contents of a folder
■ Click the folder name.

To take ownership of an item

1 Navigate to the item.

2 Click the Properties icon for the item.

The Item Properties screen appears.

3 If you have the appropriate authority, you can take ownership of the item or folder by clicking 
one of the following links:

■ Take Ownership of this item

■ Take Ownership of this item and all subitems
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To rename a folder or an item

1 Navigate to the folder or item to rename.

2 Click the Edit name and Description icon for the item.

The Rename Item screen appears.

3 Type a new name for the item.

You can also type a description.

4 To preserve references that other users might have to the prior name of the item, select the 
following option:

Preserve references to the old name of this item

If you do not select this option, users referencing this item cannot display it.

5 Click Rename.

To delete a folder or an item

1 Navigate to the folder to delete.

2 Click the folder’s Delete icon.

The Confirm Item Deletion screen appears.

NOTE: When deleting shared folders or items, be aware that other users who have added shared 
items to their personal dashboards no longer have access to them.

3  To confirm the delete, click Yes.

To copy or move an item

1 Navigate to the item.

2 Click Copy/Move button for the item.

The Copy/Move Item Here screen appears.

3 Follow the instructions given on the screen.

■ To create a new folder, click the link Create New Folder and follow the instructions on the 
screen.

4 To show hidden items, select the Show Hidden Items check box.

This action reveals, for example, the following hidden items in the user’s home directory:

■ _alerts

■ _briefingbook

■ _delivers

■ _filters

■ _ibots
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■ _portal

■ _prefs

■ _selections

■ _subscriptions

NOTE: The availability of the Show Hidden Items check box is controlled by the See Hidden Items 
privilege. For more information, read “Default Oracle BI Presentation Services Privilege 
Assignments” on page 154.

5 When done, click Copy/Move Item Here.
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7 Managing Presentation Catalogs 
Using Oracle BI Catalog 
Manager

This chapter explains how to manage Presentation Catalogs using Oracle BI Catalog Manager.

This chapter contains the following topics:

■ About Catalog Manager on page 115

■ Guidelines for Working with Catalog Manager on page 116

■ Starting Catalog Manager on page 116

■ Opening Presentation Catalogs in Catalog Manager on page 116

■ About the Catalog Manager Workspace on page 119

■ Managing the View of the Catalog Manager Workspace on page 120

■ Searching for Presentation Catalog Items Using Catalog Manager on page 121

■ Copying and Pasting Items Between Presentation Catalogs on page 122

■ Renaming Presentation Catalog Items on page 123

■ Working with the Properties of Presentation Catalog Items on page 123

■ Setting Permissions of Presentation Catalog Items on page 124

■ Viewing and Editing Presentation Catalog Objects in XML on page 125

■ Setting Browser Preference in Catalog Manager on page 126

■ Previewing Objects from Catalog Manager on page 126

■ Searching for and Replacing Presentation Catalog Text Using Catalog Manager on page 127

■ Creating Reports to Display Presentation Catalog Data Using Catalog Manager on page 129

■ Localizing Presentation Catalog Captions on page 130

■ About Upgrading the Presentation Catalog to a Newer Version on page 132

■ Archiving and Unarchiving a Presentation Catalog Using Catalog Manager on page 132

About Catalog Manager
Catalog Manager is a tool that lets you perform online and offline management of Presentation 
Catalogs. It should be installed on a secure machine accessible only to Oracle Business Intelligence 
administrators. 

You can use Catalog Manager to:

■ Manage Presentation Catalog items (that is, folders, links, and objects [requests, filters, 
prompts, dashboards, and so on]). For example, you can rename and delete items, and move 
and copy items within and between Presentation Catalogs. 
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■ View and edit Presentation Catalog objects in Extensible Markup Language (XML).

■ Preview objects, such as requests and prompts.

■ Search for and replace Presentation Catalog text.

■ Search for Presentation Catalog items.

■ Create reports to display Presentation Catalog data.

■ Localize Presentation Catalog captions.

■ Upgrade Presentation Catalogs to new versions without losing any site-specific changes and 
enhancements.

NOTE: Many of the operations that you can perform in Catalog Manager, can also be performed 
through the Manage BI Catalog activity in Oracle BI Presentation Services Administration. For more 
information, read Chapter 6, “Administering the Oracle BI Presentation Catalog” and Chapter 8, 
“Managing Oracle BI Presentation Services Security.”

Guidelines for Working with Catalog 
Manager
The guidelines for working with Catalog Manager are:

■ Always make backup copies of the Presentation Catalogs that you are working with. 

■ Be sure of changes that you plan to make. Catalog Manager commits changes immediately. There 
is no undo function nor are there any error messages to tell you that a particular change will not 
display well in Answers or in Dashboards. However, if you do make any unwanted changes, you 
can revert to your latest saved backup.

■ Do not copy and paste into email, as this is not supported.

Starting Catalog Manager
Use the following procedure to start Catalog Manager. 

To start Catalog Manager
■ On the machine where Catalog Manager is installed, choose Start > Programs > Oracle Business 

Intelligence > Catalog Manager.

Opening Presentation Catalogs in 
Catalog Manager
You can open a Presentation Catalog in one of two modes:

■ Online mode — Connects to a Presentation Catalog on a running Web server. In this mode your 
permissions are applied. You can see only those items for which you have permission.
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■ Offline mode — Connects to a local file system. In this mode, you are logged in as a super user 
or system user, and no permissions are applied. You can see all items in the Presentation Catalog.

Operations available in online mode and offline mode
Many of the operations that you can perform using Catalog Manager are available in both online mode 
and offline mode. A few operations are available in only one mode or the other. Generally, the 
operations available in:

■ Online mode are read-only operations and write operations that do not affect the entire catalog, 
such as setting permissions of an item

■ Offline mode include most of the operations available in online mode as well as write functions 
that affect the entire catalog, such as searching for and replacing Presentation Catalog text
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Specifically, the operations that you can perform in each mode are as follows:

Deciding whether to use online mode or offline mode
Whether you use online mode or offline mode depends on the activity that you want to perform. 
Generally, it is recommended that you use:

■ Online mode when you want to make minor incremental changes or additions to the Presentation 
Catalog, such as changes to permissions, updates to a single item, or migration of new items to 
a production environment 

Online mode operations Offline mode operations

Cutting items Cutting items

Copying items Copying items

Pasting items Pasting items

Copying items for another catalog Copying items for another catalog

Pasting items from another catalog Pasting items from another catalog

Creating shortcuts of items Creating shortcuts of items

Deleting items Deleting items

Renaming items without reference updates Renaming items without reference updates

Refreshing the Catalog Manager workspace Refreshing the Catalog Manager workspace

Creating folders Creating folders

Setting permissions of items Setting permissions of items

Working with properties of items Working with properties of items

Managing the view of the workspace Managing the view of the workspace

Searching for items Searching for items

Creating reports to display Catalog 
Manager data

Creating reports to display Catalog Manager 
data

Setting browser preference Setting browser preference

Previewing objects Renaming items with reference updates (known 
as Smart Rename)

Searching for and replacing Presentation 
Catalog text

Exporting captions for localization purposes

Upgrading Catalog Managers to newer versions
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■ Offline mode when you want to make Presentation Catalog-wide changes, such as globally 
renaming items or moving multiple items for reorganization

NOTE: Generally, working in offline mode is faster than working in online mode. This is because you 
are accessing, creating, and updating the individual files directly, and Presentation Catalog does not 
have to communicate with Oracle BI Presentation Services as it does when you are working in online 
mode. 

To open a Presentation Catalog

1 In Catalog Manager, choose File > Open Catalog.

2 Complete the necessary fields.

Some of the fields are described in the following table.

3 Click OK.

About the Catalog Manager Workspace
The Catalog Manager workspace allows you to view and work with Presentation Catalog items. It 
displays the following folders for an open Presentation Catalog:

■ The shared folder— Contains content that is shared among Catalog users. This includes the 
preconfigured dashboards and requests that are distributed with prebuilt applications, and other 
items such as shared filters.

■ The system folder — Contains administrative elements of Oracle BI Presentation Services. Some 
of these elements are distributed with the product, and others are set up by you as the Oracle 
BI Presentation Services Administrator, such as privileges.

■ The users folder — Contains content that Catalog users with the appropriate permissions have 
saved to their personal folders, such as individual requests.

Field Description

Type Select the mode (online or offline) in which to open the Presentation 
Catalog.

Path Enter the path to the Presentation Catalog:

■ If you are opening the Presentation Catalog in online mode, the URL 
to Oracle BI Presentation Services, for example:

http://<machinename>/analytics/saw.dll

■ If you are opening the Presentation Catalog in offline mode, the 
Presentation Catalog folder on the local file system, for example:

C:\OracleBIData\web\catalog\default

Read-Only Select this field to open the Presentation Catalog in read-only mode.
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What the Catalog Manager Looks Like
Catalog Manager consists of the following main components:

■ Menu bar — Lets you access the following menus:

■ File — Provides options that let you open and close Presentation Catalogs, exit Catalog 
Manager, and so on.

■ Edit — Provides options that let you mange Presentation Catalog items, such as Cut, Copy, 
Permissions, and so on. (Many of these options are also available on the right-mouse pop-up 
menu.)

■ View — Provides options to manage the view of the Catalog Manager workspace, such as 
Show Tree, Show Job Status, and so on.

■ Tools — Provides options that let you manage Presentation Catalogs, such as Search and 
Replace, Upgrade Catalog, and so on.

■ Help — Provides options to access the Oracle Web site and to the information about Catalog 
Manager.

■ Toolbar — Provides quick access to commonly used options, such as Cut, Copy, Paste, and so on.

■ Tree pane — Displays Presentation Catalog folders. The pane also displays objects but only if the 
Show Objects in Tree option on the View menu is selected.

■ Table pane — Displays Presentation Catalog folders and objects. It consists of: 

■ The navigation bar, where you can navigate to the Presentation Catalog item that you want 
to work with by typing its pathname.

■ These 5 columns: Name, Type, Permissions, Date Created, and Last Modified.

The Type column identifies the type of item. Items that are identified as “unknown file” are 
generally internally-used items, and their type is not exposed in Catalog Manager.

■ Right-mouse pop-up menu — Provides options that let you manage Presentation Catalog items, 
such as Rename, Properties, Permissions, and so on. (Many of these options are also available 
on the Edit menu.)

Managing the View of the Catalog 
Manager Workspace
You can manage what you view in the Catalog Manager. For example, you can show objects in the 
Tree pane or show job statuses.
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To manage the view of the Catalog Manager workspace
■ In Catalog Manager, choose View and then one of these options:

Searching for Presentation Catalog 
Items Using Catalog Manager
You can search for items in the Presentation Catalog using the Search function. For example, you 
might want to search for all items that have a property with the value of “administrator.” 

When you search, you can limit the search by:

■ Name — Limits the search to the names of items.

■ Description — Limits the search to the Description property.

■ Property values — Limits the search to the values of properties.

■ Owner — Limits the search to the owners of items.

■ Object type — Searches for all types of objects or limits the search to the specific type of object 
that you specify. You can specify folders, requests, filters, iBots, dashboard prompts, or 
dashboard pages.

■ Date — Limits the search to items that were created on the dates that you specify or to items 
that were last modified on the dates that you specify.

To search for an item:

1 In Catalog Manager, open the Presentation Catalog.

2 Click Search on the Toolbar.

3 In the Search for any or all criteria below field, type the word or phrase to search for.

Option Description

Show Tree Displays the Tree pane, if you previously had closed it

Show Table Displays the Table pane, if you previously had closed it

Show Job Status Displays the Background Job Status pane, where you can view the 
progress of processes that you have run, such as Search and Replace, 
Smart Rename, and so on. You can also remove all finished jobs and set 
progress preferences using the icons in the upper-right corner of the 
pane.

Show Objects in 
Tree

Displays objects (that is, requests, filters, and so on) in addition to 
folders in the Tree pane.

Refresh Refreshes the items displayed in the Tree and Table panes. (You might 
want to refresh the data, for example, if someone else makes changes to 
the Presentation Catalog while you are working with it and you want to 
see the changes.)
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4 If you want to limit the search, click Advanced Search.

5 In the Advanced Search area, specify the constraints for the search.

6 Click Search.

TIP: When you have finished searching, click Explorer on the Toolbar to return to the Tree and Table 
panes. 

Copying and Pasting Items Between 
Presentation Catalogs
You can copy items from one catalog and paste them into another catalog. The mode in which the 
catalogs are opened makes no difference; that is, you can copy and paste items from an:

■ Online catalog to an offline catalog (or an offline catalog to an online catalog)

■ Online catalog to another online catalog

■ Offline catalog to another offline catalog

This is especially useful, for example, if you want to develop new items in a catalog offline and then 
migrate them to a production environment without having to shutdown Oracle BI Presentation 
Services.

Presentation Catalogs are structured in hierarchical folders. When copying or merging items, 
remember to also copy any items that are associated with them, such as dashboard folders, request 
links, and requests. URL paths in external applications may need to be re-established after a copy 
or merge operation if the entire folder path is not copied, for example, if added to the dashboard as 
a link or text.

To copy and paste items between Presentation Catalogs

1 In Catalog Manager, open the Presentation Catalog that you want to change, that is the target 
catalog. 

TIP: If the both catalogs have the same name, you might want to rename one of the catalogs 
before opening it to help distinguish between the two catalogs as you work.

2 Using another instance of the Catalog Manager, open the Presentation Catalog that contains the 
items that you want to copy, that is the source catalog.

3 If necessary, reposition both instances of Catalog Manager on your screen so you can display the 
title bars of both Catalog Manager instances.

4 In the source Presentation Catalog, right-click the source item and choose Copy for another 
catalog. 

5 In the target Presentation Catalog, right-click at the point where you want to paste the source 
item and choose Paste from another catalog.



Managing Presentation Catalogs Using Oracle BI Catalog Manager ■ Renaming
Presentation Catalog Items

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

123

Renaming Presentation Catalog Items
You can rename items in the Presentation Catalog. This can be useful when you are migrating from 
a development environment to a production environment.

There are two ways to rename an item:

■ Rename without reference updates — Renames the item and preserves the references to the 
original name that other catalog items might have

■ Rename with reference updates — Renames the item and changes references that other items 
might have to the new name (that is, original name references are not preserved).

NOTE: To rename items with reference updates, you must open the Presentation Catalog in 
offline mode.

CAUTION: Do not rename the “My Dashboard” dashboards in the Users folder.

To rename an item without reference updates

1 In Catalog Manager, open the Presentation Catalog.

2 Navigate to the item to be renamed.

3 Right-click the item in the Name column and choose Rename.

4 Type a new name for the item.

To rename an item with reference updates

1 In Catalog Manager, open the Presentation Catalog in offline mode.

2 Navigate to the item to be renamed.

3 Right-click the item in the Name column and choose Smart Rename.

4 Type a new name for the item.

NOTE: A progress bar in the lower right-hand corner of the window shows the progress of the 
reference updates. 

Working with the Properties of 
Presentation Catalog Items
Using the Properties option of Catalog Manager, you can:

■ Create, view, edit, and delete the properties of Presentation Catalog items.

■ Take ownership of Presentation Catalog items.

Taking ownership of an item allows only you to make changes to it. This is useful if a user needs 
assistance with, for example, a request.
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■ Change attributes of Presentation Catalog items to hide them from display in Oracle Business 
Intelligence.

To work with the properties of a Presentation Catalog item

1 In Catalog Manager, open the Presentation Catalog.

2 Navigate to the item.

3 Right-click the item in the Name column and choose Properties.

4 Perform the necessary tasks:

a To create, edit, or delete a property, use the New, Edit, or Delete button as appropriate.

NOTE: The New button is used to create a new property. You should use it only if instructed 
to do so by Oracle Corporation. 

b To take ownership of an item, click the Take ownership button.

c To change the attribute of an item to hidden (which hides the item from display in Oracle 
Business Intelligence), select the Hidden option.

NOTE: The Read-Only option is unused. The System option indicates that the item is 
maintained internally and should not be altered.

5 Click Close.

Setting Permissions of Presentation 
Catalog Items
Permissions are used to control access to Presentation Catalog items. 

For more information about permissions in Oracle BI Presentation Services, read Chapter 8, 
“Managing Oracle BI Presentation Services Security.”

To set permissions of a Presentation Catalog item

1 In Catalog Manager, open the Presentation Catalog.

2 Navigate to the item.

3 Right-click the item in the Name column and choose Permissions.

The Permissions dialog box displays these two lists:

■ Users and groups (Explicit Permissions) list — Shows the users and groups that have 
explicit permissions granted to this item. 

■ Additional users and groups (Effective Permissions) list — Shows the users and groups 
that have access granted though group inheritance, and users and groups that have no 
access to the request.
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4 If the item whose permissions you want to set is in the Additional users and groups (Effective 
Permissions) list, move it into the Users and groups (Explicit Permissions) list by selecting it and 
clicking the left arrow button (<).

NOTE: To view groups only, select the Show groups only option.

5 Select the item in the Users and groups (Explicit Permissions) list.

6 Select the new permission from the drop-down list in the Permissions column:

7 Click the Apply Permissions: Recursively option, if appropriate.

8 Click OK.

NOTE: If you move a user or group from the Users and groups (Explicit Permissions) list to the 
Additional users and groups (Effective Permissions) list, the user or group privileges are reset to No 
Access. To move a user or group from one list to another, highlight it and click the right or left arrow 
button, as appropriate.

Viewing and Editing Presentation 
Catalog Objects in XML
You can view and edit the XML description of Presentation Catalog objects such as requests, 
dashboards, filters and so on.

CAUTION: If you change the XML code, you are changing the representation of the object in the 
Presentation Catalog.

To view the XML description of an object

1 In Catalog Manager, open the Presentation Catalog.

2 Navigate to the object.

Permission What It Means

No Access Denies the user or group access to the item. Explicitly denying access 
takes precedence over any other permission.

Read Allows the user or groups to view the item, but not make any changes.

Traverse Allows the user or groups to access objects in folders within the selected 
folder when the user does not have permission to the selected folder. 

Example: The user is granted Traverse permission to the /shared/test 
folder. The user cannot access objects in the /shared/test folder, but can 
access objects stored in lower-level folders, such as /shared/test/guest.

Change/Delete Allows the user or group to view, change, or delete the item.

Full Control Allows the user or group to have full control over the item. This is the level 
of authority granted by default to the preconfigured Administrator user 
ID.
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3 Right-click the object in the Name column and choose Properties.

4 Click Edit XML.

5 When you are done viewing the XML definition, close the XML dialog box.

6 Click Close in the Properties dialog box.

To edit the XML description of an object

1 In Catalog Manager, open the Presentation Catalog.

2 Navigate to the object.

3 Right-click the object in the Name column and choose Properties.

4 Click Edit XML.

5 Make the changes in the Object XML area.

NOTE: When you edit the XML description of an object, Presentation Catalog checks only that 
the XML is well-formed; it does not check for any other errors.

6 Click Save.

7 Click Close in the Properties dialog box.

Setting Browser Preference in Catalog 
Manager
If you are going to preview objects from Catalog Manager, you need to identify the default browser 
in which to display these objects. For more information on previewing objects, read “Previewing 
Objects from Catalog Manager.”

To set your browser preference

1 In Catalog Manager, choose Tools > Preferences.

2 In the Default Browser field, select the browser that is the same one that you have set to be the 
default browser for your operating system.

3 Click OK.

Previewing Objects from Catalog 
Manager
You can preview objects, such as requests or prompts, from Catalog Manager. 

NOTE: To preview objects, you must open the Presentation Catalog in online mode.
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To preview an object

1 In Catalog Manager, open the Presentation Catalog in online mode.

2 Navigate to the object.

3 Right-click the object in the Name list and choose Preview.

Searching for and Replacing 
Presentation Catalog Text Using Catalog 
Manager
You can search for specific text in the Presentation Catalog and replace it with other text using 
Catalog Manager.

Specifically, you can search for and replace:

■ A single text string

■ Multiple text strings all at once

NOTE: To search for and replace text, you must open the Presentation Catalog in offline mode.

Searching for and Replacing a Single Presentation 
Catalog Text String
Use this procedure to search for a single text string in the Presentation Catalog and replace it with 
other text.

To search for and replace a single text string

1 In Catalog Manager, open the Presentation Catalog in offline mode.

2 Choose Tools > Search and Replace.

3 In the Search (general) field, type the text string to search for.

4 In the Replace with field, type the replacement text.

5 Click OK.

About Searching for and Replacing Multiple 
Presentation Catalog Text Strings
You can search for and replace multiple Presentation Catalog text strings all at once by importing a 
XML file that identifies each text string to search for and replace.
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Format of the XML File for Searching for and Replacing Multiple Text 
Strings
In the search and replace XML file, you use an <action> element to identify each text string to search 
for and replace. The <action> elements are contained in a <commands> element. 

The <action> element has the following attributes:

■ command — Specifies whether you want to replace text, a Column name, or a Subject Area 
name. Valid values are:

■ textReplace — Replaces text other than the name of a Column or the name of a Subject Area.

■ renameColumn — Replaces the name of a Column.

■ renameSubjectArea — Replaces the name of a Subject Area.

■ oldValue — Specifies the text string to search for.

■ newValue — Specifies the replacement text.

Example XML File for Searching for and Replacing Multiple Text 
Strings
Here is an example of an XML file for searching for and replacing multiple text strings all at once:

- <commands>

<action command=“textReplace” oldValue=”Analytics” new Value=”Oracle Business 
Intelligence”/>

<action command=“textReplace” oldValue=”Markets.Region” new 
Value=”Markets.CountryRegion”/>

<action command=“renameColumn” oldValue=”Region” new Value=”CountryRegion”/>

<action command=“renameSubjectArea” oldValue=”SupplierSales” new 
Value=”SupplySales”/>

</commands>

Searching for and Replacing Multiple Presentation 
Catalog Text Strings
Use the following procedure to search for and replace multiple Presentation Catalog text strings all 
at once.

To search for and replace multiple text strings

1 Create the XML file for searching for and replacing multiple text strings. For more information, 
read “About Searching for and Replacing Multiple Presentation Catalog Text Strings” on page 127.

2 In Catalog Manager, open the Presentation Catalog in offline mode.
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3 Choose Tools > Search and Replace.

4 In the Import from File field, type the path or browse to the XML file you created in Step 1.

5 Click OK.

Creating Reports to Display Presentation 
Catalog Data Using Catalog Manager
You can create reports to display Presentation Catalog data for the following object types:

■ Requests

■ Dashboards

■ Segments

■ Segment trees

■ List formats

You can either display the report on the screen or save it to a file.

To create a report displaying Presentation Catalog data

1 In Catalog Manager, open the Presentation Catalog. If you want to create a report showing the 
SQL that is sent to Oracle BI Presentation Services for the object, you must open the Presentation 
Catalog in online mode.

2 Choose Tools > Create Report.

3 Specify the columns to appear in the report in the Columns in Report list. Use the left and right 
arrow buttons (< and >) to move the columns between the Available Columns list and the 
Columns in Report list, and the plus and minus buttons (+ and -) to set the order in which 
columns will appear in the report.

4 To eliminate any rows that are exactly the same from the report, select the Distinct field. 

5 In the Output the following section, specify which folders you want to output data from — either 
from all shared folders or from a specific path.

6 To save the report to a file, in the Save report to section, specify the pathname of the file as well 
as whether you want to overwrite the file or append the data to the file. (If the file does not 
already exist, it will be created.)

7 Click OK.
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Localizing Presentation Catalog 
Captions
If you need to localize text strings in the Presentation Catalog, you can export the text strings for 
translation and then expose them when translation is complete. You and your localization team are 
responsible for escaping characters properly and resolving any errors in the translated text strings.

NOTE: To export text strings, you must open the Presentation Catalog in offline mode.

The export process creates one XML file for every first-level subfolder in the shared folder, in the 
format foldernameCaptions.xml, where foldername is the name of the subfolder in the shared folder. 
Each XML file contains the text strings for all content in the corresponding first-level folder and its 
subfolders.

For example, if the shared folder in the Presentation Catalog contains the first-level folders 
Marketing, Service, and Sales, then the export process creates three XML files:

■ MarketingCaptions.xml

■ SalesCaptions.xml

■ ServiceCaptions.xml

■ After the content is translated, you place these folders in their corresponding location in the 
SADATADIR directory, where SADATADIR is the data directory:

SADATADIR\web\res\l_xx\Captions

Their content loads when the service for Oracle BI Presentation Services starts.

To export Presentation Catalog text strings

1 In Catalog Manager, open the Presentation Catalog in offline mode.

2 Choose Tools > Export Captions.

3 Browse to select the location in which to write the output, and then click OK.

4 To export only new text strings and those that have been changed since the last export, select 
Only export new or changed strings.

5 To exclude the Description properties from the export, select Exclude Descriptions.

6 Click OK.

The export process may take several minutes.

7 When the export process is complete, deliver the output file to your localization team.

You may need to make a copy of every output file for each language to be translated.

To expose Presentation Catalog text strings
■ Place the translated XML files into their corresponding location in the SADATADIR directory, 

where SADATADIR is the data directory:

SADATADIR\web\res\l_xx\Captions
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where xx is the language extension. 

The following table shows some examples of language extensions:

For more information about supported languages, see System Requirements and Supported 
Platforms on Siebel SupportWeb.

To move translated captions from a development environment to a production 
environment
■ If the caption file:

■ Does not already exist in the production environment, simple copy it from the development 
environment to the production environment.

■ Does already exist in the production environment, first make a backup copy of the existing 
file. Then open the caption file in the production environment in a text editor or XML editing 
tool and manually (and very carefully) insert the changes that were made in the development 
environment. 

Language 
Extension Language

cs Czech

da Danish

de German

en English

es Spanish

fi Finnish

fr French

it Italian

ja Japanese

ko Korean

nl Dutch

pt Portuguese

pt-br Brazilian Portuguese

sv Swedish

zh Chinese (Simplified)

zh-tw Chinese (Traditional)
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About Upgrading the Presentation 
Catalog to a Newer Version
You will need to upgrade your current Presentation Catalog with a newer version if your organization:

■ Has prebuilt applications already installed, and 

■ Has customized the Presentation Catalog, and

■ Receives a newer version of the Presentation Catalog

NOTE: If you made no changes to Presentation Catalog distributed with previous versions of prebuilt 
applications, you do not need to upgrade the catalog. You can begin using the newer version of the 
catalog.

Updating the Presentation Catalog makes use of three catalogs:

■ The Original Presentation Catalog — This is the Presentation Catalog that you received with the 
currently-installed Oracle BI applications. It is also distributed at the root level of the installation 
CD-ROM as the folder OracleBI.

■ The Current Presentation Catalog — This is the Presentation Catalog that is installed as the 
SADATADIR\web\catalog directory, where SADATADIR is the data directory.

■ The Modified Presentation Catalog — This is the Presentation Catalog that you are currently 
using. 

You use Catalog Manager to upgrade a Presentation Catalog. Catalog Manager compares the content 
in both the Current Presentation Catalog and the Modified Presentation Catalog with the content in 
the Original Presentation Catalog, merges any changes into the Current Presentation Catalog, and 
produces a list of upgrade differences, which you must resolve by indicating how you want the 
differences handled. If the Presentation Catalogs have conflicting content, you can choose which 
Presentation Catalog the content should be taken from. The end result is a merged Presentation 
Catalog that contains the site-specific changes, as well as new metadata. 

For more information on how to upgrade a Presentation Catalog using Catalog Manager, see Oracle 
Business Intelligence Applications Upgrade Guide

Archiving and Unarchiving a 
Presentation Catalog Using Catalog 
Manager
You can archive and unarchive an entire Presentation Catalog or an individual catalog folder in a 
Presentation Catalog. When you:

■ Archive a Presentation Catalog (that is, the catalog root folder) or an individual catalog folder, 
all objects in the folder and the folder’s subfolders are saved in single compressed file. 

■ Unarchive a Presentation Catalog or an individual catalog folder, the archive file is uncompressed 
and all objects in the folder and the folder’s subfolders are then stored in the current offline 
catalog. Existing folders that have the same names as folders being unarchived are overwritten.
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You also can use the Oracle BI Presentation Services Administration to archive a Presentation 
Catalog. (The unarchive functionality is available only in Catalog Manager.) For more information, 
see “Archiving a Presentation Catalog” on page 109.

To archive an entire Presentation Catalog or an individual catalog folder in the 
Presentation Catalog to a file you specify

1 In Catalog Manager, open the Presentation Catalog in offline mode.

2 To archive:

■ The entire Presentation Catalog, choose File > Archive Catalog.

■ An individual catalog folder, right-click the catalog folder and choose Archive.

3 In the Archive File Path field, specify the pathname of the file in which to archive the Presentation 
Catalog or individual catalog folder. 

4 If you want to archive the:

■ Timestamps that are assigned to the item and folder that you are archiving, select the Keep 
Timestamp checkbox. 

If you do not select this option, the archiving process will not include timestamp information. 
Upon unarchiving, the system will apply a timestamp indicating the time at which the item 
or folder is unarchived.

■ Permissions that are assigned to each item or folder, select the Keep Permissions checkbox.

If you do not select this option, the archiving process will not include any permissions. Upon 
unarchiving, the system will assign the parent folder’s permissions to all of the items and 
folders.

5 Click OK.

To archive an entire Presentation Catalog to the last used archive file

1 In Catalog Manager, open the Presentation Catalog in offline mode.

2 Choose File > Quick Archive.

To unarchive an entire Presentation Catalog or a catalog folder

1 In Catalog Manager, open the Presentation Catalog in offline mode.

2 If you are unarchiving a catalog folder, navigate to the location where you want to unarchive the 
folder.

3 Choose File > Unarchive Catalog.

4 In the Archive File Path field, specify the pathname of the Presentation Catalog or catalog folder 
that you want to unarchive.

5 Click OK.
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8 Managing Oracle BI 
Presentation Services Security

This chapter explains how to set up Oracle BI Presentation Services security so that users have only:

■ Access to items in the Presentation Catalog that are appropriate to them.

■ The ability to perform actions that are appropriate to them.

Use this chapter if your organization uses the Oracle Business Intelligence infrastructure or if your 
organization uses prebuilt applications, but has created additional content outside of the 
applications.

This chapter contains the following topics:

■ Overview of Oracle BI Presentation Services Security on page 135

■ Types of Presentation Services Groups on page 138

■ Administering Presentation Services Groups on page 139

■ About Oracle BI Presentation Services User Authentication on page 142

■ About Presentation Services Groups and Session Variables on page 143

■ Inheritance of Oracle BI Presentation Services Permissions and Privileges on page 145

■ About Setting Oracle BI Presentation Services Permissions on page 147

■ Overview of the Oracle BI Presentation Services Administration Screen on page 148

■ Setting Permissions in Oracle BI Presentation Services Administration on page 150

■ About Setting Oracle BI Presentation Services Privileges on page 152

■ Setting Privileges in Oracle BI Presentation Services Administration on page 152

■ Default Oracle BI Presentation Services Privilege Assignments on page 154

■ Guidelines for Configuring Oracle BI Presentation Services Security for the Presentation Catalog and 
Dashboards on page 161

■ About Authorizing Users to Act for Others on page 167

■ Process of Authorizing Users to Act for Others on page 168

■ Enabling User-Initiated Administration Actions on page 173

Overview of Oracle BI Presentation 
Services Security
This section provides an overview of Oracle BI Presentation Services security. It contains the 
following topics:

■ “Where Oracle BI Presentation Services Security Settings Are Made” on page 136
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■ “Differences Between Groups and Presentation Services Groups” on page 136

■ “Your Security Goals in Oracle BI Presentation Services” on page 136

■ “About Access Control and Permissions in Oracle BI Presentation Services” on page 137

■ “About User Rights and Privileges in Oracle BI Presentation Services” on page 137

■ “About User Authentication in Oracle BI Presentation Services” on page 138

Where Oracle BI Presentation Services Security Settings Are Made
Security settings that affect Oracle BI Presentation Services are made in the following Oracle 
Business Intelligence components:

■ Oracle BI Administration Tool. This is where you perform the following tasks:

■ Set permissions for business models, tables, columns, and subject areas.

■ Specify database access for each user.

■ Specify filters to limit the data accessible by users.

■ Set authentication options.

For more information, read Oracle Business Intelligence Server Administration Guide.

■ Oracle BI Presentation Services Administration. This is where you set permissions to 
Presentation Catalog items, including dashboards, and the privilege to perform actions such as 
edit views, create iBots, and create prompts.

■ Catalog Manager. This is where you set permissions to Presentation Catalog items, including 
dashboards. For more information about Catalog Manager, see Chapter 7, “Managing Presentation 
Catalogs Using Oracle BI Catalog Manager.”

Differences Between Groups and Presentation Services Groups
Oracle Business Intelligence has both Groups and Presentation Services groups. Although similar, 
they do have some differences. Both types of groups are sets of security attributes that grant or deny 
privileges to sets of users. By grouping users together, you simplify the administration of these 
privileges:

■ Groups apply privileges to Oracle BI Server objects.

■ Presentation Services groups apply privileges to Oracle BI Presentation Services objects.

Your Security Goals in Oracle BI Presentation Services
Your main security goals are to make sure that:

■ Only appropriate people can log on and access Oracle BI Presentation Services. This is achieved 
by assigning logon rights and authenticating users through the Oracle BI Server. For more 
information about authentication, read “About Oracle BI Presentation Services User Authentication” 
on page 142.
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■ Employees can access only the data that is appropriate to them. This is achieved by applying 
access control in the form of permissions.

■ Employees have the ability to perform only actions that are appropriate to them. This is achieved 
by applying user rights in the form of privileges.

You can set up Oracle Business Intelligence to use the single sign-on feature from the Web server. 
Oracle BI Presentation Services can use this feature when obtaining information for end users. For 
complete information on single sign-on, refer to the section on user authentication support in the 
Oracle Business Intelligence Infrastructure Installation and Configuration Guide.

About Access Control and Permissions in Oracle BI Presentation 
Services
Access control defines the ability of an account to access a shared Presentation Catalog item. Catalog 
items are folders and requests, where folders are application folders, dashboard folders, and 
dashboard page folders.

An account is one of the following:

■ An individual user.

■ A Presentation Services group that has one or more users as members.

Permissions describe the type of access to an object that an account is permitted. Examples are Read 
and Full Control.

Each Presentation Catalog item has an access control list that defines which accounts have which 
permissions to access the item. The access control list is stored in the item’s corresponding attribute 
(.atr) file. An access control list has the general form shown in Table 14.

For more information about permissions, read “About Setting Oracle BI Presentation Services 
Permissions” on page 147.

About User Rights and Privileges in Oracle BI Presentation Services
Privileges are the actions that users have the right to perform in Oracle BI Presentation Services. 
Example privileges are “Edit system-wide column formats” and “Create iBots.”

Table 14. Access Control List for a Catalog Item

Account Permission

Presentation Services Group 1 Read

Presentation Services Group 3 Full Control

Presentation Services Group 8 Read

User 4 Read

User 9 Full Control

User 11 Full Control
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Privileges are managed by associating them with accounts, that is, individual users or Presentation 
Services groups. A specific account is either granted or denied a specific privilege. These associations 
are created in privilege assignment tables.

The general form of a privilege assignment table is shown in Table 15 on page 138. The Presentation 
Services groups in the right column are granted the privileges in the left column.

For more information about privileges, read “About Setting Oracle BI Presentation Services Privileges” 
on page 152.

About User Authentication in Oracle BI Presentation Services
Authentication is the process of using a username and password to identify a someone who is logging 
on. Authenticated users are then given appropriate authorization to access a system, in this case 
Oracle BI Presentation Services. Oracle BI Presentation Services does not have its own 
authentication system; it relies on the authentication system built into the Oracle BI Server.

For more information about authentication, read “About Oracle BI Presentation Services User 
Authentication” on page 142.

Types of Presentation Services Groups
Presentation Services groups are defined by the system or by an Oracle Business Intelligence 
administrator. When a user is assigned to a Presentation Services group, the user becomes a member 
of that group. Presentation Services group membership is used to determine the permissions and 
privileges that are associated with a user, either by explicit assignment or inheritance.

Presentation Services groups can also be thought of as roles for users because they avoid ambiguity 
about which defaults, preferences, and so on, to assign directly to the user.

This section contains the following topics:

■ “System-Defined Presentation Services Groups in Oracle BI Presentation Services” on page 139

■ “Administrator-Defined Presentation Services Groups in Oracle BI Presentation Services” on 
page 139

Table 15. Privilege Assignment Table

Privilege Accounts That Have Been Granted the Privilege

Privilege 1 Presentation Services Group 2, Presentation Services Group 4

Privilege 2 Presentation Services Group1, Presentation Services Group 3

Privilege 3 Presentation Services Group 1, user 3

Privilege 4 Presentation Services Group 1, user 1, user 4, user 6 

Privilege 5 Presentation Services Group 2, Web Group 3, user 4
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System-Defined Presentation Services Groups in Oracle BI 
Presentation Services
System-defined Presentation Services groups are preconfigured and required for successful Oracle 
BI Presentation Services operations. There are two types of system-defined Presentation Services 
groups:

■ Everyone. By default, all users belong to the Everyone group. This is why the group does not 
appear on the Groups and Users screen of the application.

■ Oracle BI Presentation Services Administrators. Members of the Oracle BI Presentation 
Services Administrators group are users who are Oracle BI Presentation Services administrators. 
The default member of this group is the Oracle BI Presentation Services Administrator. By 
default, only members of the Oracle BI Presentation Services Administrators group have access 
to administrative functions, but this can be changed by changing privilege assignments.

Administrator-Defined Presentation Services Groups in Oracle BI 
Presentation Services
Administrator-defined Presentation Services groups are created by the Oracle BI Presentation 
Services administrator. You can create an unlimited number of Presentation Services groups in Oracle 
BI Presentation Services.

NOTE: For organizations that have prebuilt applications, preconfigured groups are set up with 
preconfigured responsibilities. For more information, see the documentation for the application.

The Presentation Services groups that you define should be used to categorize users who require 
similar access to dashboards and content. You should plan your Presentation Catalog folder structure 
and Presentation Services groups together to create a coherent security model. For guidelines, read 
“Guidelines for Configuring Oracle BI Presentation Services Security for the Presentation Catalog and 
Dashboards” on page 161. For more information about how Presentation Services group membership 
can be passed from the Oracle BI Server, read “About Oracle BI Presentation Services User 
Authentication” on page 142.

Administering Presentation Services 
Groups
In Oracle BI Presentation Services Administration, you can use the Presentation Catalog Security: 
Groups and Users screen to:

■ Create a Presentation Services group

■ Delete a Presentation Services group or user from Oracle BI Presentation Services

■ Add a Presentation Services group or user to an existing group

■ Delete a Presentation Services group or user from an existing group

To access the Presentation Catalog Security: Groups and Users screen

1 Log in to Oracle BI Presentation Services.
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2 Choose Settings > Administration.

3 Click the Manage Presentation Catalog Groups and Users link.

To create a Presentation Services group

1 In the Existing Catalog Groups and Users area, click the Create a new Catalog Group link.

The Create Catalog Group screen appears.

2 Enter a name for the group in the Group Name field.

NOTE: If you leave the Group Name field empty, Oracle BI Presentation Services cannot create 
a Presentation Services group folder.

The name of the Presentation Services group must not match the name of any user who logs in 
to Oracle BI Presentation Services. This match is not case sensitive. For example, the user name 
FOO2 matches the Presentation Services group named foo2 or FoO2. If a user and a Presentation 
Services group share the same name, the user receives an Invalid Account message when 
attempting to log on to Oracle BI Presentation Services.

NOTE: If the name of an Oracle BI Server group (which is set up in the Oracle BI Administration 
Tool) matches the name of a Presentation Services group, members of the Oracle BI Server group 
automatically become members of the Presentation Services group when they log on to Oracle 
BI Presentation Services. Their membership ceases when they log off. The name of the user 
never appears to an Oracle BI Presentation Services administrator as a member of the 
Presentation Services group. If you prefer to use Presentation Services group names that match 
Oracle BI Server group names, but want users to be viewable as members of the group, with 
persistent group membership, you must explicitly add the users to the Presentation Services 
group using the Presentation Catalog Security: Groups and Users screen.

3 In the Dashboard Name field, type a name for the dashboard.

You can assign an existing dashboard to the Presentation Services group or create a new 
dashboard for the Presentation Services group. Whichever option you choose, all members of the 
Presentation Services group are granted Read access to the designated, default dashboard. If 
you do not want to create a dashboard now, you can create one later from the Manage 
Dashboards screen.

If you do create a new, empty dashboard, it is created within a new, like-named shared folder. 
Group members will have Read permission to this folder.

4 In the Dashboard Builder field, specify the names of the users or groups that are to have 
permission to change the contents of the dashboard. Separate multiple entries with a comma, 
for example, user1,salesgroup.

5 Click Finished.

NOTE: When you create a Presentation Services group and create a name for the group, Oracle BI 
Presentation Services creates a group folder in the Presentation Catalog. All members of the 
Presentation Services group have Read permissions to this folder. For manually created group 
folders, you should set the permissions to the Group folder for the appropriate groups to Read.
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To delete a Presentation Services group or user from Oracle BI Presentation 
Services

1 In the Existing Catalog Groups and Users area, in the Catalog Groups and Users table, locate the 
group or user and click the associated Delete icon.

To help you locate the group or user you want, you can:

■ Show only groups in the Catalog Groups and Users table by using the Show users and groups 
toggle

■ Search for a Presentation Services group or user to add using the Search field

2 Click Yes to confirm the delete.

3 Click Finished.

NOTE: This procedure does not delete any group definitions or any user definitions in an Oracle BI 
repository. If the user logs on again, his or her Oracle BI Presentation Services entry is recreated. 
To completely delete a user, delete the user’s folder using Catalog Manager. 

To add a Presentation Services group or user to an existing group

1 In the Existing Catalog Groups and Users area, in the Catalog Groups and Users table, locate the 
group that you want to add a Presentation Services group or user to and click the associated Edit 
icon.

To help you locate the group or user you want, you can:

■ Show only groups in the Catalog Groups and Users table by using the Show users and groups 
toggle

■ Search for a Presentation Services group or user to add using the Search field

The Edit Catalog Group screen appears.

2 In the Group Membership area, click the Add New Member link.

The Add Member to Group screen appears.

3 Locate the user or group to add and click the associated Add link.

The Edit Catalog Group screen appears.

The Group Membership area now shows the list of the current members of the group.

4 Click Finished.

To delete a Presentation Services group or user from an existing group

1 In the Existing Catalog Groups and Users area, in the Catalog Groups and Users table, locate the 
group that you want to delete a Presentation Services group or user to and click the associated 
Edit icon.

To help you locate the group or user you want, you can:

■ Show only groups in the Catalog Groups and Users table by using the Show users and groups 
toggle
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■ Search for a Presentation Services group or user to add using the Search field

The Edit Catalog Group screen appears.

2 In the Group Membership area, in the Members table, locate a member and click the Remove 
icon.

3 Click Finished.

NOTE: You cannot delete system-defined Presentation Services groups or the user name 
Administrator.

About Oracle BI Presentation Services 
User Authentication
When users log on, they are authenticated by the Oracle BI Server using the authentication method 
specified in the Oracle BI Server configuration file NQSConfig.INI. For more information about 
NQSConfig.INI, see Oracle Business Intelligence Infrastructure Installation and Configuration Guide.

This section briefly describes the authentication methods that are relevant to Oracle BI Presentation 
Services users, in the context of Oracle BI Presentation Services. It contains the following topics:

■ “Oracle Business Intelligence LDAP or ADSI Authentication” on page 142

■ “Oracle Business Intelligence External Table Authentication” on page 143

■ “Oracle Business Intelligence Database Authentication” on page 143

■ “Oracle Business Intelligence Internal Authentication” on page 143

For detailed information about authentication options, read Oracle Business Intelligence Server 
Administration Guide.

Oracle Business Intelligence LDAP or ADSI Authentication
If you are using LDAP or ADSI authentication to provide Oracle BI Server access control, you may 
also configure your LDAP or ADSI server to provide other security information. For example, you 
could configure the name that is displayed in the Welcome text when the user logs on to Oracle BI 
Presentation Services, and is specific to the Presentation Services groups to which the user belongs. 
This information is contained in LDAP variables, which are passed to the Oracle BI Server session 
variables during the process of user authentication.

The variable USER is a system session variable that is used with LDAP or ADSI authentication. 
Whenever users log on to Oracle BI Presentation Services, their usernames and passwords are 
passed to the LDAP or ADSI server for authentication. After successful authentication, other system 
or non-system session variables for each user can be populated from information returned by the 
LDAP or ADSI server.

For more information about session variables, read “About Presentation Services Groups and Session 
Variables” on page 143.
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Oracle Business Intelligence External Table Authentication
If you are using an external database table for authentication, the table can contain additional access 
control information. This includes the name that is displayed in the Welcome text when the user logs 
on to Oracle BI Presentation Services, and the Oracle BI Server group and the Presentation Services 
groups to which the user belongs.

Whenever users log in, their usernames and passwords are authenticated through SQL that queries 
this database table for authentication. After successful authentication, the results of this SQL query 
can be used to populate other system and non-system session variables for each user.

For more information about session variables, read “About Presentation Services Groups and Session 
Variables” on page 143.

Oracle Business Intelligence Database Authentication
The Oracle BI Server can authenticate users through database logons. When a user attempts to log 
on to Oracle BI Presentation Services, the Oracle BI Server attempts to use the logon name and 
password to connect to the authentication database, using the first connection pool associated with 
it. If this connection succeeds, the user is considered to be authenticated successfully.

Database authentication provides no mechanism to return additional access control information, 
such as the user’s display name or Presentation Services group membership. If you are using 
database authentication, alone or in conjunction with external table authentication, you need to 
explicitly add users to the appropriate Presentation Services group.

NOTE: Delivers does not work with database authentication. For more information, read “About 
Delivers iBots and Impersonation” on page 67.

Oracle Business Intelligence Internal Authentication
The Oracle BI Server internal authentication method has no way to return additional access control 
information. If you are using Oracle BI Server internal authentication, you need to explicitly add 
users to the appropriate Presentation Services group, because the GROUP variable is not used with 
internal authentication.

About Presentation Services Groups and 
Session Variables
If the Oracle BI Server is using an external table or LDAP server for authentication, you must 
configure system session variables in the repository.

A session variable block contains the SQL statement that is issued when each session begins. This 
block can contain system session variables with fixed meanings (such as USER, GROUP, 
DISPLAYNAME, and WEBGROUP) and other non-system session variables unique to your particular 
environment. For more information about using session variables, read Oracle Business Intelligence 
Server Administration Guide.
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You should also create a Presentation Services group to match each possible value returned in the 
GROUP or WEBGROUPS variable for which you want to control privileges and permissions to Oracle 
BI Presentation Services components and requests.

This section contains the following topics:

■ “About the Oracle Business Intelligence GROUP Session Variable” on page 144

■ “About the Oracle Business Intelligence WEBGROUPS Session Variable” on page 144

■ “Setting Permissions and Privileges in Oracle BI Presentation Services” on page 144

About the Oracle Business Intelligence GROUP Session Variable
The GROUP variable contains one or more group names, separated by semicolons, that are also used 
by the Oracle BI Server for security and content filtering. In many cases, these same groups are 
sufficient to control access to Oracle BI Presentation Services content. Prebuilt applications have 
been preconfigured to use this GROUP variable technique to inherit group memberships from the 
Oracle BI Server.

About the Oracle Business Intelligence WEBGROUPS Session Variable
The WEBGROUPS session variable has greater flexibility, because you can define Presentation 
Services groups that categorize the roles, or classes, of Oracle BI Presentation Services users. For 
example, you might create the following groups:

■ A Basic group that can only access the dashboard.

■ A Standard group that has minimal access to Answers.

■ A Power Users group that has full access to Answers and minimal access to iBots (Delivers).

■ An Administrative group with full access to all features.

Then use the privileges settings to set up the appropriate policies for each group. Keep in mind that 
each user can be associated with multiple “roles” by being a member of multiple Presentation 
Services groups.

Setting Permissions and Privileges in Oracle BI Presentation Services
When you have set up the Presentation Services groups, create a Presentation Catalog folder 
structure and assign appropriate privileges and permissions to each group. Keep in mind that each 
user can be associated with multiple roles by being a member of multiple Presentation Services 
groups. Although WEBGROUPS can be used to control access to Presentation Catalog content 
(permissions), usually GROUP controls content and WEBGROUPS controls the ability to perform 
actions (privileges).

NOTE: Some GROUPs may not have corresponding Oracle BI Presentation Services content. In this 
case, when you create the group, you can delete the group folder created for the group in the /
Shared folder, and give the group permission to the other group folders and subject area folders as 
appropriate.

For more information about the sequence in which to set up security, read “Guidelines for Configuring 
Oracle BI Presentation Services Security for the Presentation Catalog and Dashboards” on page 161.



Managing Oracle BI Presentation Services Security ■ Inheritance of Oracle BI
Presentation Services Permissions and Privileges

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

145

For more information about permissions, read “About Setting Oracle BI Presentation Services 
Permissions” on page 147.

For more information about privileges, read “About Setting Oracle BI Presentation Services Privileges” 
on page 152.

Inheritance of Oracle BI Presentation 
Services Permissions and Privileges
Permissions and privileges can be assigned to users directly or through membership in groups. From 
another perspective, permissions and privileges can be assigned explicitly or effectively. Effective 
permissions and privileges are assigned indirectly through Presentation Services group inheritance, 
which is the recommended way to set up your security. Permissions and privilege inheritance occurs 
when one Presentation Services group is a member of another Presentation Services group.

This section contains the following topics:

■ “Rules for Inheritance in Oracle BI Presentation Services” on page 145

■ “Example of Inherited Privileges in Oracle BI Presentation Services” on page 146

Rules for Inheritance in Oracle BI Presentation Services
■ Any permissions or privileges given explicitly to a user override any permissions or privileges 

inherited from the Presentation Services group to which the user belongs.

■ If a user belongs to two groups and both groups are assigned permissions, the least restrictive 
permissions are given to the user.

For example, if one group allows Read access and another allows Change access, the least 
restrictive access would be granted; in this example, Change access.

NOTE: The exception to this is if one of the two groups is explicitly denied the permissions, in 
which case the user is denied.

■ If a user belongs to Presentation Services group X, and Presentation Services group X belongs 
to Presentation Services group Y, any rule assigned to group X overrides any rule assigned to 
group Y.

For example, if Marketing has Read permissions, Marketing Administrators, which is a member 
of Marketing, can have Full Control permissions.

■ Explicitly denying access takes precedence over any other permissions or privileges.

When assigning permissions or privileges it often useful to look at resolved permissions for users and 
groups at the bottom of the screen to make sure that everyone is inheriting correctly.
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Example of Inherited Privileges in Oracle BI Presentation Services
Figure 1 shows an example of how privileges are inherited through Presentation Services groups.

In this example:

■ User1 is a direct member of Group 1 and Group 2, and is an indirect member of Group 3, Group 
4, and Group 5.

■ The permissions and privileges from Group 1 are no access to DashboardA, Read access to 
DashboardB, and Full Control over DashboardC.

■ If permissions and privileges are conflicting, the least restrictive level of authority is granted. 
Therefore, the inherited permissions and privileges from Group 2 include Change and Delete 
access to DashboardD.

■ Specifically prohibiting access always takes precedence over any other settings. Therefore, 
Group 1’s denial of access to DashboardA overrides Group 4’s Read access. The result is that 
Group 1 provides no access to DashboardA. Likewise, Group 5 provides no access to DashboardE 
because access to it is explicitly denied in Group2.

The total permissions and privileges granted to User1 are as follows:

■ No access to DashboardA and DashboardE because access is specifically denied.

■ Read access to DashboardB.

■ Full Control over DashboardC.

Figure 1. Example of Presentation Services Group Privilege Inheritance
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■ Change and Delete access to DashboardD.

TIP: Do not add the default Everyone Presentation Services groups to any other Presentation 
Services groups that you create. This makes sure that only the desired Presentation Services groups 
(and users) have the specified permissions and privileges, by preventing users or authenticated 
users from unintentionally inheriting permissions and privileges from another Presentation Services 
group.

About Setting Oracle BI Presentation 
Services Permissions
Permissions are used to control access to shared information contained in:

■ Presentation Catalog items

■ Dashboards

Permissions, which may be explicitly set or inherited, are configured from:

■ The Oracle BI Presentation Services Administration screen

■ Catalog Manager 

For more information about Catalog Manager, see Chapter 7, “Managing Presentation Catalogs 
Using Oracle BI Catalog Manager.”

You can set permissions from the level of the application all the way down to individual requests in 
either Oracle BI Presentation Services or the Presentation Catalog.

This section contains the following topics:

■ “Types of Permissions in Oracle BI Presentation Services” on page 147

■ “Recommendations for Setting Permissions in Oracle BI Presentation Services” on page 148

Types of Permissions in Oracle BI Presentation Services
Oracle BI Presentation Services supports the following permissions:

■ Change/Delete. Authority given to view content, and make changes or delete the content.

■ Full Control. Authority given to view content, make changes or delete the content, set 
permissions, and delete the item, folder, or dashboard.

■ No Access. Access is not allowed for this user or group. Explicitly denying access takes 
precedence over any other permission.

■ Read. Authority given to view the contents of the item, folder or dashboard, but cannot make 
any changes.

■ Traverse Folder. Authority to access objects in folders within the selected folder when the user 
does not have permission to the selected folder. Example: The user is granted Traverse Folder 
permission to the /shared/test folder. The user cannot access objects in the /shared/test folder, 
but can access objects stored in lower-level folders, such as /shared/test/guest.
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Recommendations for Setting Permissions in Oracle BI Presentation 
Services
Follow these recommendations when setting permissions:

■ Assign permissions through Presentation Services group membership, even if you want to assign 
permissions for a single user. For more information, read “Types of Presentation Services Groups” 
on page 138.

■ Set the permission to the Group folder for the appropriate groups to Read.

■ For groups (or users, if necessary) that are going to be modifying the dashboards and dashboard 
content accessible to the group, set the permissions for the group to Full Control. This is often a 
dashboard or content builder group. While allowing change and delete control, Full Control also 
allows the specified group (or user) to set permissions, and to delete the item, folder, or 
dashboard.

If you plan to have numerous or varying users creating and modifying dashboard content for a 
given group, create a separate, corresponding “builder” group that has all the back-end 
permissions of the primary group, but with a different name. For example, you could create a 
Sales group and a SalesBuilder group. By giving the SalesBuilder group appropriate permissions 
to the Presentation Catalog, you can control and change who can make changes to dashboards 
and content. Assuming session variable security is in place, you could make a user a dashboard 
builder or content creator by changing the user’s group from “Sales” to “SalesBuilder” in the 
database table that holds security information.

■ For each Subject Area, grant Read permissions to the corresponding Subject Area folder within 
the Requests folder (and everything it contains). Make sure that the Everyone group has no 
access permission to the Subject Area folder.

■ For groups that should be able to save requests for public use against a given Subject Area, grant 
them Full Control to the Subject Area folder and everything it contains, and likewise for the 
Common folder. For more information on setting permissions, see “Setting Permissions in Oracle 
BI Presentation Services Administration” on page 150.

■ To make sure that only members of the designated Presentation Services groups (or users) have 
access to Presentation Catalog folders, folder content, and Dashboards, do not set explicit 
permissions for the default Presentation Services group Everyone.

NOTE: Oracle BI Presentation Services does not allow you to remove permissions for yourself or for 
the administrator. This prevents you from locking yourself out of an item, folder, or dashboard.

TIP: To provide a place for all users within a group to share requests with each other, create a folder 
under the Subject Area folder called, for example, Share or Publish, and give the entire group 
Change/Delete permission to just that folder.

Overview of the Oracle BI Presentation 
Services Administration Screen
The Oracle BI Presentation Services Administration screen contains the following sections:
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■ Product Information. This section provides information about your current installation, such 
as the product version in use, the path to the current Presentation Catalog, and a link to a list of 
features licensed by your organization.

In Windows, the following information also is shown:

❏ Available Paging Memory. The amount of physical memory remaining plus any paging 
memory remaining

❏ Available Virtual Address Space. The amount of virtual address space remaining to 
process

(If either of these values is very low, then Oracle BI Presentation Services may run out of 
memory.)

■ Activities. This section provides links to administrative functions. Table 16 lists and describes 
the links in the Activities section.

NOTE: The Activities section may also contain links for other Siebel applications from Oracle that 
your organization has licensed, such as Oracle’s Siebel onDemand or Siebel Marketing. Such links 
are not listed in Table 16. For information about an application-specific link, click Help (if present) on 
the screen that opens when you click the link, or consult the administrator documentation for the 
application.

Table 16. Description of Links in the Activities Section in Oracle BI Presentation Services 
Administration

Link Description

Manage Presentation 
Catalog Groups and 
Users

Opens the Presentation Catalog Security: Groups and Users screen, where 
you can control access to Oracle BI Presentation Services for both 
Presentation Services groups and individual users.

Manage Presentation 
Catalog

Opens the Manage Catalog screen, where you can edit, rename, set 
permissions for, and delete folders and items in the Presentation Catalog. 
This feature can also be accessed by clicking the Manage Catalog button in 
the left pane in Answers.

Manage Interactive 
Dashboards

Opens the Manage Dashboards screen, where you can administer 
dashboard security. Depending on the level of authority granted to you 
based on the user name you log on with, you can use this screen to create 
and delete dashboards, and access the screens to change user and group 
permissions to dashboards and to change the properties of dashboards.

Manage Sessions Opens the Session Management screen, where you can manage active 
sessions, such as canceling running requests and viewing the log file 
NQQuery.log for information about a request.

Manage iBot 
Sessions

Opens the iBot Session Management screen, where you can view 
information about currently active iBot sessions.
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Setting Permissions in Oracle BI 
Presentation Services Administration
Using the Change Item Permissions screen in Oracle BI Presentation Services Administration, you 
can, for Presentation Catalog items such as dashboards, dashboard pages, folders, and so on:

■ Change the explicit permissions granted to Presentation Services groups and users 

■ Add explicit permissions for Presentation Services groups and users

Manage BI Publisher Opens the Oracle Business Intelligence Publisher Administration URL, 
where you can manage BI Publisher users, permissions, jobs, and files and 
folders.

(The BI Publisher Administration URL is set in the AdvancedReporting/
AdminURL element in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml).)

For more information about Oracle BI Publisher, see Oracle Business 
Intelligence Publisher User's Guide.

Manage Privileges Opens the Privilege Administration screen, where you can manage 
privileges and rights for both Presentation Services groups and individual 
users to various Oracle BI Presentation Services features and functions. 

Manage Device 
Types

Opens the Manage Device Types screen, where you can manage device 
types for device categories supported by Delivers.

Issue SQL Opens the Issue SQL Directly screen, where you can enter an SQL 
statement to be issued directly to the Oracle BI Server. This feature is 
useful for testing the server only. Results are not formatted, and it is not 
possible to save the SQL issued here as a request. 

Toggle Maintenance 
Mode

Toggles Maintenance Mode on and off. (When Maintenance Mode is on, 
users cannot write to the Presentation Catalog.)

Reload Files and 
Metadata

Reloads XML message files, refreshes server metadata, and clears Oracle 
BI Presentation Services caches.

Table 16. Description of Links in the Activities Section in Oracle BI Presentation Services 
Administration

Link Description
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To access the Change Item Permissions screen
■ Follow the appropriate steps for the item for which you want to set permissions: 

To change explicit permissions

1 In the Users and groups with explicit access to this item table:

■ If you want to change the permission granted to a Presentation Services group or user, click 
the permission associated with the Presentation Services group or user and toggle to the 
permission that you want. 

The toggle proceeds in a ring from No Access > Traverse Folder > Read > Change/
Delete > Full Control.

■ If you want to remove the explicit permission, click the Remove permissions for user/group 
icon associated with the Presentation Services group or user.

2 Click the Replace permissions with parent folder’s permissions link, if appropriate.

3 Select one or both of the following options, as appropriate:

■ Apply permissions to sub-folders

To access the Change Permissions 
screen for: Do this:

A dashboard 1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Interactive Dashboards link.

4 Click the Permissions icon associated with the 
dashboard whose permissions you want to change.

A dashboard page 1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Interactive Dashboards link.

4 Select a dashboard and click Properties.

5 In the Dashboard Pages area, click the Page Security 
icon associated with the dashboard page whose 
permissions you want to change.

Any other Presentation Catalog item 1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Presentation Catalog link.

4 Click the Permissions icon associated with the item 
whose permissions you want to change. Note that 
you may need to click a folder link and drill down to 
the item.
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■ Apply permissions to items within folder

4 Click Finished.

To add explicit permissions

1 In the Additional groups Add Explicit Permissions table, locate the Presentation Services group 
or user for whom you want to assign explicit permissions to the item and click the associated Add 
link.

To help you locate the group or user you want, you can:

■ Show only users in the Additional groups Add Explicit Permissions table, by using the Show 
users and groups toggle

■ Search for a Presentation Services group or user to add using the Search field

■ Show effective (that is, inherited) permissions in the Additional groups Add Explicit 
Permissions table by selecting the Show effective permissions checkbox.

2 (Optional) In the Users and groups with explicit access to this item table, toggle to the type of 
permission you want to assign to the group or user you just added.

3 Click Finished.

About Setting Oracle BI Presentation 
Services Privileges
Privileges are the actions that users have the right to perform in Oracle BI Presentation Services. 
They are managed by associating them with accounts, that is, individual users or Presentation 
Services groups. A specific account is either granted or denied a specific privilege. These associations 
are created in privilege assignment tables.

Like permissions, privileges are either explicitly set or inherited through group membership. 
Explicitly denying a privilege takes precedence over any granted, inherited privilege. For example, if 
a user is explicitly denied access to the privilege to edit column formulas in Answers, but is a member 
of a group that has inherited the privilege, the user cannot edit column formulas.

Unlike permissions, privileges are more commonly granted to the Everyone system Presentation 
Services group. This allows users access to common Oracle BI Presentation Services features and 
functions.

For a list of some Oracle BI Presentation Services privileges, read “Default Oracle BI Presentation 
Services Privilege Assignments” on page 154.

Setting Privileges in Oracle BI 
Presentation Services Administration
Using the Change Privilege Permissions screen in Oracle BI Presentation Services Administration, you 
can:



Managing Oracle BI Presentation Services Security ■ Setting Privileges in Oracle BI
Presentation Services Administration

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

153

■ Change a user’s or group’s explicit access to a privilege 

■ Add explicit access to a privilege to a user or group

To access the Change Privilege Permissions screen

1 Log in to Oracle BI Presentation Services.

2 Choose Settings > Administration.

3 Click the Manage Privileges link to display the Privilege Administration screen.

4 Click the link for the users and groups associated with the privilege for which you want to change 
explicit access. 

To change explicit access to a privilege

1 In the Users and groups with explicit access to this Privilege table:

■ If you want to change the access to a privilege for a Presentation Services group or user, click 
the permission associated with the Presentation Services group or user and toggle to the 
permission that you want - either Granted or Denied. 

■ If you want to remove the explicit permission, click the Remove permissions for user/group 
icon associated with the Presentation Services group or user.

2 Click Finished.

To add explicit access to a privilege

1 In the Additional groups Add Explicit Permissions table, locate the Presentation Services group 
or user whom you want to assign explicit access to the privilege and click the associated Add link.

To help you locate the group or user you want, you can:

■ Show only users in the Additional groups Add Explicit Permission table, by using the Show 
users and groups toggle

■ Search for a Presentation Services group or user to add using the Search field

■ Show effective (that is, inherited) permissions in the Additional groups Add Explicit 
Permission table by selecting the Show effective permissions checkbox.

2 (Optional) In the Users and groups with explicit access to this Privilege table, toggle to the 
permission you want to assign to the group or user you just added.

3 Click Finished.

NOTE: By default, a user who creates an item has the permission to change it. However, in some 
cases, this privilege should be disabled. Make the appropriate changes to deny the target user or 
group access to the Admin: Catalog Change Permissions privilege.
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Default Oracle BI Presentation Services 
Privilege Assignments
Table 17 lists some privileges that can be controlled, along with the Presentation Services group that 
is granted access to that privilege by default.

These privileges apply to the Oracle Business Intelligence infrastructure. If your organization uses 
prebuilt applications, some privileges may be preconfigured. For more information, see the 
documentation for the application.

NOTE: The Privilege Administration screen may also contain privileges for other Siebel applications 
from Oracle that your organization has licensed, such as Oracle’s Siebel Marketing. Presentation 
Services groups granted permission to application-specific components have descriptive names, such 
as Marketing Analytics User. For information about application-specific privileges, read the 
administrator documentation for the application.

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission

Access Access to Dashboards Everyone

Access to Answers Everyone

Access to Delivers Everyone

Access to Briefing Books Everyone

Access to Disconnected 
Analytics

Everyone

Access to Administration Presentation Services 
Administrators

Access to Segments Everyone

Access to Segment Trees Everyone

Access to List Formats Everyone

Access to Oracle BI 
Publisher Enterprise

Shows the More Products 
> BI Publisher link, which 
lets users launch BI 
Publisher. 

For more information 
about Oracle BI Publisher, 
see Oracle Business 
Intelligence Publisher 
User's Guide.

Everyone
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Admin: 
Catalog

Change Permissions Everyone

Toggle Maintenance Mode Everyone

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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Admin: 
General

Manage Sessions Presentation Services 
Administrators

Manage Dashboards Presentation Services 
Administrators

See Session IDs Presentation Services 
Administrators

Issue SQL Directly Presentation Services 
Administrators

View System Information Presentation Services 
Administrators

Performance Monitor Presentation Services 
Administrators

Manage iBot Sessions Presentation Services 
Administrators

Manage Device Types Shows the Manage Device 
Types link on the Oracle BI 
Presentation Services 
Administration screen, 
which opens the Manage 
Device Types screen. 

Presentation Services 
Administrators

Manage Marketing Jobs Presentation Services 
Administrators

Manage Marketing 
Defaults

Presentation Services 
Administrators

Manage BI Publisher Shows the Manage BI 
Publisher link on the 
Oracle BI Presentation 
Services Administration 
screen, which opens the 
Oracle Business 
Intelligence Publisher 
Administration URL.

For more information 
about Oracle BI Publisher, 
see Oracle Business 
Intelligence Publisher 
User's Guide.

Presentation Services 
Administrators

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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Admin: 
Security

Manage Catalog Groups 
and Users

Presentation Services 
Administrators

Manage Privileges Presentation Services 
Administrators

Take Ownership of Catalog 
Objects

Presentation Services 
Administrators

Briefing Book Add To or Edit a Briefing 
Book

Everyone

Download Briefing Book Everyone

Catalog Personal Storage (My 
Folders and My 
Dashboard)

Everyone

Reload Metadata Presentation Services 
Administrators

See Hidden Items Everyone

Create Folders Everyone

Archive Catalog Presentation Services 
Administrators

Dashboards Save Selections Everyone

Assign Default Selections Everyone

Formatting Save system-wide column 
formats

Presentation Services 
Administrators

My Account Access to My Account Everyone

Change Preferences Everyone

Change Delivery Options Everyone

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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Answers Create Views Everyone

Create Prompts Everyone

Access Advanced Tab Everyone

Edit column formulas Everyone

Edit column filters Everyone

Enter XML and logical SQL Everyone

Edit Direct Database 
Requests

Presentation Services 
Administrators

Create advanced filters 
and set operations

Everyone

Save filters Everyone

Execute Direct Database 
Requests

Administrators

Delivers Retrieve delivery 
destinations for iBots 
(system call)

Presentation Services 
Administrators, 
Administrators

Create iBots Everyone

Publish iBots for 
subscription

Everyone

Deliver iBots to specific or 
dynamically determined 
users

Presentation Services 
Administrators, 
Administrators

Chain iBots Everyone

Chain iBots to custom 
scripts

Presentation Services 
Administrators, 
Administrators

See iBot Instance Errors Presentation Services 
Administrators, 
Administrators

Modify current 
subscriptions for iBots

Presentation Services 
Administrators, 
Administrators

Proxy Act As Proxy Administrators

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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RSS Feeds Access to RSS Feeds Grants the right to receive 
RSS feeds with alerts and 
contents of folders.

If the Oracle BI 
Presentation Services uses 
the HTTPS protocol, the 
RSS Reader that you use 
must also support the 
HTTPS protocol.

Everyone

Oracle BI 
Publisher 
Enterprise

For more 
information 
about Oracle 
BI Publisher, 
see Oracle 
Business 
Intelligence 
Publisher 
User's Guide.

Add BI Publisher Reports 
to Dashboard

Shows the BI Publisher 
Report object in the 
Dashboard Objects area 
on the Dashboard Editor 
screen, which allows 
dashboard developers to 
add BI Publisher reports to 
dashboard pages.

Everyone

View BI Publisher Reports Allows users to view BI 
Publisher reports on 
dashboard pages.

Everyone

Schedule BI Publisher 
Reports

Shows the Schedule 
button for BI Publisher 
reports on dashboard 
pages.

Everyone

Send BI Publisher Reports Shows the Send button for 
BI Publisher reports on 
dashboard pages.

Everyone

Analyze BI Publisher 
Reports

Shows the Analyze button 
for BI Publisher reports on 
dashboard pages.

Presentation Services 
Administrators, 
Administrators

List Formats Create List Formats Administrators

Create Headers and 
Footers

Administrators

Access Options Tab Administrators

Add/Remove List Format 
Columns

Administrators

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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Segmentation Create Segments Administrators

Create Segment Trees Administrators

Create/Purge Saved Result 
Sets

Administrators

Access Segment Advanced 
Options Tab

Administrators

Access Segment Tree 
Advanced Options Tab

Administrators

Change Target Levels 
within Segment Designer

Administrators

SOAP Access SOAP Everyone or 
Presentation Services 
Administrators, 
depending on the 
Subject Area

Subject Area 
(by its name)

Access within Answers Everyone

View Column 
Filter Prompt

Add/Edit Column Filter 
Prompt View

Everyone

View Column 
Selector

Add/Edit Column Selector 
View

Everyone

View 
Compound

Add/Edit Compound View Everyone

View Filters Add/Edit Filters View Everyone

View Funnel 
Chart

Add/Edit Funnel Chart 
View

Everyone

View Gauge Add/Edit Gauge View Everyone

View 
Dashboard 
Prompt

Add/Edit Dashboard 
Prompt View

Everyone

View Static 
Text

Add/Edit Static Text View Everyone

View Image Add/Edit Image View Everyone

View Legend Add/Edit Legend View Everyone

View Narrative Add/Edit Narrative View Everyone

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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Guidelines for Configuring Oracle BI 
Presentation Services Security for the 
Presentation Catalog and Dashboards
To set up a secure Presentation Catalog and secure dashboards, you must understand the 
information presented in the previous chapters, because you are working with Presentation Catalog, 
dashboards, and Presentation Services groups.

This section contains the following topics:

■ “Creating Presentation Services Groups” on page 162

■ “Setting Up the Presentation Catalog Structure” on page 162

View Nested 
Request

Add/Edit Nested Request 
View

Everyone

View No 
Results

Add/Edit No Results View Everyone

View Pivot 
Table

Add/Edit Pivot Table Everyone

View Create 
Segment

Add/Edit Create Segment 
View

Everyone

View Logical 
SQL

Add/Edit Logical SQL View Everyone

View Chart Add/Edit Chart View Everyone

View Table Add/Edit Table View Everyone

View Create 
Target List

Add/Edit Create Target List 
View

Everyone

View Ticker Add/Edit Ticker View Everyone

View Title Add/Edit Title View Everyone

View View 
Selector

Add/Edit View Selector 
View

Everyone

Write Back Write Back to Database Grants the right to write 
data into the database.

Administrators

Manage Write Back Grants the right to 
manage write back 
reports.

Presentation Services 
Administrators

Table 17. Privileges and Default Settings for the Oracle Business Intelligence Infrastructure

Component Privilege Description

Presentation 
Services Group 
Granted Permission
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■ “Setting Permissions to Presentation Catalog Items” on page 164

■ “Creating Shared Dashboards” on page 164

■ “Adding Shared Dashboards Pages and Content” on page 165

■ “Testing the Dashboards” on page 166

■ “Setting Up a Virtual Directory for Shared Oracle Business Intelligence Documents” on page 167

■ “Releasing Dashboards to the User Community” on page 167

Creating Presentation Services Groups
When you create a Presentation Services group, a shared Presentation Catalog group folder is 
automatically created. For more information about Presentation Services groups, read “Types of 
Presentation Services Groups” on page 138. For more information about the group folder, read “Setting 
Up the Presentation Catalog Structure” on page 162.

Setting Up the Presentation Catalog Structure
The Presentation Catalog has two main folders:

■ /Shared. Contains shared folders, shared dashboards, and shared dashboard content.

■ /User. Contains the personal storage and My Dashboards for each user.
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Figure 2 shows the recommended higher-level folder structure for the /Shared folder in the 
Presentation Catalog.

The Presentation Catalog structure shown in Figure 2 makes it easier for users and administrators to 
reorganize content and make shared dashboard sections available. This, in turn, facilitates My 
Dashboard creation by allowing users to select from shared content.

Items shown within brackets ( [ ] ) are optional. Items shown within angle brackets ( < ) should be 
replaced with the appropriate name.

Group Folder
When you create a Presentation Services group, the system automatically creates a shared folder for 
the group. All members of the Presentation Services group are automatically given Read permissions 
to this folder. These permissions are inherited by any subfolders that you create.

Figure 2. Recommended Structure for the /Shared Folder in Presentation Catalog
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Group folders hold shared dashboard content that pertains to only members of the Presentation 
Services group. Optionally, the shared content can be further organized into subfolders under the 
Group folder.

NOTE: You may want to remove this folder and grant group permissions to other folders if there is 
no group-specific content.

Common Folder
Dashboard sections that are shared across groups are saved in a Common folder under the /Shared 
folder. Content can be organized into subfolders under the Common folder.

Create only the Common and Requests subfolders under the /Shared folder.

Requests Folder
When you create requests in Answers that you want to share, save them in a Requests folder in the 
/Shared folder.

Create a folder for each subject area in the Requests folder for storing requests against that subject 
area. This allows you to manage permissions at the level of the subject area. If two or more subject 
areas are closely related, so that users with permission to one would almost always have permission 
to the other, you could create a single folder to store requests against both subject areas.

NOTE: If a user is given permission to a request in the Presentation Catalog that references a 
Subject Area to which the user does not have permission, the Oracle BI Server still prevents the user 
from executing the request.

In cases where you have requests that span subject areas (requests that involve SQL subqueries), 
you can put them in the folder for any of the subject areas, or create a new folder for users that have 
permission for these subject areas.

For more information about working with the Presentation Catalog, read Chapter 6, “Administering 
the Oracle BI Presentation Catalog.”

Setting Permissions to Presentation Catalog Items
Before setting permissions to the Presentation Catalog items you have created, review the 
information in “About Setting Oracle BI Presentation Services Permissions” on page 147.

Creating Shared Dashboards
After setting up the Presentation Catalog structure and setting permissions, you can create shared 
dashboards and content for reuse by others. If you did not specify a dashboard when creating a 
group, you can create one now, selecting the appropriate group folder.
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The advantage to creating shared dashboards is that sections that are created in the shared 
dashboard are actually shortcuts to folders in the /Shared folder. As such, you can remove them and 
add them again in a different column, page, or even a different dashboard. Users can create a My 
Dashboard from existing shared sections by clicking the Add Folder link and selecting the appropriate 
folder from the /Shared/Group or /Shared/Common folders in the Presentation Catalog.

If you plan to allow multiple users to modify the Presentation Services group’s default dashboard, 
consider putting these users into another group. For example, suppose you create a Presentation 
Services group called Sales and create a default dashboard called SalesHome. Of the 40 users that 
are members of the Sales group, suppose that there are three who need to have the ability to create 
and modify content for the SalesHome dashboard. Create a SalesAdmin group, with the same 
permissions as the primary Sales group. Add the three users who are allowed to make changes to 
the SalesHome dashboard and content to this new SalesAdmin group, and give this group the 
appropriate permissions to the Presentation Catalog. This allows them to create and modify content 
for the SalesHome dashboard. If a user no longer requires the ability to modify dashboard content, 
you can change the user’s group membership to Sales. If an existing Sales group member needs to 
have the ability to create dashboard content, the user’s group membership can be changed to 
SalesAdmin.

Dashboards are stored in a special folder, _portal, that is hidden (unless the option to show hidden 
items is checked when working with the Presentation Catalog). The hidden _portal folder is located 
directly underneath a group folder. Because the dashboard is contained in the Group folder, all the 
permissions you set to the group folder are inherited.

You can create multiple dashboards within a Group folder, each of which will have its own folder 
(named the same as the dashboard name you assign) within the /_portal folder. Underneath the 
specific dashboard folder, for example, /_portal/SalesGroup Dashboard, are folders that correspond 
to the pages you have created in the dashboard. Underneath the page folder are folders for the 
columns.

NOTE: Column folders are assigned names automatically by the system.

Within the column folders are the sections (folders or shortcuts to folders) that contain the items or 
shortcuts to items that appear in the dashboard.

For more information about creating shared dashboards, read “About Managing Dashboards” on 
page 77.

Adding Shared Dashboards Pages and Content
After you have created dashboards, you can add pages and content.

Adding Pages and Content
For information about adding pages and columns, read Oracle Business Intelligence Answers, 
Delivers, and Interactive Dashboards User Guide.
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Adding Sections
A section is a folder, or a shortcut to a folder, that appears within a dashboard. For the procedure for 
adding sections to a dashboard, read “Managing Dashboards” on page 78.

When adding requests from Answers to a section, do one of the following:

■ Include requests previously saved to the Subject Area folders.

■ Create a new request, save it in the appropriate Subject Area folder, and add it to the shared 
section using the Existing Request link.

This technique is preferred for several reasons. The permissions on the Subject Area folders filter 
requests from the dashboard from users that might have dashboard permission, but not 
permission to certain subject areas. You can refer to the same request in multiple dashboard 
sections, you can change it once, and have it reflected in all sections.

If you are working with content that is specific to a number of group folders, you might want to create 
a new folder directly underneath the /Shared folder to use, and set permissions to the new folder to 
Read for the appropriate groups.

Creating and Using Shared Items
In addition to creating shared sections, you can create other shared content that can be used within 
shared and My Dashboard sections. For example, you could create a library of images by creating a 
folder called "Images" in the /Shared/Common folder. Add this folder as a section in a dashboard - 
perhaps the "My Dashboard" of the Administrator (although it does not really matter because once 
you placed the images in the section you can remove it from the dashboard). Remember, it is a 
shared section, so the folder will still exist in the shared portion of the catalog. Edit the section and 
click the Image link to add each image that you want in the library.

NOTE: If you have a number of libraries that you want to make available to share, you might want 
to create folders within the /Common folder called /Sections and /Content or /Libraries, so it is easier 
to distinguish when using the common sections and content in other dashboards.

To use the shared content in a section of "My Dashboard," the user can simply edit the desired 
section, click the Item from Catalog link, navigate to the /Shared/Common/Images folder, and click 
the image to include.

This same mechanism should be used for any logos, images, scripts, links, copyrights, and so on, 
that are or might be used in more than one dashboard or dashboard section. This allows you to 
change the item in one location and have it immediately reflected in all dashboards.

Testing the Dashboards
Before releasing dashboards and content to the user community, perform some tests.
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To test the dashboard

1 Verify that users with appropriate permissions can correctly access it and view the intended 
content.

2 Verify that users without appropriate permissions cannot access the dashboard.

3 Verify that styles and skins are displayed as expected, and that other visual elements are as 
expected.

4 Correct any problems you find and test again, repeating this process until you are satisfied with 
the results.

Setting Up a Virtual Directory for Shared Oracle 
Business Intelligence Documents
Set up a virtual directory on the Web server for shared documents. Name the directory /
DashboardFiles and map it to a shared network directory of the same name.

This allows users with the appropriate permissions to publish files to this folder, and reference these 
files by their relative URL names rather than by their fully qualified network share names, for 
example, /DashboardFiles/AnnualReport.doc instead of 
\\SharedServer\CommonShare\DashboardFiles\AnnualReport.doc.

Releasing Dashboards to the User Community
After testing is complete, notify the user community that the dashboard is available, providing the 
relevant network address.

About Authorizing Users to Act for 
Others
You can authorize one user to act for another user in Oracle BI Presentation Services. When a user 
(called the proxy user) acts as another (called the target user), the proxy user can see the 
dashboards and reports of the target user. 

Authorizing a user to act for another is useful, for example, when a manager wants to delegate some 
of his work to one of his direct reports or when IT support staff wants to troubleshoot another user’s 
account.

When you authorize a user to be a proxy user, you also assign an authority level (called the proxy 
level). The proxy level determines the privileges and permissions granted to the proxy user when 
accessing the dashboards and reports of the target user. 

There are two proxy levels:
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■ Restricted. Permissions are read-only to the items to which the target user has access. 
Privileges are determined by the proxy user’s account (not the target user’s account).

For example, suppose a proxy user has not been assigned the Access to Answers privilege, and 
the target user has. When the proxy user is acting as the target user, he or she cannot access 
Answers.

■ Full. Permissions and privileges are inherited from the target user’s account.

For example, suppose a proxy user has not been assigned the Access to Answers privilege, and 
the target user has. When the proxy user is acting as the target user, he or she can access 
Answers.

Once you have authorized a user to act as a proxy user, he or she can then use the Settings > Act 
As option in Oracle BI Presentation Services to select the target user to act as.

TIP: Before a proxy user can act as a target user, the target user must have logged in to Oracle BI 
Presentation Services at least once and accessed his or her dashboard. (A default dashboard is 
created the first time the dashboard is displayed. This requires write privileges, which the proxy user 
may not have.)

Process of Authorizing Users to Act for 
Others
To authorize users to act for others, perform the following tasks:

■ Defining the Association Between Proxy Users and Target Users on page 168

■ Creating Session Variables for Proxy Functionality on page 169

■ Modifying the instanceconfig.xml File for Proxy Functionality on page 170

■ Creating a Custom Message Template for Proxy Functionality on page 170

■ Assigning the Proxy Privilege on page 173

Defining the Association Between Proxy Users and 
Target Users
This task is a step in Process of Authorizing Users to Act for Others on page 168.

You define the association between proxy users and target users in the database by identifying, for 
each proxy user/target user association, the:

■ ID of the proxy user

■ ID of the target user

■ Proxy level (either full or restricted)
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For example, you might create a table called Proxies in the database that looks like this:

After you define the association between proxy users and target users, you need to import the 
schema to the physical layer of the Oracle BI Server. For more information on importing a schema, 
see the Oracle Business Intelligence Server Administration Guide.

Creating Session Variables for Proxy Functionality
This task is a step in Process of Authorizing Users to Act for Others on page 168.

There are two session variables along with their associated initialization blocks that you create to 
authenticate proxy users:

For more information on creating session variables, see the Oracle Business Intelligence Server 
Administration Guide.

proxyId targetId proxyLevel

Ronald Edward full

Timothy Tracy restricted

Jeanne Natalie full

William Kelly restricted

Gail Michael restricted

Session Variable Associated Initialization Block

PROXY Initialization Block Name: ProxyBlock

Initialization String Example: 

select targetId 
from Proxies 
where ‘VALUEOF(NQ_SESSION.RUNAS)’=targetId and ‘:USER’=proxyId

(Note that you will need to modify this SQL according to the schema of your 
database.)

PROXYLEVEL 
(optional)

NOTE: If you do 
not create 
PROXYLEVEL, 
restricted access is 
assumed. 

Initialization Block Name: ProxyLevel

Initialization String Example: 

select proxyLevel 
from Proxies 
where ‘VALUEOF(NQ_SESSION.RUNAS)’=targetId and ‘:USER’=proxyId

(Note that you will need to modify this SQL according to the schema of your 
database.)
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Modifying the instanceconfig.xml File for Proxy 
Functionality
This task is a step in Process of Authorizing Users to Act for Others on page 168.

You can modify the Oracle BI Presentation Services configuration file (instanceconfig.xml) to specify 
the following information for proxy functionality:

■ The name of the custom message template in the Custom Messages folder that contains the SQL 
to:

■ Get the list of target users that a proxy user can act as

■ Verify whether the proxy user can act as the target user

■ Get the list of proxy users that can act as the target user

The default name is LogonParamSQLTemplate. 

For more information about the custom message template, see “Creating a Custom Message 
Template for Proxy Functionality” on page 170.

■ The maximum number of target users to be listed in the User box in the Act As dialog box. If the 
number of target users for a proxy user exceeds this value, an edit box, where the proxy user 
can type the ID of a target user, is rendered rather than a drop-down list of target users. 

The default is 200. 

You specify the name of the custom message template and the maximum number of target users in 
the <TemplateMessageName> and <MaxValues> elements, which appear between the 
<LogonParam> and</LogonParam> elements.

For example:

<LogonParam>

<TemplateMessageName>LogonParamSQLTemplate</TemplateMessageName>

<MaxValues>100</MaxValues>

</LogonParam>

NOTE: The name that you specify in the <TemplateMessageName> element must match the name 
that you specify in the <WebMessage> element in the custom message file. For more information, 
see “Creating a Custom Message Template for Proxy Functionality” on page 170.

Creating a Custom Message Template for Proxy 
Functionality
This task is a step in Process of Authorizing Users to Act for Others on page 168.

You need to create a custom message template for the proxy functionality that contains the SQL to: 

■ Get the list of target users that a proxy user can act as. This list appears in the User box in the 
Act As dialog box.
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■ Verify whether the proxy user can act as the target user.

■ Get the list of proxy users that can act as the target user. This list appears on the target user’s 
My Account screen.

In the custom message template, you place the SQL to retrieve this information in the following XML 
elements:

You can create the custom message template in one of the following files:

■ The custom message file in the SAROOTDIR\web\msgdb\customMessages folder, where 
SAROOTDIR is the installation directory

■ A separate XML file in the SAROOTDIR\web\msgdb\customMessages folder, where SAROOTDIR 
is the installation directory

To create the custom message template:

1 If you want to create the custom message template in the original custom message file:

a Make a backup of the original custom message file in a separate folder. 

b Make a development copy in a different folder and open it in a text or XML editor.

2 If you want to create the custom message template in a separate XML file, create and open the 
file in the SAROOTDIR\web\msgdb\customMessages folder, where SAROOTDIR is the installation 
directory.

Elements Description

<getValues>
</getValues>

Specifies the SQL to return the list of target users and 
corresponding proxy levels.

The SQL must return either one or two columns, where the:

■ First column returns the IDs of the target users

■ (Optional) Second column returns the names of the target 
users

<verifyValue>
</verifyValue>

Specifies the SQL to verify if the current user can act as the 
specified target user.

The SQL must return at least one row if the target user is valid 
or an empty table if the target user is invalid.

<getDelegateUsers>
</getDelegateUsers>

Specifies the SQL to get the list of proxy users that can act as 
the current user and their corresponding proxy levels.

The SQL must return either one or two columns, where the:

■ First column returns the names of the proxy users

■ (Optional) Second column returns the corresponding proxy 
levels
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3 Start the custom message template by adding <WebMessage> begin and end elements. For 
example:

<WebMessage name="LogonParamSQLTemplate">

</WebMessage>

NOTE: The name that you specify in the <WebMessage> element must match the name that you 
specify in the <TemplateMessageName> element in the Oracle BI Presentation Services 
configuration file (instanceconfig.xml). For more information, see “Modifying the 
instanceconfig.xml File for Proxy Functionality” on page 170.

4 After the <WebMessage> element:

a Add the <XML> and </XML> elements

b Between the <XML> and </XML> elements, add the <logonParam name="RUNAS"> and </
logonParam> elements

c Between the <logonParam name="RUNAS"> and </logonParam> elements, add each of the 
following elements along with its corresponding SQL:

❏ <getValues> and </getValues>

❏ <verifyValue> and </verifyValue>

❏ <getDelegateUsers> and </getDelegateUsers>

The following entry is an example:

<XML>

<logonParam name="RUNAS">

<getValues>select targetId 
from Proxies 
where proxyId='@{USERID}'</getValues>

<verifyValue>select targetId 
from Proxies 
where proxyId ='@{USERID}' 
and targetId='@{VALUE}'</verifyValue>

<getDelegateUsers>select proxyId, proxyLevel 
from Proxies 
where targetId ='@{USERID}'

</getDelegateUsers>

</logonParam>

</XML>

(Note that you will need to modify the example SQL according to the schema of your database.)

5 If you created the custom message template in the development copy of the original file, replace 
the original file in the customMessages folder with the newly edited file.

6 Test the new file.
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7 (Optional) If you created the custom message template in the development copy of the original 
file, delete the backup and development copies.

8 Load the custom message template by either restarting the server or clicking the Reload Files 
and Metadata link on the Oracle BI Presentation Services Administration screen. For more 
information on the Oracle BI Presentation Services Administration screen, see “Overview of the 
Oracle BI Presentation Services Administration Screen” on page 148.

Assigning the Proxy Privilege
This task is a step in Process of Authorizing Users to Act for Others on page 168.

For each user whom you want to authorize as a proxy user or for each Presentation Services group 
whose members you want to authorize as proxy users, you need to assign the Proxy privilege. For 
more information on how to assign privileges, see “Setting Privileges in Oracle BI Presentation Services 
Administration” on page 152.

Enabling User-Initiated Administration 
Actions
By default, users cannot change their own passwords or join Presentation Services groups. This is 
customizable, you can enable one or both of these privileges. This change affects your entire user 
community.

To enable user-initiated administration actions

1 Stop WWW, Web server, and Oracle Business Intelligence services.

2 Copy \SAROOTDIR\web\msgdb\messages\controlmessages.xml to 
\SAROOTDIR\web\msgdb\customMessages\controlmessages.xml, where SAROOTDIR is the 
installation directory.

3 Open the copied file with a text editor.

4 To enable users to join Presentation Services group, do the following:

a Find the following configuration key:

<WebMessage name="kmsgJoinGroupLink"><!--<HTML><A insert="1"><MessageRef 
name="kmsgUIJoinGroup"/></A></HTML> --></WebMessage>

b Edit it as follows:

<WebMessage name="kmsgJoinGroupLink"><HTML><A insert="1"><MessageRef 
name="kmsgUIJoinGroup"/></A></HTML></WebMessage>

This edit removes “<!--” and “-->” from the key. These two phrases disable the feature.

5 To enable users to change passwords, do the following:

a Find the following configuration key:
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<WebMessage name="kmsgChangePasswordLink"><!--<HTML><A insert="1"><MessageRef 
name="kmsgUIChangePassword"/></A></HTML> --></WebMessage>

b Edit it as follows:

<WebMessage name="kmsgChangePasswordLink"><HTML><A insert="1"><MessageRef 
name="kmsgUIChangePassword"/></A></HTML></WebMessage>

This edit removes “<!--” and “-->” from the key. These two phrases disable the feature.

6 Save the edited file.

7 Restart the Oracle BI Server, Web server, and WWW services in that order.
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9 Using Oracle BI Presentation 
Services Logging

Oracle BI Presentation Services includes a logging facility that logs information that can be used to 
troubleshoot problems. This logging facility is also highly configurable. This chapter describes the 
configuration parameters for the logging facility, and provides information about Oracle BI 
Presentation Services log files.

This chapter contains the following sections:

■ Using the Oracle BI Presentation Services Logging Facility on page 175

■ Oracle BI Presentation Services Configuration File Structure on page 176

■ Oracle BI Presentation Services Message Structure on page 183

■ Oracle BI Presentation Services Logging Levels on page 185

■ Oracle BI Presentation Services Log Filters on page 186

See also Technical Note 519, available on Siebel SupportWeb.

Using the Oracle BI Presentation 
Services Logging Facility
By default, Oracle BI Presentation Services is configured to log all error events and informational and 
warning events of sufficient importance. An example of an important informational event would be 
a server starting up or a server shutting down. Log files are named sawlogxx.log, where the xx is 
replaced by an incremented number.

To debug specific issues that a user may be encountering, the logging level can be increased to log 
more information than the default configuration. For example, while debugging a particular Oracle 
BI Presentation Services connectivity issue, it might be useful to increase the maximum logging on 
the saw.odbc log source only. This adds detailed logging for that component, without cluttering the 
log with detailed logging from other events. Another example is to create a new log writer that 
records only chart events. For an illustration of this example, see Figure 5 on page 178.

CAUTION: Do not increase the logging on a production implementation, except to diagnose specific 
issues. Logging affects performance.

All Oracle BI Presentation Services configuration information is loaded from the file logconfig.xml, 
located in the following directory (based on operating system platform):

■ Windows:

SADATADIR/web/config

■ UNIX:

SADATADIR/web/config
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where SADATADIR is the Oracle BI Presentation Services data directory. 

Oracle BI Presentation Services 
Configuration File Structure
The structure of the configuration XML file is shown in Figure 3. The cardinality of each node is shown 
in brackets.

Figure 3. Structure of a logconfig.xml File

 
 
Config 
Default  [1..1] 
    Writers  [0..1] 
        Writer  [0..1] 
            Filters  [0..1] 
                FilterRecord  [0..n] 
    WriterClassGroups  [0..1] 
        WriterClassGroup  [0..n] 
    Filters  [0..1] 
        FilterRecord  [0..n] 
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An example of a logconfig.xml file that has four writers is shown in Figure 4.

Figure 4. Example of a logconfig.xml File with Four Writers

<?xml version="1.0" ?>  
<Config> 
    <Default> 
    <Writers> 
        <Writer implementation="FileLogWriter" name="Global File Logger" 

writerClassId="1" dir="{%SADATADIR%}/web/log" filePrefix="sawlog" 
maxFileSizeKb="10000" filesN="10" /> 

        <Writer implementation="CoutWriter" name="Global Output Logger" 
writerClassId="2" /> 

        <Writer implementation="EventLogWriter" name="Event Logger" 
writerClassId="3" /> 

        <Writer implementation="CrashWriter" name="CrashWriter" writerClassId="4" 
/> 

    </Writers> 
    <WriterClassGroups> 
        <WriterClassGroup name="All">1,2,3,4</WriterClassGroup> 
        <WriterClassGroup name="File">1</WriterClassGroup> 
        <WriterClassGroup name="Cout">2</WriterClassGroup> 
        <WriterClassGroup name="EventLog">3</WriterClassGroup> 
        <WriterClassGroup name="Crash">4</WriterClassGroup> 
    </WriterClassGroups> 
    <Filters> 
        <FilterRecord writerClassGroup="Cout" path="saw" information="31" 

warning="41" error="41" security="41" />  
        <FilterRecord writerClassGroup="File" path="saw" information="31" 

warning="100" error="100" security="41" /> 
        <FilterRecord writerClassGroup="File" path="saw.mktgsqlsubsystem.joblog" 

information="41" warning="100" error="100" security="41" />  
        <FilterRecord writerClassGroup="File" path="saw.httpserver.request" 

information="51" warning="100" error="100" security="41" />  
        <FilterRecord writerClassGroup="File" path="saw.httpserver.response" 

information="51" warning="100" error="100" security="41" /> 
    </Filters> 
    </Default> 
</Config> 
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An example of a logconfig.xml file that has one writer set up to record charting events is shown in 
Figure 5.

Figure 5. Example of a logconfig.xml File with ChartLogger Writer

<Config> 
<Default> 
 <Writers> 
 <Writer implementation="FileLogWriter" name="Global File Logger" writerClassId="1"  
 dir="{%SADATADIR%}/web/log" filePrefix="sawlog" maxFileSizeKb="10000" 

filesN="10" /> 
 <Writer implementation="CoutWriter" name="Global Output  Logger" 

writerClassId="2"/> 
 <Writer implementation="EventLogWriter" name="Event  Logger" writerClassId="3" />
 
 <!-- New log writer dedicated for charts --> 
 <Writer implementation="FileLogWriter" name="Chart Logger" 

writerClassId="4"  
 dir="{%SADATADIR%}/web/log/chart" filePrefix="sawlog" 

maxFileSizeKb="10000" filesN="10" /> 
 </Writers> 
 <WriterClassGroups> 
 <WriterClassGroup name="All">1,2,3,4</WriterClassGroup> 
 <WriterClassGroup name="File">1</WriterClassGroup> 
 <WriterClassGroup name="Cout">2</WriterClassGroup> 
 <WriterClassGroup name="EventLog">3</WriterClassGroup> 
 <WriterClassGroup name="Chart">4</WriterClassGroup> 
 </WriterClassGroups> 
 <Filters> 
 <FilterRecord writerClassGroup="Cout" path = "saw" information="31" warning="41" 

error="41" security="41"/> 
 <FilterRecord writerClassGroup="File" path = "saw" information="31" warning="100" 

error="100" security="41"/> 
 <FilterRecord writerClassGroup="File" path = "saw.mktgsqlsubsystem.joblog" 

information="41" warning="100" error="100" security="41"/> 
 <!-- Logs all chart events, including minor informational events --> 
 <FilterRecord writerClassGroup="Chart" path = "saw.charts" 

information="100" warning="100" error="100" security="100"/> 
 <FilterRecord writerClassGroup="Chart" path = "saw.views.chart" 

information="100" warning="100" error="100" security="100"/> 
 </Filters> 
</Default> 
</Config> 
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A description of each node in the configuration hierarchy is shown in Table 18.

Table 18. Oracle BI Presentation Services Log Configuration File Elements

Element Attribute Description

Writers Contains writers configuration.

This configuration is loaded on startup.

Writer Configures a writer. 

implementation Name of the C++ class that implements the 
writer.

The following implementations are defined:

■ FileLogWriter. Writes to a disk file.

■ CoutWriter. Writes to standard output.

■ EventLogWriter. Writes to Windows event log 
or UNIX syslog.

■ CrashWriter. Writes to a crash dump file when 
the Oracle BI Presentation Services attempts 
to log from a specific source file and line 
number.

■ Used in a production environment for 
information of some loggable but non-
fatal error (for example, failed NQTEST).

■ On Windows, CrashWriter requires 
appropriate version of dbghelp.dll (at 
least 6.0.17.0). 
The correct dbghelp.dll is found in 
support/windows/system32. 
Put this DLL in the WINNT/system32 or in 
the main/bin directory. 
No registration is required.

name Unique name for the writer.

writerClassId Integer number in the range 1-10. This number is 
used by filters to allow or prohibit logging.

Each distinct writer must have a unique value, 
which is used later for filter configuration.

Different writers may have the same class ID, but 
if they do, those writers cannot be distinguished 
by filters.
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Writer (continued) fmtName (optional) Specifies the format of logged 
messages. Valid values are:

■ default. Formats messages with identifying 
headings. 

■ short. Formats messages in a shortened form 
without identifying headings.

■ xml. Formats messages in XML.

If you do not set this attribute, then logged 
messages appear in the default format.

For examples of these formats, see “Examples of 
the Formats of Logged Messages” on page 181.

FileLogWriter specific attributes:

dir Directory where log files are to be created. 

maxFileSizeKb Maximum size of the logging file in kilobytes.

When the file size limit is reached, the file is 
closed and a new logging file is created.

filePrefix Log files prefix.

filesN Maximum number of logging files.

When this number is exceeded, the logger starts 
to write to the beginning of the first file.

EventLogWriter specific attributes:

winSource Event log source for logged events.

CrashWriter specific attributes:

file Dump file path.

On Windows, a dump file is created in bin/
coredumps and Oracle BI Presentation Services 
continues to run.

line Dump file line number.

WriterClassGroups Contains definition for writer classes. Writer class is a group of Writer 
class IDs.

WriterClassGroup Contains (as child text) a comma-separated list of class IDs. 

name Name of the WriterClassGroup.

Filters Contain filter configuration.

Table 18. Oracle BI Presentation Services Log Configuration File Elements

Element Attribute Description
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Examples of the Formats of Logged Messages
The fmtName attribute of the Writer element formats logged messages in one of three formats: 
default, short, and xml. The following entries are examples of these formats. 

Default Format Example
The default format formats messages with identifying headings like this:

Type: Information
Severity: 30
Time: Wed Jul 26 11:22:20 2006
File: project\sawserver\sawserver.cpp
Line: 399
Properties: ThreadID-2552
Location: 

saw.sawserver
saw.sawserver.initializesawserver
saw.sawserver

OracleBI Presentation Server has started successfully.

Short Format Example
The short format formats messages in a shortened form without identifying headings like this:

I30 Wed Jul 26 11:22:20 2006 sawserver.cpp 399 saw.sawserver  OracleBI 
Presentation Server has started successfully.

FilterRecord writerClassGroup Specifies the group of writers to which this record 
is applied. WriterClassGroup should be defined 
previously in the WriterClassGroups section.

path Log source path. To enable the logging of SOAP 

information, enter the following value:

saw.httpserver.request.soaprequest

Current filter record is applied to the software 
component identified by that path and all its 
subcomponents.

information An integer that specifies the severity of the 
corresponding message type.

Only messages with a severity index less than the 
provided number are logged.

warning

error

security

Table 18. Oracle BI Presentation Services Log Configuration File Elements

Element Attribute Description
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XML Format Example
The xml format formats messages in XML like this:

<Message>

<Type>I</Type>

<Severity>30</Severity>

<Time>Wed Jul 26 11:22:20 2006 </Time>

<File>sawserver.cpp</File>

<Properties>

<Property>

<Name>ThreadID</Name>

<Values>4524</Values>

</Property>

</Properties>

<Location>

<Logsource>saw.sawserver</Logsource>

<Logsource>saw.sawserver.initializesawserver</Logsource>

<Logsource>saw.sawserver</Logsource>

</Location>

<MessageText>OracleBI Presentation Server has started successfully.</MessageText>

</Message>
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Oracle BI Presentation Services 
Message Structure
Each message that is logged by Oracle BI Presentation Services has several components, as shown 
in Table 19.

Table 19. Components of the Oracle BI Presentation Services Log Message

Message Component Description

Message Text The text of the log message to the user.

Message Type One of four types: information, warning, error, or security.

The first three are self-explanatory. Security is reserved for auditing 
security type information, such as user logged in, login failed, user 
accessed catalog item XYZ, and so on.

Severity The severity is represented as a positive integer.

The lower the value, the more important the message. A message with 
severity 0 is the most important type of message; a message with 
severity 1000 is not important at all.
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NOTE: If the log contains the message “Config Key is not set”, this is not an error, it is an indication 
of the status (set or not set) of a configuration key.

Log Sources Log sources indicate where the message is coming from.

Sources are always of the form 
saw.component.subComponent.function. There is no limit on the 
number of periods (.) in a source. The source can be as many levels 
deep as the programmer decides to make it. Moreover, each logged 
message can have one or more log sources associated with it, 
depending on what code path caused that error to be logged.

For example, the message "Unable to open file" might be logged with 
the stack of sources {saw.delivers, saw.charts} as well as the log 
source stack {saw.views, saw.pdf}.

To print all known log sources, use the logsources command option as 
follows:

■ In Windows:

SAROOTDIR/web/bin/sawserver /logsources

where SAROOTDIR is the installation directory

■ In UNIX:

. SAROOTDIR/setup/saw.sh
SAROOTDIR/web/bin/sawserver -logsources

where SAROOTDIR is the installation directory

Message Properties Properties indicate other kinds of information. The kind varies from 
message to message, and might include username, IP address of client 
browser, thread ID, and so on.

Table 19. Components of the Oracle BI Presentation Services Log Message

Message Component Description
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Oracle BI Presentation Services Logging 
Levels
The categories, impact, and descriptions of the log levels are shown in Table 20.

Table 20. Oracle BI Presentation Services Logging Levels

Category Level Impact Description

Errors 10 Corruption Data corruption detected.

20 Fatal Cannot recover without restart.

25 Unknown Special severity case for catch (...).

30 Critical A recoverable error that needs attention.

40 Error Basic error message.

45 User Special severity for user input error.

Warnings 30 Critical Some immediate action is required to keep system 
running well.

40 Warning Basic warning.

50 Minor Relatively minor warning.

Security 20 Fatal Operation compromised. For example, no license file 
exists, no components are licensed, a needed 
directory cannot be accessed, and similar issues.

30 Critical Break-in, connection to Delivers server failed due to 
access denied, or similar issue.

40 Security Access denied to a necessary or requested object

50 Minor User logon failed due to invalid password or ID, or 
similar function.

55 Trace Special severity for tracing normal security activity, 
such as user logged in, user logged out, or similar 
issue.

Information 20 Fatal Fatal events that need immediate review.

30 Critical Essential start-up, shutdown events.

40 Informational Administrative information, such as completion of 
auto-save.

45 System Special severity for important system information, 
such as cache cleanup started, cache cleanup 
completed.

50 Minor Less important, more granular information, such as 
session time-out.
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Oracle BI Presentation Services Log 
Filters
FilterRecords customize logging details. Use FilterRecords to specify the implementation (output 
type) and logging levels for categories of Web logs: Errors, Warnings, Security, and Information.

In the following example, the first two FilterRecords contain the following string:

path="saw"

This string logs the informational events at level 31, the error messages at level 41, and so on:

This high-level path applies to every event.

You can customize FilterRecords by adding new FilterRecords, such as the third one shown in the 
preceding example, with finer-grain specification of log levels for events of various types. In this 
example, information is being logged to a disk file from saw.mktgsqlsubsystem.log, which generates 
Marketing job events.

You can turn off logging of job details by changing the information level from 41 to 51, as shown in 
the following example, or by commenting out the lines:

 <FilterRecord writerClassGroup="Cout" path="saw" information="31" warning="41" 
error="41" security="41" />  

 <FilterRecord writerClassGroup="File" path="saw" information="31" warning="100" 
error="100" security="41" />  

 <FilterRecord writerClassGroup="File" path="saw.mktgsqlsubsystem.joblog" 
information="41" warning="100" error="100" security="41" />  

 <FilterRecord writerClassGroup="File" path="saw.mktgsqlsubsystem.joblog" 
information="41" warning="100" error="100" security="41" />  

 <FilterRecord writerClassGroup="File" path="saw.httpserver.request" 
information="51" warning="100" error="100" security="41" />  

 <FilterRecord writerClassGroup="File" path="saw.httpserver.response" 
information="51" warning="100" error="100" security="41" />  
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10 Customizing the Oracle BI 
Presentation Services User 
Interface

This chapter describes how to customize the appearance of the Oracle BI Presentation Services user 
interface.

NOTE: In Oracle BI Presentation Services, customization of user interface elements and appearance 
is accomplished by modifying XML message files, and styles and skins, and not through the use of 
JavaScript. You should not modify JavaScript files located in the folder SAROOTDIR\web\app\res, 
where SAROOTDIR is the installation directory. This is because the objects and methods in these 
scripts may change, and because these files may be replaced when upgrading. (In a dashboard, 
users with the appropriate permissions can customize an individual dashboard section by adding 
HTML to it. This HTML can include JavaScript. For more information, read Oracle Business 
Intelligence Answers, Delivers, and Interactive Dashboards User Guide.)

This chapter contains the following topics:

■ About Skins and Styles on page 187

■ Modifying Oracle BI Presentation Services User Interface Styles on page 188

■ Specifying Defaults for Oracle BI Presentation Services Styles and Skins on page 191

■ Customizing Oracle BI Presentation Services NonDashboard Components on page 191

■ Customizing the Oracle BI Presentation Services User Interface Using XML Message Files on 
page 192

■ Adding a Language Selection to Oracle BI Presentation Services Screens on page 197

■ Frequently Customized Oracle BI Presentation Services User Interface Messages on page 198

■ Customizing the Appearance of the Oracle BI Presentation Services Login Screens on page 199

■ Configuring the Oracle Business Intelligence ReportUI Portlet on page 199

About Skins and Styles
The Oracle BI Presentation Services Administrator can control the way the Oracle Business 
Intelligence interface appears to the user by creating skins and styles. The primary difference 
between skins and styles is that skins can be automatically assigned to a user at logon, while styles 
are selectable by the user at runtime to control things such as table formatting, and so on. The 
default skins and styles shipped with the product are located in the Oracle BI Presentation Services 
application resources directory (\web\app\res directory in the installation directory) in the sk_* and 
s_* folders.

A "skin" is assigned based on the value of the system session variable SKIN. The user can then alter 
some elements, such as fonts, colors, various attributes of tables and charts, and so on, by picking 
a "style" for request results (or a dashboard) when logged on to Oracle Business Intelligence. Skins 
consist of nonalterable elements, such as corporate logos or other graphics.
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A "style" controls how dashboards and results are formatted for display, such as the color of text and 
links, the font and size of text, the borders in tables, the colors and attributes of charts, and so on. 
Styles consist on alterable elements, often combined into style sheets.

Using the SKIN Variable
The SKIN variable points to a directory in Oracle BI Presentation Services that contains the 
nonalterable elements. Such directories are located in the Oracle BI Presentation Services data 
resources folder (\SADATADIR\web\res) and begin with "sk_". For example, if a directory were called 
sk_MyCompany, the SKIN variable would be set to MyCompany. Styles are organized into similar 
directories containing the alterable elements. Style folders and style sheets are located in the 
resources folder in directories beginning with "s_". For example, if a directory were called 
s_MyCompanyStyle, the style name would be My CompanyStyle.

Both skin and style directories may contain Cascading Style sheets (files with a .css extension), 
images, and chart templates. Oracle BI Presentation Services Administrators can create new styles 
and skins by creating new style and new skin directories in Oracle BI Presentation Services.

NOTE: Style and skin names cannot include underscores.

Using Skins and Styles
While skins and styles are typically used to customize the look and feel of reports and dashboards 
by providing logos, color schemes, fonts, table borders and other elements, they can also be used 
to control the position of such elements as the paging controls by including specialized style tags in 
the relevant style sheet (.css) file. For example, the page control "tape deck" appears, by default, 
centered and below a table. You can control whether the tape deck appears below or above the table 
(or does not appear at all) by editing the table properties for the target results. By using a specialized 
style tag, however, you can also control the justification of the page control. For example, if you have 
a very wide table, a centered page control might require the user to scroll to the right before it is 
displayed. By including the following specialized style tag in the relevant skin or style sheet (.css) 
file, you can change the justification to the left.

.TapeDeckCell

{ 

text-align: left; 

Modifying Oracle BI Presentation 
Services User Interface Styles
You can modify the Cascading Style Sheets (CSS) files and the images stored in the default 
installation directory to create a custom user interface. The default images and style sheets are 
located the in the SAROOTDIR\web\app\res\s_oracle10 folder, where SAROOTDIR is the installation 
directory. The relevant subdirectories are contained in this directory (b_mozilla_4, charts, images, 
maps, meters, popbin, portal, and views) for the current Oracle Business Intelligence style.
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Web developers who work with and understand style sheets can modify the default Oracle BI 
Presentation Services styles.

NOTE: Modifications to the PopChart appearance files used in charting are not supported by Oracle 
Corporation.

This section contains the following topics:

■ “Working with Cascading Style Sheets to Modify Default Oracle BI Presentation Services Styles” on 
page 189

■ “About Cascading Style Sheet Attributes and Oracle BI Presentation Services” on page 190

■ “Creating a New Dashboard Style for Oracle BI Presentation Services” on page 190

■ “Example: Customizing the Dashboard Banner Image in Oracle BI Presentation Services” on 
page 190

Working with Cascading Style Sheets to Modify Default Oracle BI 
Presentation Services Styles
Web developers who work with and understand style sheets can modify the default Oracle BI 
Presentation Services styles. There are three files that affect most of the dashboard user interface:

■ PortalBanner.css. Influences the overall appearance of a dashboard’s top section. This includes 
the dashboard’s names, links, and so on.

■ PortalContent.css. Influences the overall appearance of a dashboard’s main content area.

■ Views.css. Corresponds to each of the Oracle Business Intelligence request views (Title, Table, 
Pivot Table, Chart, Narrative, Ticker, and so on).

To display an example default Oracle 10 style sheet

1 Right-click the dashboard, and select View Source to view the Web page within a text editor.

There are several CSS files referenced within the header of the Web page (<HEAD>….</HEAD>).

2 Perform a Find within the document and search for the keyword class.

There is a class variable for each available attribute in one of the CSS files.

The first class that appears is the PortalBody class (<body class="PortalBody">). If you open the 
PortalContent.css file, you get a corresponding section for PortalBody. For example:

.PortalBody {
font-family: Verdana, Arial, Sans-serif;
font-size: 9pt;
background-color: #FFFFFF;
margin: 0 0 2 0;

}

You could modify the background color of the dashboard page by changing, for example, the 
hexadecimal color from #FFFFFF (white) to the color of your choice. If you were to save this 
change, you could go back to the Web browser and display the change by clicking Refresh.
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You can change the various CSS classes to adjust the overall look of any Oracle Business Intelligence 
application. This can be a tedious process, but after you have a good understanding of the available 
or most commonly used classes, you can perform a find and replace within the text editor to make 
mass changes to a style.

About Cascading Style Sheet Attributes and Oracle BI Presentation 
Services
Cascading style sheets allow Web developers to have control over any object within Oracle Business 
Intelligence. You can change images, backgrounds, font colors and sizes, table cell gridlines and cell 
padding, and so on.

For more information about cascading style sheets, you can consult a resource such as the Microsoft 
Developer Network (MSDN).

Creating a New Dashboard Style for Oracle BI Presentation Services
The easiest way to create a new style is to copy the SAROOTDIR\web\app\res\s_oracle10 directory 
(where SAROOTDIR is the installation directory) and paste it into the SADATADIR\web\res directory 
(where SADATADIR is the data directory). Copying to the data directory rather than to the main 
installation directory prevents any customized CSS files and images from being overwritten during a 
software upgrade.

After the style has been copied, rename the directory from s_oracle10 to a name that has meaning 
to you (such as s_ProspectName).

The b_mozilla_4.0 directory contains the important files for making quick changes to the 
dashboards.

NOTE: The service for Oracle BI Presentation Services must be restarted before you can display the 
new style sheet from the Dashboard Properties screen.

To create a new style

1 Copy the SAROOTDIR\web\app\res\s_oracle10 directory (where SAROOTDIR is the installation 
directory).

2 Paste it to the SADATADIR\web\res directory (where SADATADIR is the data directory) and give 
it a meaningful name.

3 Make and save your modifications.

The style sheet becomes available in the Dashboard Properties screen when the service for Oracle 
BI Presentation Services is restarted.

Example: Customizing the Dashboard Banner Image in Oracle BI 
Presentation Services
The image bg_Banner.gif image is referenced on the top section of dashboards. Developers can open 
the bg_Banner.gif file and make changes, or delete and recreate a new bg_Banner.gif file.
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Specifying Defaults for Oracle BI 
Presentation Services Styles and Skins
You can specify which style and skin to use when users choose the default style at the Dashboard 
Properties screen in Dashboards by adding entries to the Oracle BI Presentation Services 
configuration file (instanceconfig.xml):

■ “Specifying Which Oracle BI Presentation Services Style Folder to Use” on page 191

■ “Specifying Which Oracle BI Presentation Services Skins Folder to Use” on page 191

If users do not make a choice, or if these entries are not present in the instanceconfig.xml file, the 
Oracle Corporation styles and skins are used. These styles and skins are located in the s_oracle10 
and sk_oracle10 folders in the SAROOTDIR\web\app\res directory, where SAROOTDIR is the 
installation directory.

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

Specifying Which Oracle BI Presentation Services Style Folder to Use
You can specify which style folder to use in the \web\app\res folder when users select the Default 
option from the Styles drop-down list at the Dashboard Properties screen in Dashboards. If your style 
folder begins with the characters s_, such as s_TestStyle, omit those characters from the entry.

The following entry is an example:

<DefaultStyle>TestStyle</DefaultStyle>

Specifying Which Oracle BI Presentation Services Skins Folder to Use
To specify the skins folder that is paired with the style folder you selected as described in “Specifying 
Which Oracle BI Presentation Services Style Folder to Use” on page 191, add the following entry. If your 
skins folder begins with the characters sk_, such as sk_TestSkin, omit those characters from the 
entry.

The following entry is an example:

<DefaultSkin>TestSkin</DefaultSkin>

Customizing Oracle BI Presentation 
Services NonDashboard Components
Non-dashboard components include Answers, Delivers, and Oracle BI Presentation Services 
Administration. The CSS files for these components are stored in the sk_ directory within the main 
installation directory (SAROOTDIR\web\app\res\sk_oracle10). The location b_mozilla_4 contains the 
relevant CSS files that correspond to Answers, Delivers, and Oracle BI Presentation Services 
Administration, and so on.
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Use the same logic that is described in “Modifying Oracle BI Presentation Services User Interface 
Styles” on page 188 to make modifications to the non-dashboard components of the Oracle BI 
Presentation Services user interface.

The non-dashboard components are controlled globally. Users cannot toggle between multiple user 
interfaces for the nondashboard components.

Customizing the Oracle BI Presentation 
Services User Interface Using XML 
Message Files
This section explains how to customize text elements in message files to manage the default 
appearance and behavior of the Oracle BI Presentation Services user interface using XML strings.

NOTE: The intent of this section is to allow organizations that have XML expertise to perform 
additional customization. If you do not have this expertise, enlist the assistance of a third party to 
help you with customization.

This section contains the following topics:

■ “About the Oracle BI Presentation Services User Interface XML Message Files” on page 192

■ “How Oracle BI Presentation Services XML Message Files Are Structured” on page 193

■ “Customizing Oracle BI Presentation Services XML Messages” on page 193

■ “Resolution of Oracle BI Presentation Services XML Message Name Elements” on page 194

■ “Sample Oracle BI Presentation Services XML Template” on page 195

■ “Sample Oracle BI Presentation Services custommessages.xml File” on page 196

NOTE: Other topics in this guide describe additional customizations that you can perform by 
customizing text elements in message files, such as “Configuring Answers Pivot Table Settings” on 
page 52.

About the Oracle BI Presentation Services User Interface XML 
Message Files
You can customize many of the text elements that appear in Answers, Delivers, and on dashboard 
pages. Examples of text elements include the content of text strings, the text for prompts such as 
the names of links and buttons, and the text of error and informational messages that are displayed 
to users as the result of an action.

These text elements are contained in external message files that are distributed with Oracle BI 
Presentation Services. The message files are in XML format. Language-specific messages are located 
in the folder SAROOTDIR\web\msgdb\l_xx\messages, where SAROOTDIR is the installation directory 
and xx is the language identifier of the selected locale (for example, for english-usa, the identifier is 
en). Language-independent messages are located in the folder SAROOTDIR\web\msgdb\messages, 
where SAROOTDIR is the installation directory.
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You should not edit the message files directly because any changes would not be retained when you 
install newer versions or service releases. For more information, read “Customizing Oracle BI 
Presentation Services XML Messages” on page 193.

How Oracle BI Presentation Services XML Message Files Are 
Structured
The name of a particular message file indicates the kind of content that it holds. For example, 
messages in the file logonmessages.xml hold message content related to the act of logging on and 
off the application. Within each XML file, the WebMessage name= elements define the names of the 
messages. These elements are called message identifiers.

A particular message may also reference the content of another message by using a MessageRef 
element. For example, the following message in the file logonmessages.xml references the value of 
another message:

<WebMessage name="kmsgAuthenticateNotLoggedOnToLogOnClickHere">
<HTML>
You are not currently logged in to the
<MessageRef name="kmsgProductServer" />

The entry <MessageRef name="kmsgProductServer" /> in the previous message indicates that the 
name of the server is taken from the value of the kmsgProductServer message identifier. This 
message is located in the file productmessages.xml, and its value is Oracle BI Server:

<WebMessage name="kmsgProductServer" CRC="nnnnnnnnnnnnnnnnnnnn">

<TEXT>Oracle BI Server</TEXT> 

Some messages, such as those that contain copyright information and product names, are protected 
and cannot be changed. If you read the file productmessages.xml, there is text preceding the 
WebMessage elements indicating that the associated names cannot be changed.

Customizing Oracle BI Presentation Services XML Messages
This section explains how to change the content of unprotected messages and provides several 
examples. The intent is to show you how to alter the text of messages, and not to teach you XML.

To customize messages

1 Create message identifiers with similar names and customize their text.

2 Create a custom messages folder named customMessages.

NOTE: Organizations that have Oracle Business Intelligence applications may already have a file 
present in this folder. This file enables Oracle Business Intelligence support for Oracle Business 
Intelligence applications, and should not be modified, moved, or deleted.

3 Place the messages in one or more XML files in the customMessages folder, and then place the 
customMessages folder in this location:
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SADATADIR\web\msgdb\l_xx

where SADATADIR is the data directory, and xx is the language identifier of the selected locale 
(for example, for english-usa, the identifier is en).

If you are not concerned with multiple languages, place the folder in the l_en folder. Messages 
default to l_en if a language-specific version is not found. You need to create the l_xx folder in 
the SADATADIR\web\msgdb folder.

4 Restart Oracle BI Server.

You can create multiple XML files in the customMessages folder, or create a single XML file that holds 
customized messages, for example, custommessages.xml. This is because the application goes 
through the customMessages folder and reads every file that has an XML extension, regardless of 
the file’s name. If you create many customized messages you may prefer to organize them into 
separate files.

NOTE: If you intend to support multiple languages, place control messages (which are messages 
that are not translated) into one file named customcontrolmessages.xml. Place messages that are 
translated into another file named, for example, customuimessages.xml. This places localized 
versions of the customuimessages.xml file in each language folder as appropriate, such as 
\OracleBIData\web\msgdb\l_de\customMessages, 
\OracleBIData\web\msgdb\l_fr\customMessages, and so on.

Links are a special case. Modifications made to link messages display as expected in dashboards and 
delivers. To make these same modifications display in Answers, you must modify the 
kuiAnswersMainBar message.

To edit a custom message file

1 Make a backup of the original file in a separate folder.

2 Make a development copy in a different folder.

3 Edit the development version of the file in a text or XML editor.

4 Replace the original file in the customMessages folder with the newly edited file.

5 Test the new file.

6 (Optional) Delete the backup and development copies.

Resolution of Oracle BI Presentation Services XML Message Name 
Elements
During initialization, the Oracle BI Presentation Services replaces the WebMessage name default text 
with text from equivalently named elements in any customized XML file, based on the following 
precedence order, from highest to lowest:

■ XML in SADATADIR\web\msgdb\l_xx\customMessages folder (language- specific folders), where 
SADATADIR is the data directory.

■ XML in SADATADIR\web\msgdb\l_en\customMessages folder (for language-specific user logons 
if WebMessage name elements reside here, but are not in language-specific files).



Customizing the Oracle BI Presentation Services User Interface ■ Customizing the
Oracle BI Presentation Services User Interface Using XML Message Files

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

195

■ XML in SADATADIR\web\msgdb\customMessages folder.

■ XML in SAROOTDIR\web\msgdb\l_xx\messages folder, where SAROOTDIR is the installation 
directory.

■ XML in SAROOTDIR\web\msgdb\messages folder.

As an example, when Oracle BI Presentation Services starts up, it first reads the messages in the 
folder SAROOTDIR\web\msgdb\l_xx\messages in the installation directory, and then reads the 
messages in the folder SADATADIR\web\msgdb\l_xx\customMessages. It replaces the default text 
for those messages with the customized text. If you attempt to alter the text of a protected message, 
a message is displayed in its place indicating that you attempted this.

Sample Oracle BI Presentation Services XML Template
The following is a sample template for a custommessages.xml file in the folder 
SADATADIR\web\msgdb\l_xx\customMessages, where SADATADIR is the data directory. An example 
custommessages.xml file follows the template.

Every message begins with a <WebMessage name=> element and ends with a
</WebMessage> element. The message text that you can customize is contained between <TEXT> 
elements or <HTML> elements. To suppress the display, delete the text between the elements.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables>

<WebMessageTable system="Custom Messages">
<!-- The name of a message must match the name of the message you are 

overriding. -->
<WebMessage name="kmsgExampleOverrideMessage">

<!-- A message can have TEXT and/or HTML versions of it. It is not necessary 
to have both. (TEXT will be automatically converted to HTML when necessary). -->

<TEXT>Example message.</TEXT> <!-- Format used in a text only output -->
<HTML><b>Example message with bold HTML tags.</b></HTML> <!-- Format used 

in an HTML output -->

</WebMessage>
</WebMessageTable>

</WebMessageTables>

To create a sample template

1 Replicate the sample template in a text editor.

2 Name the file custommessages.xml (or any name you choose).

3 Place the file into the customMessages folder you have created in the appropriate 
SADATADIR\web\msgdb\l_xx folder.
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Sample Oracle BI Presentation Services custommessages.xml File
The following example shows four customized messages placed in the custommessages.xml file.

<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables>

<WebMessageTable system="Custom Messages">

<!-- First message -->
<WebMessage name="kmsgAuthenticateRemembermyIDandpassword">
<TEXT>Remember my signon name and password.</TEXT>

</WebMessage>

<!-- Second message -->
<WebMessage name="kkmsgPrivilegeDisplayerAccountUnknown">
<TEXT>Unknown Account (<Param insert="1"/>). Call the Help Desk at 

extension 9999 to set up a new account.</TEXT>
</WebMessage>

<!-- Third message --
<WebMessage name="kmsgWelcomeFrameCreateNewRequest">
<HTML>Create a <b>new request</b> by clicking on a Subject Area below. After 

creating the request, click on the <b>Done</b> button at the bottom of the page.</
HTML>

</WebMessage>

<!-- Fourth message -->
<WebMessage name="kmsgUIAdmin">
<HTML></HTML>

</WebMessage>

</WebMessageTable>

</WebMessageTables>

■ The message identifier of the first message being customized is 
"kmsgAuthenticateRemembermyIDandpassword". The default text for this message is 
located in the file logonmessages.xml in the folder SAROOTDIR\web\msgdb\l_xx\messages, 
where SAROOTDIR is the installation directory.

■ The message identifier of the second message being customized is 
"kmsgPrivilegeDisplayerAccountUnknown". The default text for this message is located in the 
file viewmessages.xml in the folder SAROOTDIR\web\msgdb\l_xx\messages, where 
SAROOTDIR is the installation directory. This message contains a variable,
( <Param insert="1"/> ).

NOTE: If you are customizing a message that contains a variable, do not alter the variable. 
In the UNIX environment, be careful to preserve the case of the message name being 
customized.
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■ The message identifier for the third message being customized is 
"kmsgWelcomeFrameCreateNewRequest". The default text for this message is located in the 
file searchsysmessages.xml in the folder SAROOTDIR\web\msgdb\l_xx\messages, where 
SAROOTDIR is the installation directory. This message is in HTML format and uses an HTML 
tag ( <b> ) to display text in bold letters.

■ The message identifier for the fourth message being customized is "kmsgUIADMIN". The 
default text for this message is located in the file uimessages.xml in the folder 
SAROOTDIR\web\msgdb\l_xx\messages, where SAROOTDIR is the installation directory. 
This message is in HTML format. This message identifier displays the Admin link at the top 
of each Answers, Delivers, or dashboard page. Deleting the Admin text between the <HTML> 
and </HTML> tags suppresses the display of the link.

Adding a Language Selection to Oracle 
BI Presentation Services Screens
The Oracle BI Presentation Services login screen and the My Account screen in Answers each include 
a language selection drop-down list, where users select the language in which they want to work. If 
a language that you want users to be able to select does not appear in the language selection drop-
down list, you can add it. 

To add a language to the language selection drop-down list on the login and My 
Account screens

1 Add the l_xx directory to the SADATADIR\web\msgdb directory, where xx is the language 
extension for the language that you want to add (for example, en for english-usa) and 
SADATADIR is the data directory.

2 Copy the languagenames.xml file in the SAROOTDIR\web\msgdb\messages directory to the 
SADATADIR\web\msgdb\messages directory, where SAROOTDIR is the installation directory and 
SADATADIR is the data directory. (The languagenames.xml file contains the list of languages that 
are acceptable for the language selection drop-down lists.)

3 Use a text editor to open the languagenames.xml file in the SADATADIR\web\msgdb\messages 
directory.

4 Check to make sure that the language that you want to add is not already listed in the file. If it 
is not listed, make the following entry to add the language:

<WebMessage name="kmsgLanguageName_xx">
<TEXT>LanguageName</TEXT>
</WebMessage>

where xx is the language extension (for example, ar) and LanguageName is the name of the 
language (for example, Arabic).
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Frequently Customized Oracle BI 
Presentation Services User Interface 
Messages
Messages that are frequently customized are located in the file uimessages.xml. This file contains 
text strings for display elements and for links throughout the user interface.

For example, the following messages contain the text for the links Admin, Alerts!, and Answers in 
the user interface. You can customize the text, or delete the text to suppress the display of the link.

<WebMessage name="kmsgUIAdmin">
<HTML>Admin</HTML>

</WebMessage>

<WebMessage name="kmsgUIAlerts">
<HTML>Alerts!</HTML>

</WebMessage>

<WebMessage name="kmsgUIAnswers">
<HTML>Answers</HTML>

</WebMessage>

For example, users can export the data for a request to a Microsoft Excel file. If you do not want to 
support the download to Excel option, you can remove the link.

To remove the Download link

1 Open the viewscontrolmessages.xml file.

2 Copy the following message to the custommessages.xml file:

<WebMessage name="kmsgEVCDownloadLinks">
<HTML>

<a insert="1">
<MessageRef name="kmsgEVCLinkDownloadExcel" />

</a>

<a insert="2">
<MessageRef name="kmsgEVCLinkDownloadData" />

</a>
</HTML>

3 Delete the first message identifier anchor:

 <a insert="1">
<MessageRef name="kmsgEVCLinkDownloadExcel" />

</a>

4 Save the custommessages.xml file.

For more information about the custommessages.xml file, read “Sample Oracle BI Presentation 
Services custommessages.xml File” on page 196.



Customizing the Oracle BI Presentation Services User Interface ■ Customizing the
Appearance of the Oracle BI Presentation Services Login Screens

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

199

Customizing the Appearance of the 
Oracle BI Presentation Services Login 
Screens
Users must log in to Oracle BI Presentation Services to gain access to Dashboards, Answers, and 
other Oracle BI Presentation Services components. The logon process provides a user interface to 
the Oracle BI Server authentication process.

When Oracle BI Presentation Services is accessed, the user is presented with the default Oracle BI 
Presentation Services login screen. The user must enter an appropriate Oracle Business Intelligence 
user name and password. When authentication is complete, the user gains access to the appropriate 
Oracle BI Presentation Services components, and the user’s default dashboard displays. For more 
information, read “About Oracle BI Presentation Services User Authentication” on page 142.

To customize the appearance of the login screens
■ Override the relevant messages in the file logoncontrolmessages.xml.

NOTE: The Not Logged On screen (kmsgAuthenticateNotLoggedOn), used for session timeout, 
appears only when users are not logged on and attempt to access a URL that does not support 
direct logon. For example, suppose a user accesses Answers and clicks the Log Off link. If the 
user clicks the browser’s Back button and then clicks the My Account link, the user receives the 
Not Logged On screen.

For general information about customization the user interface with XML messages, read 
“Customizing the Oracle BI Presentation Services User Interface Using XML Message Files” on page 192.

NOTE: This feature does not allow the Oracle BI Presentation Services Administrator to control how 
users are actually authenticated. For information about authentication options, read “About Oracle BI 
Presentation Services User Authentication” on page 142.

Configuring the Oracle Business 
Intelligence ReportUI Portlet
The Oracle BI ReportUI Portlet is a software component that displays Oracle BI Presentation Services 
content in a portlet in a portal server. While the Oracle BI ReportUI Portlet adheres to JSR 168 portlet 
specifications and should work on any JSR 168-compliant portal server, it has been tested on the 
following portal servers:

■ Oracle Application Server Portal 10.1.4.0.0 

Additionally, the Oracle Application Server Portal requires Patch 4900785, and the OC4J instance 
where the Oracle BI ReportUI Portlet is to be installed requires an installed WSRP Container. 

■ WebSphere Portal 5.1.0.4

The implementation of the Oracle BI ReportUI Portlet is based on an existing HTML view service 
provided by the Oracle BI Presentation Services SOAP layer.

The connection schema works as follows:
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1 The browser displaying the Oracle Application Server Portal or WebSphere Portal contains the 
Oracle BI ReportUI Portlet that requests an Oracle BI Presentation Services report.

2 The Oracle Application Server Portal Server or the WebSphere Portal Server receives the request 
and forwards it to the Bridge servlet in the Oracle BI Presentation Services Portlets Web 
Application.

3 The Bridge servlet contacts Oracle BI Presentation Services.

4 Oracle BI Presentation Services delivers the report information to the ReportUI portlet in the 
Oracle BI Presentation Services Portlets Web Application.

5 The ReportUI portlet sends the information to the Oracle Application Server Portal Server or 
WebSphere Portal Server which forwards it on to the user’s web browser for display.

Installing and Configuring the Oracle BI ReportUI 
Portlet
These instructions assume that you have installed the Oracle Application Server Portal Server or 
WebSphere Portal Server according to the manufacturer’s instructions and have started the Oracle 
Application Server Portal Server or WebSphere Portal Server. A complete installation consists of the 
following activities:

■ “Editing the portlet.xml file to configure Oracle BI ReportUI Portlet” on page 200

■ “Deploying the Oracle BI ReportUI Portlet” on page 203

■ “Configuring Authentication in the Oracle BI ReportUI Portlet” on page 203

Editing the portlet.xml file to configure Oracle BI 
ReportUI Portlet
Before you deploy the Oracle BI ReportUI Portlet, you need to edit the portlet.xml file to specify the 
URL for Oracle BI Presentation Services as well as some administrator credentials.

The portlet.xml file is delivered as part of the sawjsr168portlets.war file, a Web Archive (WAR) file 
located in the SAROOTDIR/web/skd folder (where SAROOTDIR is the installation directory).

To edit the portlet.xml file

1 Create an empty folder named {portletconfig} (where portletconfig is any name you choose for 
the folder) in which to expand the sawjsr168portlets.war file. 

2 Locate the sawjsr168portlets.war file in the SAROOTDIR/web/skd folder (where SAROOTDIR is 
the installation directory) and copy it to the {portletconfig} folder.

3 Make the {portletconfig} folder the current folder and expand sawjsr168portlets.war using the 
jar utility included with the JDK installation:

jar -xf sawjsr168portlets.war
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4 Use a text editor to open the portlet.xml file in {portletconfig}/WEB-INF. 

5 Set the value element for each of the following preference/name elements:

6 Make the {portletconfig} folder the current folder and update sawjsr168portlets.war using the 
jar utility included with the JDK installation:

jar -uf sawjsr168portlets.war WEB-INF/portlet.xml

Example of portlet.xml
The following XML file is an example of the portlet.xml file:

Element Value

oracle.bi.presentation.sawserver.URL The access URL of Oracle BI Presentation 
Services. It includes the part of the URL before 
the question mark. It usually ends with saw.dll.

Default value is:
http://localhost/analytics/saw.dll

oracle.bi.presentation.portlets.jsr168.reportui.
AdminUserName

The user name of the Oracle Business 
Intelligence administrator. 

Required when authentication is done by 
administrative credentials. For more information 
see “Configuring Authentication in the Oracle BI 
ReportUI Portlet” on page 203.

oracle.bi.presentation.portlets.jsr168.reportui.
AdminPwd

The password for the Oracle Business 
Intelligence administrator. 

Required when authentication is done by 
administrative credentials. For more information 
see “Configuring Authentication in the Oracle BI 
ReportUI Portlet” on page 203.

oracle.bi.presentation.portlets.websphere.
SuperuserSlotId

(For WebSphere Portal only) The name of 
WebSphere Shared Credential Vault Slot, which 
holds the administrative user name and 
password for Oracle BI Presentation Services 
identified by the URL above. 

Used when authentication is done by 
administrative credentials. For more information 
see “Configuring Authentication in the Oracle BI 
ReportUI Portlet” on page 203.

For more information about WebSphere Shared 
Credential Vault Slot, see the WebSphere Portal 
documentation. 
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<?xml version="1.0" encoding="UTF-8" ?>
<portlet-app xmlns="http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd http://
java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd" version="1.0"
id="Oracle Business Intelligence Report View Portlet Application">
<portlet>

<portlet-name>Oracle Business Intelligence Report View Portlet</portlet-name>
<portlet-class>com.siebel.analytics.web.portlets.jsr168.ReportUI</portlet-class>
<expiration-cache>0</expiration-cache>
<supports>

<mime-type>text/html</mime-type>
<portlet-mode>edit</portlet-mode>
<portlet-mode>edit_defaults</portlet-mode> 

</supports>
<portlet-info>

<title>Oracle Business Intelligence Report View Portlet</title>
</portlet-info>
<portlet-preferences>

<preference>
<name>oracle.bi.presentation.report.Path</name>
<value/>
<read-only>false</read-only>

</preference>
<preference>

<name>oracle.bi.presentation.report.ViewName</name>
<value />
<read-only>false</read-only>

</preference>
<preference>

<name>oracle.bi.presentation.sawserver.URL</name>
<value>http://localhost/analytics/saw.dll</value>
<read-only>false</read-only>

</preference>
<preference>

<name>oracle.bi.presentation.portlets.jsr168.reportui.AdminUserName</name>
<value/>
<read-only>false</read-only>

</preference>
<preference>

<name>oracle.bi.presentation.portlets.jsr168.reportui.AdminPwd</name>
<value/>
<read-only>false</read-only>

</preference>
<preference>

<name>oracle.bi.presentation.portlets.websphere.SuperuserSlotId</name>
<value/>
<read-only>false</read-only>

</preference>
</portlet-preferences>

</portlet>
<custom-portlet-mode>

<description xml:lang="en">This mode signifies that the portlet should render a 
screen to set the default values for the read-only preferences that are typically changed 
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in the EDIT screen. Calling this mode requires that the user must have administrator 
rights.</description>

<portlet-mode>edit_defaults</portlet-mode>
</custom-portlet-mode>

</portlet-app>

Deploying the Oracle BI ReportUI Portlet
The Oracle BI ReportUI Portlet is packaged in the sawjsr168portlets.war file located in the 
SAROOTDIR/web/skd folder (where SAROOTDIR is the installation directory). To deploy it, follow the 
instructions in the Portal documentation.

TIP: When deploying the Oracle BI ReportUI Portlet on the Oracle Application Server Portal, first 
deploy the sawjsr168portlets.war file as a Web application in the OC4J instance that supports Web 
Services for Remote Portals (WSRP). Then, to test that the deployment was successful, access this 
URL:
http://{Portal server host}:{Portal server port}/{Portlet application URL}/portlets?WSDL
This URL should return a valid WSDL document.

TIP: If the Oracle BI ReportUI Portlet deployment fails, try deploying some other portlet to make 
sure that the portal server is working correctly.

Configuring Authentication in the Oracle BI ReportUI 
Portlet
To authenticate users, the Oracle BI ReportUI Portlet retrieves the login name for the current user 
from the Portal and passes it to Oracle BI Presentation Services. In order for Oracle BI Presentation 
Services to trust that the name of the authenticated user, Oracle BI Presentation Services needs to 
verify that the login name is from a trusted source. You can use one of two approaches to accomplish 
this verification:

■ Authenticate with administrative credentials — With this approach, the Portlet remembers the 
credentials of the Oracle BI Administrator (that is, user name and password) and passes them 
to Oracle BI Presentation Services along with the login name of the current user. Because Oracle 
BI Presentation Services knows the user name and password of the Oracle BI Administrator, it 
knows that it can trust that the login name of the current user is actually the name of the user 
who was properly authenticated.

■ Authenticate with SSL certificates — With this approach, the Portal authenticates itself to Oracle 
BI Presentation Services using SSL certificates.

To configure authentication using administrative credentials
■ Set the following elements in the portlet.xml file:

■ For the Oracle Application Server Portal: 

❏ oracle.bi.presentation.portlets.jsr168.reportui.AdminUserName 
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❏ oracle.bi.presentation.portlets.jsr168.reportui.AdminPwd

■ For the WebSphere Portal: oracle.bi.presentation.portlets.websphere.SuperuserSlotId

For more information on editing the portlet.xml file, see “Editing the portlet.xml file to configure Oracle 
BI ReportUI Portlet” on page 200.

To configure authentication using SSL certificates
NOTE: These procedures assume that you are familiar with general SSL concepts and the 
administration of the Web server running the Bridge servlet and the Portal server.

1 In the portlet.xml file, make sure that the following elements are set to empty strings:

■ oracle.bi.presentation.portlets.jsr168.reportui.AdminUserName 

■ oracle.bi.presentation.portlets.jsr168.reportui.AdminPwd

For more information on editing the portlet.xml file, see “Editing the portlet.xml file to configure 
Oracle BI ReportUI Portlet” on page 200.

2 Create and sign two SSL certificates for the Web server running the Bridge servlet and the Portal 
server. Make sure that the Web server certificate includes the proper domain name system (DNS) 
name of the Web server.

3 For the Web server running the Bridge servlet, configure the server to:

■ Accept “https” connections. Be sure to test that you can access Oracle BI Presentation 
Services from the browser using “https” and that the Browser does not display a Domain 
Name Mismatch Security Error.

■ Accept client certificates. 

For example, in Tomcat, you configure SSL parameters as attributes of the Connector 
element of the server.xml file, where the clientAuth="want" attribute enables client 
certificates and the truststoreFile attribute identifies the certificate for the certificate 
authority that was used for signing the Portal server certificate.

4 Configure the Oracle Application Server Portal or WebSphere Portal to accept client certificates. 

For example, for the Oracle Application Server Portal, you can edit the Java command line and 
specify Java properties related to SSL. To do so, display the Administration screen for the OC4J 
instance that supports WSRP and select the Server Properties link. Then, in the Java Options 
files, add SSL properties to configure the trust store and the key store, for example:

-Djavax.net.ssl.trustStore=D:/certificates/jsr168portal.keystore
-Jjavax.net.ssl.keyStorePassword=password
-Djavax.net.ssl.keyStore=D:/certificates/jsr168portal.keystore

where -Djavax.net.ssl.trustStore identifies the certificate of the certificate authority that 
was used for signing the Web server running the Bridge servlet and -Djavax.net.ssl.keyStore 
identifies the certificate of the certificate authority that was used for signing the Portal server.

5 Configure the Bridge servlet to recognize the Portal certificate by adding the 
com.oracle.bi.web.TrustedRemoteDNs element (which identifies the list of Distinguished Names 
(DNs) of trusted certificates, with each DN separated by a semicolon) to the Web server’s 
web.xml file, for example:
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<param-name>com.oracle.bi.web.TrustedRemoteDNs</param-name>
<param-value>

CN=Portal, OU=OrgUnit, O=Organization, L=City, ST=State, C=Country
</param-value>

When the Bridge servlet receives a trusted certificate, it extracts the CN value and passes it to 
Oracle BI Presentation Services as the current remote user. 

6 Configure Oracle BI Presentation Services to allow authentication of remote users without a 
password via SOAP by setting the EnableWebServerAuthInSoap element to Y in the Oracle BI 
Presentation Services configuration file (instanceconfig.xml). 

For information about working in the Oracle BI Presentation Services configuration file 
(instanceconfig.xml), read “Making Oracle BI Presentation Services Configuration Changes” on 
page 15.

7 Enable Oracle BI Presentation Services to retrieve the user password for the Portal user from the 
credential store. There are two ways to do this:

■ If security is a concern, create an entry in the Oracle BI Presentation Services credential store 
with the key that matches the value of the CN attribute of the Portal certificate. For more 
information about the Oracle BI Presentation Services credential store, see Oracle Business 
Intelligence Enterprise Edition Deployment Guide.

■ If security is not a concern:

❏ Add the following entry to the instanceconfig.xml file:

<CredentialStore>
<CredentialStorage type="file" path={full_path_to_credential_store}/>

</CredentialStore>

❏ Create a credentialstore.xml file. For more information, see Oracle Business Intelligence 
Enterprise Edition Deployment Guide.



Oracle Business Intelligence Presentation Services Administration Guide 
Version 10.1.3.2

Customizing the Oracle BI Presentation Services User Interface ■ Configuring the 
Oracle Business Intelligence ReportUI Portlet

206 



Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

207

11 Integrating Oracle BI 
Presentation Services into 
Corporate Environments Using 
HTTP

This chapter explains the HTTP methods that you can use to integrate Oracle BI Presentation Services 
into your corporate environment. Oracle BI Presentation Services provides entry points for most 
functionality exposed in the system. Calls can be made through HTTP using a simple URL syntax or 
JavaScript commands. In UNIX, interfaces are exposed through a Java Servlet. This chapter contains 
the following topics:

■ Incorporating Oracle Business Intelligence Results into External Portals or Applications Using the Go 
URL on page 207

■ Referencing Dashboard Content in External Portals or Applications Using the Oracle BI Presentation 
Services Dashboard URL on page 210

■ Using the Oracle BI Presentation Services Go URL to Issue SQL and Pass Filters on page 212

■ Example of an Oracle Business Intelligence Third-Party SQL Tool Integration on page 217

Incorporating Oracle Business 
Intelligence Results into External 
Portals or Applications Using the Go URL
This section describes how to use the Oracle BI Presentation Services Go URL to incorporate results 
into external portals or applications. It contains the following topics:

■ “About the Oracle BI Presentation Services GO URL” on page 207

■ “Structure of the Basic Oracle BI Presentation Services Dashboard URL” on page 211

■ “Optional Parameters for the Oracle BI Presentation Services Go URL” on page 208

About the Oracle BI Presentation Services GO URL
The Oracle BI Presentation Services Go URL command is for use in incorporating specific Oracle 
Business Intelligence results into external portals or applications. The Go URL is used when you add 
a result to your favorites, or add a link to a request to your dashboard or an external Web site. It 
has a number of forms and optional arguments that can be used to control its behavior.

You can post the Go URL as a Form or issue it as a URL. If you are issuing parameters as part of a 
URL, they need to be escaped properly. You need to replace spaces with plus ( + ) signs, and so on. 
For example, to pass East Region as a value, type East+Region.

When called from within an Oracle BI Presentation Services screen, such as a dashboard or an HTML 
result view, the URL should begin with the following characters:

saw.dll?Go
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When called from another screen on the same Web server, the URL should begin with the following 
characters:

/Analytics/saw.dll?Go

When referenced from a screen on a different server (or sent through email, and so on), the URL 
should begin with the fully qualified server name or IP address:

http://server_name_or_ip_address/Analytics/saw.dll?Go

To test these commands, you can enter the fully qualified version into the Address field in Internet 
Explorer.

Structure of the Basic Oracle BI Presentation Services Go URL
The basic Go URL command needs the full Presentation Catalog path to the request to execute. It 
returns the default result view, which is defined in the request.

For example, the following go URL command returns the default result view as defined in the request, 
where SB2 is the name of the request to execute.

saw.dll?Go&Path=/Shared/Test/SB2

Optional Parameters for the Oracle BI Presentation Services Go URL
You can modify the behavior of the Go URL command by adding one or more of the following 
parameters. If an invalid URL is specified (for example, you type a parameter incorrectly), the 
browser displays a “The page cannot be found” error with the detailed text of “HTTP 400 - Bad 
Request.”

NOTE: In parameter descriptions, SB2 is the name of the request to execute.

■ User ID and Password. The user is prompted for user ID and password if this information has 
been omitted from the request and if the user has not chosen the option to have logon 
information remembered.

This is the format, where uuu is the user ID and ppp is the password:

&NQUser=uuu&NQPassword=ppp 

Example:

saw.dll?Go&Path=/Shared/Test/SB2&NQUser=user1&NQPassword=rock

This logs on as user1 with a password of rock, and executes the request.

■ Link Options. The results will include links.

This is the format:
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&Options=x 

The x can be one or more of the following letters:

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Options=md

This displays results with the links Modify Request and Download.

■ Printer Friendly. Results are in a printer-friendly format, without the paging controls, hot links, 
and so on.

This is the format:

&Action=print

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Action=Print

■ Application Friendly. Results are displayed in an application-friendly format, such as for 
Microsoft Excel, without the paging control, hot links, and so on.

This is the format:

=&Action=Extract

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Action=Extract

The Extract action also acts as a Navigate action (read “Passing Filters to the Oracle BI 
Presentation Services Go URL Through a URL (Navigation)” on page 212) so you can filter the 
results that are returned by the call.

■ Specific View. This shows an individual result view rather than the default compound view.

This is the format, where xx is the name of the view:

saw.dll?Go&Path=/Shared/Test/SB2&ViewName=xx

Example:

saw.dll?Go&Path=/Shared/Test/SB2&ViewName=Chart

Assuming that the request contains a Chart view named Chart, this displays just the Chart view.

Letter Link

m Modify Request

f Printer Friendly

d Download to Excel

r Refresh Results
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■ Specific Style. This shows the results using a specified style. If the style does not exist, the 
default is used.

This is the format, where xx is the name of the style:

saw.dll?Go&Path=/Shared/Test/SB2&Style=xx

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Style=Lime

This uses the style named Lime to show the results.

■ Result Format. This controls the format of the results.

This is the format, where xx is XML or HTML:

saw.dll?Go&Path=/Shared/Test/SB2&Format=xx

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Format=XML

This shows results in XML.

Displaying All Records in a Table
There are two ways to display all the records in the table:

■ Set the Rows per Page property on the Table view to 10,000, and then use the basic Go. This is 
the easier of the two methods.

■ Issue the following URL, assuming the View to control is called Table:

saw.dll?Go&Path=/Shared/Test/SB2&Action=Scroll&P5=-1&ViewID=go~Table

Referencing Dashboard Content in 
External Portals or Applications Using 
the Oracle BI Presentation Services 
Dashboard URL
This section describes how to use the Oracle BI Presentation Services Dashboard URL. It contains 
the following topics:

■ “About the Oracle BI Presentation Services Dashboard URL” on page 211

■ “Structure of the Basic Oracle BI Presentation Services Dashboard URL” on page 211

■ “Optional Parameter for the Oracle BI Presentation Services Dashboard URL” on page 211



Integrating Oracle BI Presentation Services into Corporate Environments Using
HTTP ■ Referencing Dashboard Content in External Portals or Applications Using the Oracle

Oracle Business Intelligence Presentation Services Administration Guide
Version 10.1.3.2

211

About the Oracle BI Presentation Services Dashboard URL
The Oracle BI Presentation Services Dashboard URL is for use in incorporating or referencing the 
content of a specific dashboard in external portals or applications. It has a number of forms and 
optional arguments that can be used to control its behavior.

You can post the Dashboard URL command as a Form or issue it as a URL. If you are issuing 
parameters as part of a URL, they need to be escaped properly. You need to replace spaces with plus 
( + ) signs, and so on. For example, to pass East Region as a value, type East+Region.

When called from within an Oracle BI Presentation Services screen, such as a dashboard or an HTML 
result view, the URL should begin with this:

saw.dll?Dashboard

When called from another screen on the same Web server, the URL should begin with this:

/Analytics/saw.dll?Dashboard

When referenced from a screen on a different server (or sent through email, and so on), the URL 
should begin with the fully qualified server name or IP address:

http://server_name_or_ip_address/Analytics/saw.dll?Dashboard 

To test these commands, you can enter the fully qualified version into the Address field in Internet 
Explorer.

Structure of the Basic Oracle BI Presentation Services Dashboard URL
The basic Dashboard URL command needs no parameters. It displays the user’s default portal, after 
authenticating the user.

This is the format:

saw.dll?Dashboard

Optional Parameter for the Oracle BI Presentation Services Dashboard 
URL
You can modify the behavior of the Dashboard URL command by adding the user ID and password 
parameters. If the parameters are omitted, then the user is prompted for user ID and password 
information, unless the user chose the option to have logon information remembered when last 
logged on. If using a Session ID or Ticket, pass it as the NQUser parameter. In the parameter 
description, SB2 is the name of the request to execute.

This is the format, where uuu is the user ID, and ppp is the password:

&NQUser=uuu&NQPassword=ppp

Example:

saw.dll?Go&Path=/Shared/Test/SB2&NQUser=user1&NQPassword=rock

This logs on as user1 with a password of rock, and displays the dashboard.
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If an invalid URL is specified (for example, you type a parameter incorrectly), the browser returns 
the “The page cannot be found” error with detailed text of “HTTP 400 - Bad Request.”

Using the Oracle BI Presentation 
Services Go URL to Issue SQL and Pass 
Filters
This section explains how to use the Go URL command to issue SQL, and how to pass filters to be 
used for navigation. It contains the following topics:

■ “Issuing SQL Using the Oracle BI Presentation Services Go URL” on page 212

■ “Passing Filters to the Oracle BI Presentation Services Go URL Through a URL (Navigation)” on 
page 212

Issuing SQL Using the Oracle BI Presentation Services 
Go URL
The Go URL command can be used to issue Oracle Business Intelligence SQL. These forms of the Go 
URL return tabular results. The basic options from &Style= and &Options= can be used here as well.

To issue Oracle Business Intelligence's simplified SQL, include the escaped SQL as a parameter to 
the Go URL. For example:

saw.dll?Go&SQL=select+Region,Dollars+from+SupplierSales

where the FROM clause is the name of the Subject Area to query.

Alternatively, the command IssueRawSQL can be used to bypass the Web processing and issue SQL 
directly against the Oracle BI Server.

Passing Filters to the Oracle BI Presentation Services 
Go URL Through a URL (Navigation)
The Go URL can also be used to pass context such as filters to a destination request. This is done by 
adding additional parameters to the call. You need to make sure that any columns you are passing 
are set up in the destination with Is Prompted filters, or specific default filters.

Navigation Parameters
The basic syntax of the navigation command is the same as presented in the section “Structure of 
the Basic Oracle BI Presentation Services Dashboard URL” on page 211, but with the addition of the 
Action=Navigate parameter, and then population of the P1 - Pn parameters, as necessary.
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&Action=Navigate

&P0=n where n is the number of columns you wish to filter, currently 1 - 6.

&P1=op where op is one of the following operators.

NOTE: The settings for &P1,&P2, and &P3 are repeated for &P4-P6, &P7-P9, &P8-P10, &P11-P13, 

Operator Meaning

eq Equal to or in.

neq Not equal to or not in.

lt Less than.

gt Greater than.

ge Greater than or equal to.

le Less than or equal to.

bwith Begins with.

ewith Ends with.

cany Contains any (of the values in &P3).

call Contains all (of the values in &P3).

like You need to type %25 in place of the usual % wildcard. See the 
examples that follow.

top &P3 contains 1+n, where n is the number of top items to 
display.

bottom &P3 contains 1+n, where n is the number of bottom items to 
display.

bet Between (&P3 must have two values).

null Is null (&P3 must be 0 or omitted).

nnul Is not null (&P3 must be 0 or omitted).

&P2=ttt.ccc In this parameter, ttt is the table name and ccc is the column 
name. If the table or column contains spaces, it must be 
quoted with double-quotes. Spaces should be escaped as %20, 
for example, Measures."Dollar%20Sales".

&P3=n+xxx+yyy+...+zzz In this parameter, n is the number of values, and xxx, yyy, and 
zzz are the actual values.

NOTE: If the value of P3 begins with a numeric character, the 
entire value must be enclosed in quotes. For example:

saw.dll?Go&Path=/Shared/Test/

SB2&Action=Navigate&P0=1&P1=top&P2=Customers.Region&P3

="7West"
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&P14-P16, and &P17-P19 as necessary, depending on the value of &P0.

Navigation Examples
This returns records for the East and Central regions:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=eq&P2=Customers.Region&P3=2+Central+East

This returns records for like Regions E....t:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=like&P2=Customers.Region&P3=1+E%25t

This returns the top two regions by dollars sold:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2="Sales%20Facts".Dollars&P3=1+2

This is an example where the number of arguments is not included in the syntax:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2=Customers.Region&P3=Central

NOTE: You can omit the number of arguments only if just one argument value is included.

This returns records with between 2,000,000 and 2,500,000 in sales:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2="Sales%20Facts".Dollars&P3=2+2000000+2500000

This returns records for Regions beginning with the letter E:

saw.dll?Go&Path=vate&P0=1&P1=bwith&P2=Customers.Region&P3=1+E 

This returns records for Regions containing the letter E and having more than 20 million in sales:

saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=2&P1=cany&P2=Customers.Region&P3=1+e&P4=gt&P5="Sales%20Fact
s".Dollars&P6=1+20000000

Oracle BI Presentation Services navigation is currently supported from charts, table and pivot table 
views, HTML views, and external applications and Web pages. The destination search should have 
filters defined on columns for which it wants to receive context. These can be specific filters or, 
usually, the Is Prompted filter. In addition to the Table.Column value specifically referenced in the 
navigation call, all filters from the source request that have corresponding table.columns in the 
destination, are applied to the destination. Therefore, the appropriate context from a source can be 
passed to the destination.

Navigation from Charts
From the chart properties screen, check the Navigate radio button and enter the full path to the 
saved search or portal that you are interested in the field provided, for example:

/shared/topaz/performance/transaction details
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Navigation Using JavaScript
Navigation can currently be accomplished using the custom text/date formatter for a column. The 
central concept is that you add a column you want to navigate from to your search. You then choose 
Custom Text Format from the properties for the column, and enter HTML that calls one of the two 
provided JavaScript functions. This technique can be used to perform many actions, including sorting 
columns, calling custom JavaScript functions, and so on.

Oracle BI Presentation Services includes two JavaScript functions that enable navigation from Table 
and Pivot views: GoNav and PortalNav. (These functions are located in 
SAROOTDIR\web\app\res\b_mozilla\viewhelper.js [where SAROOTDIR is the installation directory] if 
you are interested in seeing what they do.) The former handles navigation to a specific search. The 
latter handles navigation to a specific dashboard. A description of their syntax follows, along with 
example Custom Text formats that you can use to implement navigation.

NOTE: To control the look of the navigable text using the style sheet, Oracle BI Presentation Services 
is standardized on the class=Nav.

GoNav function

function GoNav(event, sPath, sTbl, sCol, sVal, sTarget) where:

event = event indicator.

sPath = the catalog path of the destination search.

sTbl = the logical table name to filter.

sCol = the logical column name to filter.

sVal = the value to filter by.

sTarget (optional) = "_blank" to open a new browser window with the results.

Sample Custom Text Format for GoNav Call

The GoNav and PortalNav calls can be wrapped in an HTML statement (include the quotes):

[html]"<font class=nav onclick=\"JavaScript:GoNav(event, '/shared/topaz/performance/
transaction details','Transaction','Quality','"@"');\">"@"</font>

Table 21 explains the elements of this example.

Table 21. Elemental Analysis of a GoNav Call

Element Description

[html] Tells Oracle BI Presentation Services to interpret the following text as 
HTML. Note, that every "less than" character (<) must be preceded by a 
double quote (“) if the intent is to use it in an HTML tag.

"<font An HTML tag that a JavaScript call can be attached to. You could 
potentially use <div>, <span>, <a>, and so on.

class=nav The CSS style class used for formatting of the HTML tag.
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This example of GoNav places this HTML on the dashboard:

<a href="javascript:GoNav(event, '/shared/topaz/performance/transaction 
details','Transaction','Quality','Some value');">Click here to navigate to Transaction 
Details with ''Some value'</a>

PortalNav Function

function PortalNav(event, sPortal,sTbl,sCol,sVal)

event = event indicator.

sPortal = the catalog path of the destination portal.

sTbl = the logical table name to filter.

sCol = the logical column name to filter.

sVal = the value to filter by.

Sample Custom Text Format for PortalNav Call

Make sure to include the quotes exactly as shown.

"<font class=nav onclick=\"JavaScript:PortalNav(event, '/shared/topaz/_portal/
transaction analysis','Transaction','Type','"@"');\">"@"</font>"

Navigation from HTML Results
This is the same as described in “Navigation Using JavaScript” on page 215, but rather than using a 
custom formatter, type in the HTML syntax with static values in place of the @ signs.

onclick=\"JavaScript:
GoNav('event, /
shared/topaz/
performance/
transaction 
details','Transaction','
Quality','"@"');\" 

The method to call a JavaScript function. When the user clicks on the 
contents of this HTML tag, then the JavaScript function is called.

> The end of the font tag.

"@" Instructs Oracle BI Presentation Services to replace the at sign (@) with 
the actual column value. When [html] is used, the @ symbol must be 
surrounded by quotes.

</font> The closing tag to match the <font> tag.

Table 21. Elemental Analysis of a GoNav Call

Element Description
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Example of an Oracle Business 
Intelligence Third-Party SQL Tool 
Integration
This section illustrates the requirements for integrating a third-party SQL tool with Oracle Business 
Intelligence by describing an example integration, using Microsoft Access. Because Oracle Business 
Intelligence is designed as a middleware platform for enterprise data access and integration, 
common report writers and business intelligence tools can communicate natively with the Oracle BI 
Server.

Most third-party SQL tools require the user to include join conditions within queries to avoid cross-
joins. A cross-join occurs when a request does not have a WHERE clause, which, in turn creates a 
Cartesian product of the tables involved in the join. The size of a Cartesian product is the number of 
rows in the first table multiplied by the number of rows in the second table.

To integrate Microsoft Access with the Oracle BI Server, the Oracle BI Server Administrator must 
expose the keys within the Presentation layer of the Oracle BI Administration Tool.

Example of integrating a third-party SQL tool

1 Drag and drop the keys from the Business Model and Mapping layer to the Presentation layer and 
save the repository.

2 Open Microsoft Access, select the option Blank Access Database, type the name siebel-
analytics.mdb when prompted, and click Create.

3 After creating the new Microsoft Access database, right-click in the white section of the screen 
and select Link Tables.

4 From the Files of Type drop-down list box, select ODBC Databases.

The Select a Source Dialog appears, and prompts you for a Data Source Name.

5 Click the Machine Data Source tab, locate the Analytics_Web DNS, and click OK.

The Oracle BI Server requires a login.

6 Type your user ID and password.

The Import Objects dialog box appears.

7 Click the Select All button, or highlight the desired logical tables from Oracle Business 
Intelligence.

The import may take a while to complete.

8 When the import completes, right-click in the white section of the screen and select 
Relationships:

a Add the desired tables and drag and drop the keys from the dimension tables (Period, Market, 
Product) to the fact table (Sales Measures).
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b Drag and drop Period Key over the perkey column, and repeat for each corresponding key to 
create the joins.

Now, you can test and run a request.

9 Select Create query in Design view from the Queries button:

a Select Markets, Products and Sales Facts.

b Add Region, Brand, Units and Dollars, respectively, and then click Run.
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